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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to 
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void the user’s authority to operate this equipment.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this 
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International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Warranty and Repair Policy
The Ultricore and Ultrix systems are backed by a comprehensive one-year warranty on all 
components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.
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If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to Ultricore and Ultrix, what you should know about maintaining security of this product, 
and how we can partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.
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Introduction
This guide covers the configuration of databases for the Ultrix routers and Ultricore controllers. The 
following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” outlines how a database determines the routing system, and provides a 

generalized work flow of configuring a database.
• “Using DashBoard” provides instructions for launching DashBoard, and accessing the Ultrix and 

Ultricore interfaces in DashBoard.
• “Navigating the Database Interfaces” provides an overview of how the Database interfaces are 

organized, and outlines how to access the interfaces in DashBoard.
• “Databases Menu System” summarize the menus, fields, and options available in each Database 

interface starting with the first sub-node in the tree view.
• “Enabling a Service” outlines how to enable or disable each required communication service for 

your router. A summary of the additional required settings based on the protocol and the 
support commands is also provided.

• “Creating a New Database” outlines the information that is captured in a database, provides an 
overview of the Database Manager interface, and describes how to create a new database using 
the Database Manager interface. A summary of how to import and export databases, and change 
the active database is also provided.

• “Adding Connection Points” summarizes how to establish communication between your 
primary device to the other devices in your routing system.

• “Defining an External Matrix” outlines how to configure connection points to third-party 
devices, and access their matrices.

• “Defining the Levels” outlines how to determine the number of levels your database needs, and 
then how to define a level in the database.

• “Mapping the Destinations” outlines how to map the available output signals to the 
destinations in your database.

• “Mapping the Sources” outlines how to map the available input signals to the sources in your 
database.

• “Mapping the I/O for ULTRIMIX-MXR” how to map the destinations and sources for the 
ULTRIMIX-MXR licensed feature.

• “Tallies” provides instructions on how to enable TSL UMD messages in the active database, 
assign Tally IDs to your sources and destinations, and how to manage tally objects in your 
UltriScape heads.

• “Using an Alias Set” outlines how to create an alias set of virtual labels and how to apply an alias 
set to your sources and destination matrices.

• “Tielines” outlines how to define a distributed routing system using the Tieline Builder feature of 
the Ultricore.

• “Using Cat/Index Mode” outlines how to organize your resources using the Cat/Index Mode 
feature.

• “Using Group Categories” outlines how to organize the database resources into folders and 
sub-folders using the Group Categories feature.

• “Using Salvos” describes how to create and recall a salvo using the options in DashBoard.
• “Soft Panels in DashBoard”describes the Matrix, MultiBus, and Category panels in DashBoard, 

and provides instructions on how to use the soft panels to perform crosspoint switches.
• “Ultricore Profiles” provides an introduction to the Ultricore Profiles for your router matrix and 

includes general information on managing the user accounts and profiles.
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Related Publications
It is recommended to consult the following Ross documentation before configuring your databases:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultricore BCS User Guide, Ross Part Number: 2201DR-106
• Ultriscape User Guide, Ross Part Number: 2101DR-018
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide, Ross Part Number: 2101DR-004
• ULTRIX-FR12 User Guide, Ross Part Number: 2101DR-604
• ULTRIX-MODX-IO User Guide, Ross Part Number: 2101DR-020
• Walkabout Application Note, Ross Part Number: 2201DR-003

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Save As dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the ULTRIX-FR12 User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 An error message displays when an object overlaps a tile or when one tile overlaps another in the 
workspace.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
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and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 844-652-0645
• After Hours Emergency: (+1) 613-349-0006
• E-mail: solutions@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
This chapter outlines how a database determines the routing system, and provides a generalized 
work flow of configuring a database for the following devices:

• Ultricore BCS
• Ultricore CC
• ULTRIX-NS-FR1
• ULTRIX-NS-FR2
• ULTRIX-FR5
• ULTRIX-NS-FR5
• ULTRIX-FR12

Before You Begin
 Unicode characters are not supported.

Before proceeding, ensure that:

• the required license keys are installed for your device(s). Refer to the user guide for your router 
or controller for more information.

• any existing databases in your routing system are exported. Refer to the user guide for your 
router for information on exporting legacy databases in your system.

• your router and controllers are running software v6.1 or higher.

 Contact Ross Technical Support before upgrading the software for your system. 

A Note on Upgrading an Ultricore BCS Redundant System

This section only applies if you are upgrading Ultricore BCS Redundant system.

Upgrading your Ultrix and Ultricore redundant system requires you to:

1. Contact Ross Technical Support before upgrading the software for your system. 

2. Upgrade the software on the standby Ultricore BCS.

3. Reboot the standby Ultricore BCS.

4. Wait until the standby Ultricore BCS is in sync with the primary Ultricore BCS.

5. Perform a failover to the newly upgraded standby Ultricore BCS.

6. Upgrade the software on the newly standby Ultricore BCS.

7. Reboot the newly standby Ultricore BCS.

8. Perform a failover.

How a Database Determines the Routing System
The various tables within an Ultrix and Ultricore determine if a signal/route can be made from input 
to output.

For a given level, if there is a physical port mapped, for the same physical device, in both the Source 
and Destination interfaces, and the controlling device has the level enabled, then a crosspoint 
switch can be issued and executed on the router(s). Table 1 outlines a database with four levels. 
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Level 1 has mapped valid Sources and Destinations, and the level is enabled on the controlling 
device. 

Configuration Overview
The generalized work flow of configuring a database is:

1. Ensure your devices are running v6.1 software or higher.

2. Create a copy of any pre-existing Ultricore/Ultrix databases in your system.

3. Create a new (blank) database on the primary device using the options on the Database 
Manager interfaces. You can create as many databases as required, but only one database can 
be active at a time. Refer to “Creating a New Database”.

4. Establish connection points to external devices (clients). To enable an Ultricore BCS to function 
as the ‘primary’ of the routing system, you must establish communications with the ‘client’ 
devices.

 This step is only required if external routing systems are connected to the primary Ultricore.

5. Verify the available IN/OUT ports to ensure correct system connections. The default port 
naming convention of frame.slot.port.type may be overwritten (if required) at this stage.

6. Create levels as outlined in “Defining a Level”.

7. Create destination labels and assign physical ports to the labels as outlined in “Updating the 
Destination Labels” and “Mapping the Destinations”.

8. Create source labels and assign physical ports to the labels as outlined in “Updating the 
Source Labels” and “Mapping an Input to a Source”.

9. Perform one of the following:

• Define a soft panel as outlined in “Creating a Soft Panel”; or
• Establish a connection from a remote control panel (RCP) as outlined in its user guide.

Table 1  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  xa

a. An entry is not present in the corresponding Level column of the Source interface.

 

Is a physical destination assigned?   xb

b. An entry is not present in the corresponding Level column of the Destinations interface.

x

Is the Level enabled on the Controller device?    x

Can a switch be executed? c

c. A switch will be executed.

xd

d. A switch will not be executed. Physical ports from the same logical matrix must be entered in the 
same control level before a connection can be made.

xd xd
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Using DashBoard
This chapter provides instructions for launching DashBoard, and accessing the Ultrix and Ultricore 
interfaces in DashBoard.

If you have questions pertaining to the operation of Ultrix and Ultricore, contact us at the numbers 
listed in “Contacting Technical Support”. Our technical staff is always available for consultation, 
training, or service.

Launching DashBoard
DashBoard must run on a computer that has a physical wired ethernet connection. Wireless 
connections do not allow device discovery.

For More Information on...
• downloading and installing the DashBoard client software, refer to the DashBoard User Manual.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.13 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Accessing the Ultrix and Ultricore Interfaces in DashBoard
The interfaces are accessed by expanding the Ultrix or Ultricore sub-nodes in the DashBoard Tree 
View.

To access the interfaces in DashBoard

1. Locate the Ultrix or Ultricore node in the Tree View of DashBoard

2. Expand the Ultrix or Ultricore node to display a list of sub-nodes.

When accessing an Ultrix, the first sub-node provides access to the Ultriscape settings for the 
Multiviewer licensed featured. If the Ultriscape sub-node is not displayed, an Ultriscape license is 
not enabled on the router. Refer to the Ultriscape User Guide for details.

3. Expand the second sub-node.

4. Double-click the Product Info sub-node to display that interface in the right pane of the 
DashBoard window.

The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in 
the right pane. Refer to the user guide for your router for an overview of the available tabs, 
menus, and settings. 
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5. Expand the System sub-node.

The System tree includes three sub-nodes: Configuration, Control, and Monitoring. 

 The Control sub-node is not implemented on the Ultrix routers.

6. Expand the Configuration sub-node.

The Ultrix and Connections sub-nodes display. Refer to the user guide for your router for an 
overview of the available tabs, menus, and settings.

7. If this is an Ultricore BCS, double-click the Control sub-node to display the options for 
configuring the Ultripower Manager. Refer to the Ultricore BCS User Guide for details.

8. Expand the Monitoring sub-node.

The Logs and Alarm Configuration sub-nodes display. Refer to the user guide for your router for 
details on these sub-nodes.
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Navigating the Database Interfaces
This chapter summarizes the Database interfaces, and how to access the interfaces in DashBoard.

Database Tree View Overview
Ultrix and Ultricore group the database configuration options in a tree view in the DashBoard 
window. Expanding the top Database node enables you to access the interfaces to configure the 
connection points, matrices, destinations, sources, group, levels, soft panels, and salvos for the 
active database. Double-clicking a sub-node opens the corresponding interface, giving access to the 
database options.

Each sub-node offers specific database configuration options. This enables you to configure your 
routing system. Note that the currently active database name is displayed in parentheses beside 
the Database node in the tree view. For example, Figure 1 illustrates a router with the 
Database_2024_MAR database activated. Unicode names are supported so that names may be 
defined in other languages or writing systems.

Figure 1  Expanded Database Nodes in the Tree View

Throughout the Database interfaces, actual sockets (inputs and outputs) of a device (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical device housing the matrix/matrices.

• Slot identifies which router slot in the matrix the socket is located in.

• Port identifies the physical input or output socket.

• Type identifies the generic signal type (e.g. SDI, audio).

• Channel identifies the audio channel within an SDI stream.

Accessing the Database Interfaces
The interfaces are accessed by expanding the Database node in the DashBoard Tree View and 
selecting the appropriate sub-node for the database feature you wish to edit.
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 An orange border displays around an interface when the current database has the Operation 
Mode set to Manual save. A blue border indicates that the current database is read-only and 
cannot be edited (the Operation Mode set to Protect). If the Operation Mode is set to Auto save, 
any unsaved changes made to the current database are automatically applied.

To access the Database interfaces

1. Locate the Ultrix or Ultricore node in the Tree View.

2. Expand the Ultrix or Ultricore node to display a list of sub-nodes.

3. Expand the second sub-node.

4. Expand the Database sub-node to list the options available for configuring your databases.

5. Double-click the Database Manager sub-node to display the options for managing the 
database(s) in your routing system. 

Use the Database Manager interface to create, activate/inactive, and delete databases. You can 
also backup and restore databases using the Import/Export options in the Database Manager 
toolbar. Refer to “Database Manager Interface” for more information.
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6. Expand the Configuration sub-node to list the options available for configuring a database.

7. Double-click a sub-node in the Configuration tree to display its interface in the DashBoard 
window. 

For example, double-click the Routing Devices sub-node to display the options for managing 
the devices in your routing system. Refer to “Configuration Interfaces” for information on the 
available sub-nodes.

8. Expand the Control sub-node to access the configured soft panels in your routing system. Refer 
to “Soft Panels in DashBoard” for more information.
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Databases Menu System
This chapter summarize the menus, fields, and options available in each Databases sub-node 
starting with the first sub-node in the tree view. 

Figure 2  Example of a Database Tree in DashBoard

Database Manager Interface
The Database Manager helps you to create, edit, and manage your databases via a single interface. 

Figure 3  Example of a Database Manager Interface

The Database Manager interface is organized into three distinct areas: a toolbar at the top, a table 
in the left pane, and a series of tabs in the right pane. 

Table 2 summarizes the buttons displayed in the Database Manager toolbar.
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Table 3 summarizes the columns displayed in the table located in the left pane of the Database 
Manager. 

Table 2  Database Manager — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Activate Toggles the status of the selected inactive database to activate. This 
allows you to load another database to the routing system, and 
enables editing of the database settings and contents.

Add Enables you to create a new (blank) database. The list of available 
databases updates to include the new entry at the bottom of the table. 
Select the new entry to display the Database Configuration and 
Database Builder functions to further define the database.

Delete Enables you to delete the selected database

Duplicate Creates a copy of the selected database

Import Enables you to import a database file and include it in the Database 
Manger list of available databases

Export Enables you to export the selected database as a file that is then saved 
to a location on your DashBoard client computer

Legacy 
DB

Enables you to import a database (*.uda) that was created and saved 
before software version 6.1.

Filter This enables a user to filter the interface entries to only databases that 
match the entered text.

Table 3  Database Manager — Database Table

Item Parameters Description
Name <text> The unique identifier for the device in the routing 

system. This name is also used when matrices are 
defined in the Ultrix or Ultricore system.

Status Active Indicates that the specified database is currently in 
use by this Ultrix or Ultricore

Inactive Indicates that the specified database is not 
currently loaded to this Ultrix or Ultricore
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Database Configuration Tab
The right pane of the Database Manager displays the Database Configuration tab. The options 
displays on this tab enable you to configure options for the active database. 

Figure 4  Example of the Active Database Configuration Tab

Table 4 summarizes the menus and options displayed in the Database Configuration tab.

 
Table 4  Database Manager — Database Configuration

Item Parameters Description
Operation Mode

Auto save • Changes made to any database interface are 
automatically saved. 

• This is the default setting when a database is set 
to Active.

Protect • All fields, except Aliases and labels, of the 
database are read-only and cannot be edited. 

• A blue border displays around each interface.
• A shield icon displays in the Status column for the 

database in the Database Manager table
• A shield icon displays in the bottom left corner of 

each interface to remind the user that the 
database is read-only.

Manual save • The database is editable but changes are not 
automatically saved.

• An orange border displays around each interface.
• The Cancel and Save buttons display in the 

bottom right corner of each database interface. 
• After making changes on any interface, the user 

must then click Save to save any changes. 
• Clicking Save on one interface applies any 

unsaved changes made to any interface.

Tally
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Database Builder Tab
The Database Builder tab helps you to quickly create a database. From this tab you can define the 
database properties including: type of signals (video, audio), the number of devices that the 
database includes, the audio elements of the database, and basic I/O settings.

Figure 5  Example of the Database Builder Tab

Table 5 summarizes the fields displayed in the options in the Database Builder tab. 

Enable tally Selected Enables a 'Tally' column for the Sources and 
Destinations interfaces.
The Tally column associates a TallyID with a source 
or destination. This information is used to control 
tally display objects on PiPs of Ultriscape heads. 

Cleared The option for TallyID association is removed.

Snapshots

Snapshot frequency 
(min)

# Determines how often the active database settings 
are auto saved. The default is 15 minutes.

Restore Returns the database to the settings during the 
selected snapshot

Create Immediately creates a snapshot of the currently 
active database

Date/Time Lists the saved snapshots by MM DD YY

Table 5  Database Manager — Database Builder

Item Parameters Description
Name

Devices Displays a list of detected routers in your network. 
Select a device name to include it in this database.

Table 4  Database Manager — Database Configuration (Continued)

Item Parameters Description
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Include AUX ports None Do not create entries for AUX ports in the database

Insert at slot Create AUX port entries as they are physically 
located within the device chassis (e.g. ports 17 and 
18).

At the end Create AUX ports after all the BNC entries

Video support Yes The database includes video and audio signals

No Creates an audio-only database

Audio channels # Specifies the quantity of audio channels (levels) 
required

Breakaway source 
support

Yes Create sources for audio breakaways/shuffles

No Audio breakaways are not included in this database

SDI audio per 
channel

Creates audio breakaway sources using the 
selected audio channel grouping size

MADI channels per 
source

Creates MADI sources using the selected audio 
channel grouping size

Disconnect source? Yes Creates a source that will disconnect (mute) SDI and 
audio channels

No This option is not included in the database

Passthrough 
source?

Yes Creates a source that may be routed to destinations 
so that embedded audio from a connected SDI 
source is passed through without changes

No This option is not included in the database

UltriScape support? Yes Enables UltriScape heads and PiPs to be included in 
the database (requires the UltriScape license)

No UltriScape heads and PiPs are not included in the 
database

Number of 
Multiviewer heads

# Specifies the number of UltriScape heads the 
database will support

Number of 
Multiviewer pips per 
head

# Specifies the maximum number of PiPs available 
per layout

Include detected 
Multiviewer layout

Creates sources for detected UltriScape layouts to 
enable layout changing from control panels

Audio Mixer IO Yes Generates audio mixer sources and destinations. 
This requires an Ultrimix-MXR license be enabled 
on the router.

No Does not generate audio mixer sources or 
destinations

Audio Mixer Direct 
Outputs

Yes Generates source maps for audio mixer direct 
outputs

No Does not generate audio mixer direct outputs

Starting Audio Level # Selects the audio level to start generation from

Table 5  Database Manager — Database Builder (Continued)

Item Parameters Description
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Configuration Interfaces
The Database > Configuration node expands to display a tree of sub-nodes that enable you to 
further define the current database. Each sub-node provides access to a specific interface of the 
database. (Figure 6)

Figure 6  Database > Configuration Nodes

This section outlines each sub-node in order of appearance in the Configuration tree.

 An orange border displays around an interface when the current database has the Operation 
Mode set to Manual save. A blue border indicates that the current database is read-only and 
cannot be edited (the Operation Mode set to Protect). If the Operation Mode is set to Auto save, 
any unsaved changes made to the current database are automatically applied.

Routing Devices
The Routing Devices interface reports a list of devices detected in the routing system and their 
communication status with the primary device. (Figure 7)

Channels per 
destination / source

Selects the audio grouping

Destination Name <text> Specifies the prefix for audio mixer destinations

Source Name <text> Specifies the prefix for audio mixer sources

Starting Number for 
Destinations         

<#> Specifies the number to start destination 
generation from (e.g. MDST#)

Starting Number for 
Source

<#> Specifies the number to start source generation 
from (e.g. MSRC#)

Build Click this button to apply the settings and update 
the database

Table 5  Database Manager — Database Builder (Continued)

Item Parameters Description
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Figure 7  Example of a Routing Devices Interface

Table 6 summarizes the buttons displayed in the toolbar located at the top of the Routing Devices 
interface. 

Table 7 summarizes the read-only fields displayed in the left pane of the Routing Devices interface. 
Each row of this table represents a device in your routing system. 

When using an Ultricore BCS, this pane lists the devices you manually added. 

Table 6  Routing Devices — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to create a connection point to another device in the 
routing system

Delete Removes the selected device and its matrices from the active database

IP 
discovery

This button is only available when using an Ultricore BCS with the 
Ultricore-IP feature enabled. Refer to the Ultricore BCS User Guide for 
more information on Ultricore-IP. 
When this button displays the yellow triangle, clicking it displays the IP 
Discovery dialog. Use this dialog to add the NMOS devices discovered 
by the Ultricore-IP feature to your list of routing devices. 

Filter Reduces the number of database entries visible on the Routing 
Devices interface.
This enables a user to filter the interface entries to only devices that 
match entered text.
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Communication Tab
Table 8 summarizes the tabs and menus displayed in the Communication tab, located in the right 
pane, of the Routing Devices interface. Select a device on the left pane to display its communication 
settings in the Communication tab.

Table 7  Routing Devices — Left Pane

Item Parameters Description
ID # Auto-numbered field (read-only).

Name <name> The unique identifier for the connected matrix to be 
used by the database

Product <name> Indicates the type of device connected

Protocol <name> Indicates the communication protocol required by 
this device

Type <name> Specifies the connection type this device provides 
within the database

Status (read-only) Running No communication errors are detected

Disconnected This device is no longer communicating with the 
routing system

Initializing Attempting to connect to this device. It is 
recommended to wait approximately 60 seconds to 
establish a connection.

IO mismatch The number of available I/O on the device does not 
match the values specified in the active database

Not available The device was added/edited while the database is 
operating in Manual save mode but is now 
disconnected from the primary device.
Click Save, located at the bottom right corner, and 
verify if a connection is now made to the device.

 Unknown 
State

A legacy database was imported and the protocol 
cannot be determined (this is usually for the NK 
devices). 
You will have to specify the protocol for the device. 
Refer to “Enabling a Communication Service”

Updates the database with the selected device 
matrix. 
If the device is reporting an IO Mismatch, click this 
button to refresh the database and see if it clears 
the error.
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Matrix Tab
Table 9 summarizes the buttons and menus displayed in the Matrix tab, located in the right pane, 
of the Routing Devices interface.

Table 8  Routing Devices — Communication Tab

Item Parameters Description
Device name <name> Provides a unique identifier for the device in the 

database. This name is also used when matrices are 
defined in the routing system.

Protocol Ultrix TCP The device uses the Ross Ultrix protocol to 
communicate (TCP only)

GVG Native The device uses the third-party GVG protocol to 
communicate (TCP or Serial)

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only)

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol (TCP or Serial)

RossTalk TCP The device uses the Ross Talk protocol to 
communicate (TCP only)

Protocol TSL UMD v3.1 The device uses TSL UMD protocol version 3.1 (TCP, 
UDP, or Serial)

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0 (TCP, 
UDP, or Serial)

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0 (TCP, 
UDP, or Serial)

NVision NP0010 
Serial

This device communicates via the third-party 
NVISION protocol

NVision NP0016 
TCP

NVision NP0016 
UDP

Communication

IP Address # Indicates the IP Address assigned to the device 
within the network

Port # Indicates the ethernet port the devices is associated 
with on the network

Control

Device Status enabled Direct communication is established between the 
primary device and this client device

disabled Communication between the primary device and 
this client device is unavailable
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Levels
A level is a term used to describe a section or layer of the routing system. Typically a level is 
associated with input/output ports that are used with sets of similar or related signals, such as SDI 
Video, AES Audio, Analog Video, Analog Audio, Timecode, or Machine Control, and often include 
routing matrices that are dedicated to controlling that specific type of signal. These levels may be 
controlled individually, or grouped together in common patterns (a breakaway).

Figure 8  Example of Entries in a Levels Interface

The options in the Levels interface are organized into a table where each row represents a level and 
the columns provide the options for configuring that level. (Figure 8) From this interface you assign 
a unique name to each level, a color that represents the level to make it easier to identify the level in 

Table 9  Routing Devices — Matrix Tab

Item Parameters Description
Add Adds a new entry in the tab to enable you to define 

a new matrix based on this device

Delete Deletes the selected matrix from the database

Name <name> Assigns a unique identifier for the imported third 
party matrix to be used by the database

Type Specifies the signal type of inputs and outputs this 
device provides within the database

Level # Specifies the number of levels for the device in the 
database

First Output # Specifies the first destination for the device within 
the database

Last Output # Specifies the last destination for the device within 
the database

First Input # Specifies the first source for the device within the 
database

Last Input # Specifies the last source for the device within the 
database
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a soft panel, and add a description of the level to aid identification. The levels defined in the Levels 
interface have a direct relationship with the Level entries in other database configuration tabs.

For More Information on...
• the Tally Status Level menu, refer to “Defining the Status Level for Tally Operation”.

Destinations
The Destinations interface enables the assignment of logical labels (used by remote control panels 
and soft panels) to physical outputs of the attached matrices or routers. The options in the 
Destination interface are organized into a table where each row associates a name of the 
destination with one or more physical matrix output sockets. A toolbar at the top includes options 
for managing the table entries. (Figure 9) 

Figure 9  Example of Entries in a Destinations Interface

Table 10 summarizes the buttons displayed in the toolbar of the Destinations interface.

Table 10  Destinations — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to add a single or range of new logical labels. These are 
added at the end of the current definitions

Fill I/Os Displays a pane that enables you to insert destination labels with 
assignments for the entire device (including the AUX ports) or for a 
custom range

Edit Enables the reassignment of the physical ports to the selected 
destination

Rename Displays a dialog that enables the renaming of a selected destination

Select all Selects all entries on the Destinations interface

Deselect 
all

Entries are no longer selected on the Destinations interface



38 • Databases Menu System Ultrix and Ultricore Database Guide (v1-rev6)

Clear Clears the physical port mapping

Delete Removes the selected destination from the active database

Export Enables you to save the current Destination mapping as an *.xlsx file 
on your DashBoard client computer

Import Enables you to import an *.xlsx file that automatically maps the 
Destinations as defined by the spreadsheet entries

Reset IDs Replaces the current ID assignments to the default values (starting 
with 0 for the first entry)

View 
Columns

Displays a dialog that enables you to specify the Levels columns to 
show/hide on the Destinations interface. Note that the ID and Name 
columns are fixed (cannot be hidden).

Alias Applies the custom labels as defined in the Aliases interface. Refer to 
“Aliases” for details.

Table 10  Destinations — Toolbar (Continued)

Button Label Description
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Table 11 summarizes the table columns displayed in the main area of the Destinations interface 
(from left to right). 

Sources
The Sources interface is organized into a table where each row associates a name of the source 
with one or more physical matrix input sockets. (Figure 10) This enables the assignment of labels 
(used by remote control panels and soft panels) to inputs of the attached matrices or routers. A 
toolbar at the top includes options for managing the table entries.

Table 11  Destinations Interface

Item Parameters Description
ID (read-only) # An auto-numbered field that is not used within 

the Ultrix or Ultricore system itself, however, 
third-party protocols that do not support labels 
will reference this field in their communications

Name <text> Assigns a unique identifier (label) for the 
destination in the routing system. This label is 
used by control interfaces/devices.

Description <text> Provides additional information or user entered 
notes about the output

Tallya

a. This option only displays when the Enable tally box is selected in the Database Manager > Database Configuration 
tab of the active database.

TSL v3.1 <displayID> Displays the TSL protocol Tally ID entry 

TSL 4.0 <displayID>

TSL v5.0 <screenID>:<displayID>

Tally Modea Enables/disables the re-direction of connected 
source Tally ID to destination Tally ID as set by 
the Tally field

Level # Specifies the physical output port associated 
with the destination and assigns it to the 
specified level. Unless you have given the port a 
different label via the Channel Alias interface, the 
port is labeled as: 
Frame.Slot.Port.Type.Channel.



40 • Databases Menu System Ultrix and Ultricore Database Guide (v1-rev6)

Figure 10  Example of Entries in a Sources Interface

Table 12 summarizes the buttons displayed in the toolbar of the Sources interface. 

Table 12  Sources — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to add a single or range of new logical labels. These are 
added at the end of the current definitions.

Fill I/Os Displays a pane that enables you to insert source labels with 
assignments for the entire device (including the AUX ports) or for a 
custom range

Edit Enables the reassignment of the physical ports to the selected source

Rename Displays a dialog that enables the renaming of a selected source

Select all Selects all entries on the Sources interface

Deselect 
all

Cancels the previous selections

Clear Clears the physical port mapping

Delete Removes the selected source from the active database

Export Enables you to save the current Source mapping as an *.xlsx file on 
your DashBoard client computer

Import Enables you to import an *.xlsx file that automatically maps the 
Sources as defined by the spreadsheet entries

Reset IDs Replaces the current ID assignments to the default values (starting 
with 0 for the first entry)
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Table 13 summarizes the table columns displayed in the main area of the Sources interface (from 
left to right on the interface). 

Aliases
The Alias interface provides a method for defining an alias for one or more source or destination 
labels. An alias can be useful for defining label sets for use with devices that have limited screen real 
estate such as Remote Control Panels. 

The default labels for the routing system are the labels as defined in the Source and Destination 
interfaces. An alias set is a group of labels that can be defined and then used with display limited 
devices.

For example, a label Remote Camera will not display correctly on a Remote Control Panel. An alias 
for this label may be REM CAM. This will display correctly on character limited displays.

An alias set may only define a few aliases for the router. When using this set, the defined aliases are 
used but where no alias is defined for a given source or destination, then the label as defined within 
the source or destination interface is used.

View 
Columns

Displays a dialog that enables you to specify the Levels columns to 
show/hide on the Sources interface. Note that the ID and Name 
columns are fixed (cannot be hidden).

Alias Applies the custom labels as defined in the Aliases interface. Refer to 
“Aliases” for details.

Table 13  Sources Interface

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used 

within the routing system itself, however, 
third-party protocols that do not support labels will 
reference this field in their communications.

Name <name> Assigns a unique identifier (label) for the source in 
the routing system. This label is used by control 
interfaces/devices.

Description Provides additional information or user entered notes about the input

Tallya

a. This option only displays when the Enable tally box is selected in the Database Manager > Database 
Configuration tab of the active database.

<displayID>  
or 
<screenID>:<displayID>

Displays the TSL protocol tally ID entry 

Level # Specifies the physical input port associated with the source and assigns it to 
the specified level. Unless you have given the port a different label via the 
Channel Aliases interface, the port is labeled as: 
Frame.Slot.Port.Type.Channel.

Table 12  Sources — Toolbar (Continued)

Button Label Description
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Figure 11  Example of Entries in an Alias Sets Interface

Table 14 summarizes the buttons displayed in the leftmost toolbar located at the top of the Alias 
interface. 

Table 15 summarizes the table columns displayed in the main area of the Aliases interface (from 
left to right on the interface). 

Table 16 summarizes the buttons displayed in the rightmost toolbar located at the top of the 
Sources, and Destinations tabs in the Aliases interface.  

Table 14  Aliases — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Creates a new alias set

Duplicate Creates a copy of the alias set

Delete Removes the selected alias set from the active database

Table 15  Aliases — Main Area

Item Description
Name Provides a list of configured alias sets. Select a row to display the alias set 

details on the rightmost pane.

Description Provides additional information about the alias set

Table 16  Alias > Sources or Destination — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Rename Assigns a new identifier to the selected row(s) for this alias
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Table 17 summarizes the columns displayed in the Sources and Destinations tabs of the Aliases 
interface. 

Table 18 summarizes the options displayed in the Services tab of the Aliases interface. 

Channel Alias
The Channel Alias interface provides a method for over-riding the default port nomenclature of 
Frame.Slot.Port.Type.Channel for identification. This name is used to identify not just a 
physical connector on a router, but also different channels within a digital stream. An alias may be 
created to aid identification within a facility.

 This re-naming is not necessary for router operation, but it may make your assignment of source 
and destination labels easier to identify when using your internal cable naming conventions.

Select all Selects all entries on the tab

Deselect 
all

Cancels the previous selections

Clear Removes any recent changes 

Import Enables you to import a Microsoft® Excel® spreadsheet that lists the 
ports and the new identifiers for a specific alias set 

Export Enables you to save the specified alias to a Microsoft Excel 
spreadsheet file on your DashBoard client computer

Table 17  Aliases — Sources or Destinations Tabs

Item Description
Name Indicates the label as defined by the Sources or Destinations interface

Alias Provides a text entry for the label alias. 
Double-click the entry to edit, or click Rename. For example, re-name a 
port from Ultrix.slot2.in[7].SDI.ch1 to SDI IN 7.

Table 18  Aliases — Services Tabs

Item Description
Apply selected Applies the selected alias set to the external device matrix. Services are 

defined in “Enabling a Service”.

Clear The alias set is no longer applied to the external device matrix. This button 
is disabled if no alias sets are currently applied to the external device 
matrix.

Service alias set Reports the alias set currently applied and the number of services 
(devices) it is applied to.

Table 16  Alias > Sources or Destination — Toolbar (Continued)

Button Label Description
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Figure 12  Example of Entries in a Channel Alias Interface

Table 19 summarizes the buttons displayed in the toolbar located at the top of the Channel Aliases 
interface. 

Table 20 summarizes the table columns displayed in the Channels Alias interface.

 

Table 19  Channel Alias — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Rename Assigns a new identifier to the selected row(s) for this alias

Select all Selects all entries on the tab

Deselect 
all

Cancels the previous selections

Clear Removes any recent changes 

Import Enables you to import a Microsoft® Excel® spreadsheet that lists the 
ports and the new identifiers for your audio channels 

Export Enables you to capture the current channel aliases and save to a 
Microsoft Excel spreadsheet on your DashBoard client computer

Table 20  Channel Alias

Item Description
Name Lists the input and output channels provided by the configured matrices. 

The format is Frame.Slot.Port.Type.Channel.

Alias Provides a text label that identifies the channel in other interfaces of the 
database. Double-click to edit, or click Rename.This alias is used instead of 
the Frame.Slot.Port.Type.Channel format for label assignment. 
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Cat/Index Categories
The Cat/Index Categories interface enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. (Figure 13) You can use categories to filter sources, destinations or levels 
into manageable groups for a Category soft panel. Refer to “Using Category Panels” for more 
information.

Figure 13  Example of Entries in a Cat/Index Categories Interface

Table 21 summarizes the buttons displayed on the top toolbar. 

 The toolbar button function depends on the Category table selection or Index table selection.

Table 21  Cat/Index Categories — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Creates a new entry in the selected Category or Index table. For 
example, a new entry would be added to the Category table in Figure 13.

Select all Selects all entries in the current table

Deselect 
all

Cancels the previous selections in the current table

Delete Deletes the selected entry from the current table (Category or Index). 
Automatically unassigned any resources.

Generate Automatically generates Category and Index entries based on the active 
database entries.
Categories are automatically defined by searching for space characters 
within the database logical source and destination names.

Default 
index

Generates the default indexes (0-9 and A-F)
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Assigned Resources Area
Table 22 summarizes the options displayed in the Assigned Resources area (bottom left pane) of 
the Cat/Index Categories interface. 

Unassigned Resources Area
The right pane of the Cat/Index Categories interface displays a tab for each resource type. Select a 
tab to display the resources in the current database that are not assigned to a category/index. 

Table 23 summarizes the options displayed in each tab. 

Group Categories
The Categories interface enables you to categorize resources (levels, sources, and destinations) via 
a hierarchal system of tags. You can use categories to filter resources into manageable groups for a 
Category soft panel. Refer to “Using Category Panels” for more information.

Table 22  Cat/Index Categories — Assigned Resources Area

Item Parameters Description
Show Levels Updates the Levels in Categories list

Levels in Categories Lists the current levels that are accessible via the 
defined Category/Index combinations

Assigned # Reports the number of levels assigned to the 
selected Category/Index combination

Show Sources Updates the Sources in Categories list

Sources in 
Categories

Lists the current sources that are accessible via the 
defined Category/Index combinations

Assigned # Reports the number of sources assigned to the 
selected Category/Index combination

Show Destinations Updates the Destinations in Categories list

Destinations in 
Categories

Lists the current destinations that are accessible via 
the defined Category/Index combinations

Assigned # Reports the number of destinations assigned to the 
selected Category/Index combination

Table 23  Cat/Index Categories — Unassigned Resources Area

Button Label Description
Add Enables you to assign the selected resource(s) to the a new Cat/Index 

filter for destinations

Select all Selects all resources in the current tab

Deselect 
all

Cancels the previous selections on the current tab

Generate Automatically generates category tags based on the destinations in 
your database
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Figure 14  Example of Entries in a Group Categories Interface

The Group Categories interface is organized into two panes: the Group Categories tree (left pane), 
and the available resources tabs (right pane). The tree organizes all the created groups and 
sub-groups, and/or resources in a top-down hierarchy. (Figure 14) Note that the nodes are sorted 
by type and then by alphabetical order.

Table 24 summarizes the toolbar buttons displayed in the left pane of the Group Categories 
interface. 

Table 25 summarizes the options displayed in the right pane of the Group Categories interface. 
This panel displays a tab for each resource type, listing the available levels, sources, or destinations 
that can be assigned to the group categories.

 

Table 24  Group Categories Interface — Toolbar Buttons

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to manually add a new group (node) to the Group 
Categories tree

Edit Enables you to edit the name assigned to a group

Move Displays the Move dialog that enables you to move a selected group 
and its contents to another group or to a new node in the tree

Delete Deletes the selected group(s) and all sub-groups

Generate Auto-generates the group categories based on the resource names 
from the current database

Table 25  Group Categories Interface — Right Panel

Item Description
Levels Displays the unassigned levels

Sources Displays the unassigned sources
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Salvos
A salvo is a set of pre-defined switch events. The Salvos interface provides a list of the global salvos 
available in the currently active database. (Figure 15) Use this interface to create salvos, rename, 
edit, and delete salvos.

The workspace in the Salvos interface displays a grid pattern with sources at the top and the 
destinations along the left side. A list of currently available (saved) salvos displays on the far 
left-side of the interface. The toolbar on the far right-side displays a button for each level available 
in the database with each button set in the color specified for the level.

Figure 15  Example of a Salvos Interface

Table 26 summarizes the buttons displayed in the toolbar located at the top of the Salvos interface.

 

Destinations Displays the unassigned destinations

Assign Select the resource(s) to add it to the group selected in the Group 
Categories tree

Table 26  Salvos — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to create a new salvo for the active database

Duplicate Creates a copy of the currently selected salvo

Delete Deletes the selected salvo

Select all Selects all available destinations on the Salvos workspace.

Deselect 
all

Clears the Destinations column of selections

Table 25  Group Categories Interface — Right Panel (Continued)

Item Description
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Table 27 summarizes the table columns displayed in the left pane of the Salvos interface. 

Table 28 summarizes the options displayed in the right pane of the Salvos interface. 

Panels
The Panels interface includes a series of sub-tabs that enable you to customize the soft panels 
(control panels within the DashBoard environment). You can choose to assign the resources (levels, 
sources, destinations, and salvos) from a database to the panel buttons. The soft panels display as 
sub-nodes in the Database > Control > Panels tree using the configured name. When you save a soft 
panel to the database, a node for the panel automatically displays in the Panels tree. The soft 
panels display in the tree according to their assigned Panel ID (where an ID of 1 is the highest, and 
ID of 2 is the second highest etc.).

Capture Captures the current state of the routing system as a new salvo using 
one of the following methods:
Capture system status — uses the current routing state of the routing 
system.
Capture destination status — uses the current status of the selected 
destinations in this database.
Capture port status — uses the current status of the physical ports in 
the database.

Clear Clears the preset crosspoint selections for the current salvo. If 
destinations are selected, the option to only clear the selection is 
presented.

Levels Select to filter the displayed levels

Toggle Toggles the workspace between a grid view (default) and a table view. 
Note that editing is not available in table view.

Find & 
Filter

Displays the Find dialog which enables you to:
enter search criteria to locate specific Sources or Destinations in the 
current workspace.
filter the workspace entries to only display sources and/or 
destinations that match entered text

Table 27  Columns of the Salvos Interface — Left Pane

Column Description
ID The auto-assigned identifier for a salvo

Name Provides a list of configured salvos for the currently loaded database. 
Double-click an item in the list to update the grid in the Salvos interface.

Table 28  Columns of the Salvos Interface — Right Pane

Button Description
Level # The display of levels is controlled via the Levels button on the top 

toolbar. Select one or more level buttons to include it in the next preset 
selection.

Follow Click to include all the Levels in the next preset selection.

Table 26  Salvos — Toolbar (Continued)

Button Label Description
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The Panels interface is organized into two distinct areas from left to right: the Panels table and the 
Settings, Data, and Layout tabs. (Figure 16)

Figure 16  Example of Entries in a Panels Interface

Panels Table
The Panels area is located in the left pane, and displays a table with a toolbar at the top. The table 
lists the soft panels saved in the current database. The toolbar includes buttons that enable you to 
quickly add, copy, or delete selected soft panel(s) from the table.

Table 29 summarizes the fields and menus displayed in the toolbar of the Panels area. 

Table 29  Panels Area — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Displays the Add Panel dialog. This dialog enables you to create a new 
soft panel entry.

Duplicate Creates a copy of the currently selected soft panel

Delete Deletes the currently selected soft panel(s)

Up Moves the selected item higher in the table/list.

Down Moves the selected item lower in the table/list.

Top Moves the selected item to the top of the table/list.

Bottom Moves the selected item to the bottom of the table/list.
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Table 30 summarizes the table columns displayed in the Panels area. 

Settings Tab
The Settings tab is the first tab displayed on the right side of the interface. Use the options in the 
Settings tab to determine how the panel will perform tasks such as Take transitions, what data to 
include, or whether to include window/drawer elements (if applicable).

 Not all options are available for all panel types.

Table 31 summarizes the fields and menus displayed in the Settings tab. 

Table 30  Panels Area — Table

Item Parameters Description
Panel ID # Auto-assigns an ID number to the soft panel. This 

value determines the panel node placement in the 
hierarchy of the Soft Panel tree. This number can 
be over-written.

Name <name> Provides a unique identifier for the soft panel. This 
name also displays in the Databases > Control > 
Panels interface.

Description # Provides a textual summary of the soft panel or 
additional information about the panel.

Type (read-only) <text> Specifies the panel type that was assigned to the 
soft panel when it was created.

Table 31  Panels > Settings Tab

Item Parameters Description
Panel

Protection 
operation

Enable Displays the Lock and Protect buttons on the soft 
panel interface

Disable The Lock and Protect buttons do not display on the 
soft panel interface

Take operation Confirm Displays the TAKE button on the soft panel 
interface. 
The user must click TAKE to confirm a switch before 
a crosspoint route will occur.

Direct A TAKE button is not displayed on the soft panel 
interface. 
Any source button selection is acted upon 
immediately.

Machine control Enable Displays a Machine Control toggle button on the 
soft panel interface. 
When enabled (the button is lit blue), any source 
selection on the panel will also send a command to 
Ross NK-M series data routers to automatically 
make the reciprocal port switch.

Disable Does not display a Machine Control button on the 
panel
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Selection operation Single The Multi Select button does not display on the 
MultiBus soft panel

Multi Displays the Multi Select button on the soft panel. 
Use this button to quickly select multiple 
destinations for a crosspoint switch.
This button is only applicable for MultiBus panels.

Nongroup 
resources

Hide Resources that are not assigned to a specific group 
are not displayed on the Group Category soft panel.

Show All resources are displayed on the Group Category 
soft panel.

Window

Vertical scroll bar 
width

Determines the width of the vertical scroll bar

Horizontal scroll bar 
height

Determines the height of the horizontal scroll bar

Icons display Enable The Destination and Source buttons will display the 
default icons based on the window type

Disable The Destination and Source buttons do not display 
icons; only the labels are displayed

Orientation Portrait Specifies a vertical layout where the soft panel is 
taller than it is wide. 
The windows are organized into columns (vertical 
panes) on the soft panel.

Landscape Specifies a horizontal layout where the soft panel is 
wider than it is tall.
The windows are organized into rows (horizontal 
panes) on the soft panel.

Drawer width Specifies the width of the drawer handle size on an Audio Mixer panel

Channel strip title Read Only Each strip reports the name of the audio channel 
and the router source assigned to it. This is 
available only for Audio Mixer panels.Editable

Take button size Specifies the dimension of the TAKE button on the soft panel. This is 
available only for the Ultritouch PB panels.

Viewable Data

Levels # Specifies the maximum number of levels available, 
as selectable buttons, on the panel

Sources # Specifies the maximum number of sources 
available, as selectable buttons, on the panel

Destinations # Specifies the maximum number of destinations 
available, as selectable buttons, on the panel

Salvos # Specifies the maximum number of salvos available, 
as selectable buttons, on the panel

Table 31  Panels > Settings Tab (Continued)

Item Parameters Description
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Data Tabs
Selecting the Data tab updates the interface with sub-tabs to assign the resources (levels, sources, 
destinations, salvos, and alias sets) for the selected soft panel.

Levels Sub-tab

Use the options in the Data > Levels sub-tab to specify the available levels for the panel, and 
organize them in a hierarchy. 

Figure 17  Example of the Panels > Data > Levels

Table 32 summarizes the fields and menus displayed in the Data > Levels sub-tab. 

Sources Sub-tab

Use the options in the Sources sub-tab to specify which router inputs will be available in the Source 
bus of the soft panel, and determine their hierarchy. 

Figure 18  Example of the Panels > Data > Sources

Table 32  Data > Levels Sub-tab

Item Description
Available Lists all the levels that are available in the database but are not 

assigned to the soft panel

Assigned Specifies which levels will be available on the soft panel
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Table 33 summarizes the fields and menus displayed in the Data > Sources sub-tab.

Destinations Sub-tab

Use the options in the Destinations sub-tab to specify which outputs will be available in Destination 
bus of the soft panel. 

Figure 19  Example of the Panels > Data > Destinations

Table 34 summarizes the fields and menus displayed in the Data > Destinations sub-tab. 

Salvos Sub-tab

Use the Salvos sub-tab to determine the salvos displayed in the soft panel and their hierarchy. 

Table 33  Data > Sources Sub-tab

Item Description
Available Lists all the sources that are available in the database but are not 

assigned to the soft panel

Assigned Specifies which sources will be available in the soft panel

Table 34  Data > Destinations Sub-tab

Item Description
Available Lists all the destinations that are available in the database but are not 

assigned to the soft panel

Assigned Specifies which destinations will be available in the soft panel
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Figure 20  Example of the Panels > Data > Salvos

Table 35 summarizes the fields and menus displayed in the Salvos sub-tab. 

Alias Sets Sub-tab
Use the options in the Alias Sets sub-tab to apply one or more configured alias sets to the soft 
panel. An alias set will determine the button labels on the soft panel.

 This sub-tab is not available when configuring a Cat/Index Category soft panel.

Figure 21  Example of the Panels > Data > Alias Sets

Table 36 summarizes the fields and menus displayed in the Alias Sets sub-tab.

Table 35  Data > Salvos Sub-tab

Item Description
Available Lists all the salvos that are available in the database but are not 

assigned to the soft panel

Assigned Specifies which salvos will be available in the soft panel.
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Layout Tab
The Layout tab enables you to customize the contents and display settings of the windows and 
drawers of a soft panel. (Figure 22) The available settings depend on the panel type you are editing.

The Layout tab may be organized into the following areas:

• Home Windows — these options determine the contents and layout of the main (Home) window 
of a soft panel.

• Drawer Windows — these options determine the contents and layout of the navigation drawers 
on the left and right sides of the soft panel.

 The Layout tab is not available for the Matrix or MultiBus panel types.

Figure 22  Example of the Panels > Layout Tab

Table 37 summarizes the options displayed in the Layout tab.

 

Table 36  Data > Alias Sets Sub-tab

Item Description
Available Lists all the alias sets that are available in the database but are not 

assigned to the soft panel

Assigned Specifies which alias sets will be available in the soft panel. 
Note that the first alias set assigned will be the first set the user sees in 
the soft panel.

Table 37  Layout Tab

Item Parameters Description
Home Windows

Total Width (%) 
(read-only)

# Reports the percentage of allocated space used by 
the Home Window components on the panel

Add Enables you to add a new window to the soft panel 
layout

Delete Removes the window from the soft panel layout

Default Loads the default window layout and widths
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Buttons
Table 38 summarizes the buttons displayed in all Panel sub-tabs. 

Windows data 
(read-only)

<text> Specifies the resource or window type that is 
included on the panel

Percent # Specifies the width of the window in a percentage 
of the overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the 
window

Title bar Selected A header displays above each data type window to 
identify it on the panel. For example “Destinations” 
or “Sources”.

Cleared The data type windows are not identified by a 
header

Drawer Windows

Add Enables you to add a new data type to a drawer of 
the panel

Delete Removes the data type from the drawer of the 
panel

Default Loads the default drawer layout and widths

Position Specifies the drawer (left or right) on the soft panel

Windows data 
(read-only)

<text> Specifies the resource or data that is included in the 
drawer of the panel

Percent # Specifies the width of the window in a percentage 
of the overall drawer size

Rows # Specifies the number of button rows in the drawer 
window

Columns # Specifies the number of button columns in the 
drawer window

Title bar Selected A header displays above each data type in the 
drawer to identify it on the panel

Cleared The data type is not identified by a header in the 
drawer

Table 38  Button on the Panels Interface

Button Description

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available list. 
These items will not be available on the panel.

Table 37  Layout Tab (Continued)

Item Parameters Description
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Destination Follow Interface
The Destination Follow interface (Figure 23) enables one destination to follow another. The follow 
will not occur immediately upon setting the destination follow; it will happen with the next route of 
the followed destination.

For More Information on...
• the Multiviewer options, refer to the Ultriscape User Guide.

Figure 23  Example of the Destination Follow Interface

Table 39 summarizes the options displayed in the Destination Follow > Destinations interface. 

Moves all the available items to the Assigned list.

Moves all the items from the Assigned list back to the Available list. These 
items will not be available on the panel.

Moves the selected item in the Assigned list up one position. This changes the 
order of the displayed items on the soft panel.

Moves the selected item in the Assigned list down one position. This changes 
the order of the displayed items on the soft panel.

Moves the selected item in the Assigned list to the top of the list. This changes 
the order of the displayed items on the soft panel.

Moves the selected item in the Assigned list to the bottom of the list. This 
changes the order of the displayed items on the soft panel.

Table 39  Destination Follow Interface

Item Parameters Description
Destinations

Select all Selects all entries in the Destination and Follow 
columns

Table 38  Button on the Panels Interface (Continued)

Button Description
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Ultricore Profiles Interface
The Ultricore Profiles operate as a hierarchical database where user permissions are organized into 
a tree-like format. A profile determines which groups and pages that a user can access. 

On the Ultricore BCS, the Ultricore Profiles node is automatically enabled and selecting it displays 
a series of tabs in DashBoard. The ULTRICORE-PRO license must be first enabled on a router in 
order to access all settings of the Ultricore Profiles feature as described in this section.

Figure 24  Example of the Ultricore Profiles Interface

The Ultricore Profiles interface is organized into two tabs: Users and Profiles. Each tab is briefly 
described in this section starting with the leftmost tab of the DashBoard window. (Figure 24)

Users Tab
When the system is configured to use the Ultrix user login mechanism, a list of all currently 
configured usernames along with their current online status displays in this area. 

Table 40 summarizes the options displayed in the User Profiles > Users tab. 

Deselect 
all

Entries in the Destination and Follow columns are 
no longer selected

Clear Clears the entries in the Follow column

Destination # Specifies the destination you want to configure

Follow # Reports the router output that the specified 
destination will follow

Following

Destination # Reports the router outputs that are following any 
router output

Table 39  Destination Follow Interface (Continued)

Item Parameters Description
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Profiles Tab
This tab provides a list of the available profiles. Selecting a profile (row) in this area automatically 
updates the items displayed in the Profile Details, Device Tree, and Options areas. (Figure 25)

Figure 25  Example of the Ultricore Profiles > Profiles

Table 41 summarizes the options displayed in the left pane of the Ultricore Profiles > Profiles tab. 

Table 40  User Profiles > Users

Item Description
Add Enables you to create a new user account by specifying a name and 

(profile) type. The new account now displays as a row at the bottom of 
the table.

Rename Enables you to change the account name and/or type.

Delete Removes the user account from the database

Clear Removes the user account from any profiles it was assigned to. The 
user account is no longer assigned to any profile.

User Each row represents a specific user account. Select a row to edit the 
profiles currently assigned to the account.

Assigned Profile Lists the profiles currently assigned to each user account.

Available Profiles Enables you to assign the user account to the profiles listed in this 
table. Use the provided buttons to manage what profiles the user is 
assigned to.

Table 41  User Profiles > Profiles

Item Description
Add Displays the Add profile dialog that enables you to create a new profile

Duplicate Copies the selected profile and creates a new profile using the same 
settings as the original
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The following sections outline each tab in the right panel of the Ultricore Profiles > Profiles tab.

Info Sub-tab

Table 42 summarizes the Info sub-tab. 

Configuration Sub-tab

This sub-tab is a visual representation of the tree view where the tree nodes are organized in a 
hierarchy that reflects the DashBoard Tree View. Note that certain entries that are specific to 
licenses or other conditions may be visible but not in the actual tree view. Should conditions change 
that enable those entries, they will appear as shown in this display. A profile also maintains the 
position of items in groups allowing the most relevant items to be the easiest to reach. 

 This area only displays when the ULTRICORE-PRO license is enabled on the router.

Figure 26  Example of the Ultricore Profiles > Profiles > Configuration Sub-tab

Table 43 summarizes the options displayed in the Configuration sub-tab. 

Delete Removes the selected profile from the database

Profile Name A list of the available profiles in the database

Table 42  User Profiles > Profiles > Info

Item Parameter Description
Profile name <text> Assigns a unique identifier to the profile. This name 

is used in the Ultricore Profiles interface.

Table 43  User Profiles > Profiles > Configuration

Item Description
Available Enables you to assign permissions to the selected profile listed in this 

table. Use the provided buttons to define what settings and functions 
that the profile can access.

Assigned Lists the settings and functions currently assigned to the selected 
profile

Table 41  User Profiles > Profiles (Continued)

Item Description
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Assign Users Sub-tab
This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.

 This area only displays when the ULTRICORE-PRO license is enabled on the router.

Figure 27  Example of the Ultricore Profiles > Profiles > Assign users Sub-tab

Table 44 summarizes the options displayed in the Assign users sub-tab. 

Tieline Builder Interface
The Tieline Builder creates tielines based on the routers and ports available to the Ultricore within 
the current database and routing system.

 The ULTRICORE-TLX license must be enabled to display the Tieline Builder node in the tree view.

Table 44  User Profiles > Profiles > Assign users

Item Description
Available Enables you to assign user accounts to the selected profile listed in 

this table. Use the provided buttons to define what user accounts are 
included in the selected profile.

Assigned Lists the user accounts currently assigned to the selected profile
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Figure 28  Example of the Tieline Builder Interface

Table 45 summarizes the options displayed in the Tieline Builder interface. 

Table 45  Tieline Builder Interface

Item Description
Existing Tielines

ID An auto-generated identification number assigned to the tieline

Name Indicates the unique identifier assigned to the tieline

From Device Indicates the router that the tieline will use as the source (start 
point)

Output Port Indicates the physical port that the tieline will use to switch the 
signal

To Device Indicates the router that the tieline will use as the destination 
(end point)

Input Port Indicates the physical port that the tieline will use to pass the 
signal through during the switch

Rename Applies a new identifier to the tieline

Remove Removes the tieline from the list and deletes it from the router 
system

From Device: Use this menu to display a list of available routers that the user 
can assign as the start point for a new tieline

Output Ports: Indicates the physical ports on the selected device that are 
available as sources for the tieline

To Device: Use this menu to display a list of available routers that the user 
can assign as the end point for a new tieline

Input Ports: Indicates the physical ports on the selected device that are 
available as destinations for the tieline

Add Tieline Adds the tieline defined using the From Device and To Device 
tables. The Existing Tielines table updates to include the new 
tieline as a row entry.
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Tieline Runtime Interface
The Tieline Runtime reports the sources and destinations for each defined tieline, enables the 
user to manage and monitor the switch requests using the define tielines.

 The ULTRICORE-TLX license must be enabled to display the Tieline Runtime node in the tree view

Figure 29  Example of the Tieline Runtime Interface

Table 46 summarizes the options displayed in the Tieline Runtime Interface. 

Table 46  Tieline Runtime Interface

Item Description
Existing Tielines

Tieline Name Indicates the unique identifier assigned to the tieline

From Device Indicates the router that the tieline will use as the source (start 
point)

Output Port Indicates the physical port that the tieline will use to switch the 
signal

To Device Indicates the router that the tieline will use as the destination 
(end point)

Input Port Indicates the physical port that the tieline will use to pass the 
signal through during the switch

Sources Reports the available signals on the From Device via the selected 
Output Port

Destinations Reports the available signals on the To From Device via the 
selected Input Port

Release Tieline Disables the selected tieline. It is no longer available for switching 
signals in the routing system

View Tieline Details Provides more information on the selected tieline

Destinations Using Tielines

Destination Specifies a specific destination in use by the tieline

Source Specifies a specific source in use by the tieline
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Path to Source Indicates how the signal is passed through the routing system via 
the selected tieline

Release Destination Removes the selected destination as an option for the tieline. 
This destination can no longer be used for a switch via the tieline.

View Destination 
Paths

Reports the route that the Ultrix or Ultricore has chosen to pass 
the selected source to the end point (destination) as defined by 
the selected devices, ports, and signals

Show Take Errors Indicates whether any error conditions are present during the 
switch the tieline

Table 46  Tieline Runtime Interface (Continued)

Item Description
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Enabling a Service
The Ultrix routers support a set of third-party communications protocols that allow the router to 
communicate with devices in your routing system. Before creating a connection point to each 
device, you must first enable the required protocol(s) on the Ultrix router, and configure any 
settings required for communication. This chapter outlines how to enable a communication service 
(protocol), and configure the additional settings on the router for each protocol (if required). A 
summary of the supported commands is also provided.

If you have questions about the operation of your Ross devices, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• how to establish a connection point to a device in your routing system, refer to “Adding 

Connection Points”.

Enabling a Communication Service
Use the options in the System > Configuration > Connections > Services interface to enable or 
disable each required service (protocol). This allows your router to communicate with an external 
device that uses the enabled third-party protocol.

To enable a service

1. Display the System > Configuration nodes as outlined in “To access the Database 
interfaces”.

2. Double-click the Connections sub-node.

The Connections interface opens in the DashBoard window with the Incoming Connections tab 
automatically selected.

3. Select the Services tab.

The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the router.

 Some services require that a license key is also enabled on your router. Refer to the Ultrix User 
Guide for your router to learn more.



68 • Enabling a Service Ultrix and Ultricore Database Guide (v1-rev6)

4. Enable or disable a service by selecting or clearing the associated box. Choose from the 
following:

• SSH service — Enables the ability to log onto the Ultrix router via an SSH server. Secure Shell 
(SSH) Login is a client-server protocol used by system administrators to securely log onto 
remote systems and execute commands over an unsecured network. SSH may also be used 
by Ross Technical Support for advanced troubleshooting.

• FTP service — Enables the ability to communicate with the Ultrix router over an FTP 
connection.

• Walkabout — Enables the Ultrix router to communicate with Ross Video devices in the 
Walkabout system.

• Ember Plus — Enables the Ultrix router to communicate with a third-party control system via 
the Ember+ media distribution protocol.

• GVG Native — Enables the Ultrix router to communicate via the GVG Series 7000 Native 
protocol and is available over an RS-422 or RS-232 serial connection, or ethernet connection.

• Nvision — Enables the Ultrix router to communicate via a limited sub-set of the NVISION 
serial NP0010 protocol, and the NVISION NP16 ethernet protocol. 

• Probel SW-P-08 — Enables the Ultrix router to communicate via the Probel SW-P-08 protocol. 
This protocol is available over an RS-422 or RS-232 serial connection, as well as an ethernet 
connection.

• RossTalk — Communications via the RossTalk protocol (a plain text based protocol that 
allows control of Ross Video equipment).

• TSL — Enables the Ultrix router to communicate via the TSL UMD v3.1, TSL UMD v4.0, and TSL 
UMD v5.0 protocols.

• NK — Enable this option if there are Ross NK series devices or signal types the Ultrix router 
itself does not handle. The Ross NK series devices must be connected to the ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable communication with the 
Ultrix router.

 The Enable Web Access determines if remote access and upgrades are enabled. This option is 
disabled by default (the Upload button is disabled in the DashBoard interfaces). Remote 
upgrades may optionally be enabled through DashBoard via this option. On bootup or power 
cycle, this option will default back to disable (box is unselected). You must select the box again if 
you wish to enable web access and firmware upgrades after a bootup or power cycle.

5. Click Apply.

Configuring the Service Settings
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your router and using the 
protocols enabled in the Services tab. Some services require you to configure additional settings on 
the router. This section briefly summarizes those additional settings.

For More Information on...
• the supported protocols, refer to “Server Options and Supported Commands”.

To configure the protocol settings

1. Display the System > Configuration nodes as outlined in “To access the Database 
interfaces”.

2. Double-click the Connections sub-node.

The Connections interface opens in the DashBoard window with the Incoming Connections tab 
automatically selected.

3. Select the Protocol Services tab.
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4. Click Options (located in the bottom toolbar).

The Server Options dialog opens.

5. Locate the options for the third-party protocol you wish to configure for communications.

6. Refer to the following sections for a summary of the settings based on the protocol.

7. Click Apply.

The Server Options dialog closes and the new settings are applied.
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Server Options and Supported Commands
Some protocols require additional settings be configured on the router. The following sections 
outline these required settings based for each protocol.

GVG Series 7000 Native Protocol Commands
The router supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 
serial connection, as well as an ethernet connection. Refer to Table 47 for connection details.

Table 48 summarizes the Server Options for the GVG Series 7000 Native protocol.

  

Table 47  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet
Port (incoming) 12345

Port (outgoing) 12345a

a.For outgoing connections, port 12345 is the default value but is 
user configurable.

Table 48  Server Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on protocol 

layer 4 (Ethernet only)

No Do not send acknowledgments. This is the default.

Sequence More to 
Come Character

# Enables the user to assign a number to the 
seq_flag field in a packet that will indicate more 
messages to come. The default value is 9.
A value of 0 (zero) indicates the last or only packet.

Send Trailing HT Yes Includes the trailing <HT> character (Horizontal 
Tab (0x09)) in the packet

No The trailing <HT> character is not included in the 
packet

Send nbr_sources 
Leading Zero

Yes Always forces the nbr_sources field to be 2 
ASCII characters (e.g. 1 becomes 01). This supports 
fragmentation of large message streams.

No Allows the nbr_sources field to be a single ASCII 
character

Repeated Packet 
Holdoff (ms)

# Ultrix detects repeated identical packets, and will 
skip processing if the packets are repeated within 
the specified delay. The default is 0.
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To send GVG Native commands to the router

1. Create a network connection to the router on TCP/IP Port 12345.

2. A valid connection is reported in the Connections > Incoming Connections interface.

3. Refer to Table 49 for a list of supported GVG Native Protocol commands.

Table 49  GVG Native Protocol Commands

Message
Notes

Command Description
BK[,parameter]

BK,D Force next QD command to return 
status of all destinations

Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (e.g. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination from 
having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination status by 
name

QD[,dest_name] Query Destination status by name No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by name Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by indexa

Qi,destIndex,lvlIndex Query Destination status by indexa The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by indexa No information is returned for unmatched destination levels

Qj Query Destination status by indexa Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter

QN,S Query source names/labels As defined inactive database

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name_
entry1[,...src_name_entryn]

Takes sources (on specified levels) to 
specified destination, by name rather 
than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or specified 
levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified levels) to 
specified destinations by index rather 
than name; allows breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.
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For More Information on...
• these commands, refer to the GVG protocol documentation.

NVISION Commands
This section outlines the NVISION protocol commands supported by the router.

 Ensure that the Ultricore-NVISION license is installed for your router. Refer to the Ultrix User 
Guide for details.

Table 50 summarizes the settings in the Server Options dialog for the NVISION protocol.

  

NVISION NP16 Ethernet Protocol

The router supports the NVISION NP16 Ethernet protocol. Table 51 outlines the default values for 
the router when using NP16.

NP16 Commands

The NP16 protocol defines the message format as follows: 

Protocol ID | Sequence Number | byte count | Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultrix and Ultricore response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 52.

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 52 for a list of supported NP16 commands.

a.Zero-based hex logical index numbering.

Table 50  Server Options — NVISION Protocol

Option Setting Notes
Offset 0 The Ultrix and Ultricore level matches the 

NVISION level

1 The Ultrix and Ultricore level is the NVISION level 
plus 1

Table 51  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 52  NP16 Protocol Commands

Message
Notes

Command Description
0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination
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NVISION NP0010 Serial Protocol

The router supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 53 outlines the router default values for an NP0010 serial connection.

Refer to Table 54 for a list of supported NP0010 commands.

Probel SW-P-08 Protocol Commands
The router supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 55 provides the default values for this protocol.

 

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 53  Default Connection Types — NVISION NP0010 Serial

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 115200

Data Bits 8

Parity No

Stop Bits 1

Table 54  NP0010 Protocol Commands

Message
Notes

Command Description
0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 55  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Table 52  NP16 Protocol Commands (Continued)

Message
Notes

Command Description
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Table 56 summarizes the settings in the Server Options dialog for the Probel SW-P-08 protocol.

  

Table 57 lists the supported Probel SW-P-08 Serial Protocol commands.

Parity None

Stop Bits 1

Ethernet
Port (incoming) 8910

Port (outgoing) 8910a

a.For outgoing connections, port 8910 is the default value but is 
user configurable.

Table 56  Server Options — Probel SW-P-08 Protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received command 
format (e.g. if received a non-extended command, 
reply in a non-extended format). This is the default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. This is the default.

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. The 
default is 0.

Do not wait for ACK Yes Ultrix and Ultricore will not wait for message 
acknowledgments between connect responses

No Ultrix and Ultricore will wait for message 
acknowledgments between connect responses. This is 
the default.

Batch Collate Timea

a.When both Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will release the 
batch, and the Batch Collate Split Size and the Collate Time values are reset.

# milliseconds Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature). 

Batch Collate Split Size # received 
commands

Wait up to 100 received commands before processing. 
The default is 0 (which disables this feature). 

Repeated Packet 
Holdoff (ms)

# Ultrix detects repeated identical packets, and will skip 
processing if the packets are repeated within the 
specified delay. The default is 0.

Table 57  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

Table 55  Default Probel SW-P-08 Connection Types (Continued)

Setting
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10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

Table 57  Probel SW-P-08 Native Protocol Commands (Continued)

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to the router

1. Create a network connection to the router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 58 for a list of supported 
commands.

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 58  RossTalk Protocol Commands

Message
Notes

Command Description
GPI ## Execute the salvo number corresponding to the 

numerical ## extension of the command
For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultrix and 
Ultricore database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

Table 57  Probel SW-P-08 Native Protocol Commands (Continued)

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
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For More Information on...
• adding a RossTalk label to an Ultriscape layout, refer to the Ultriscape User Guide.

TSL UMD Protocol v3.1 Commands
Table 59 outlines the default values for the router when using TSL UMD v3.1.

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique “rosstalk id” associated with 

an Ultriscape RossTalk display object. This 
field is compulsory.

• <text> is the text to be displayed. This field is 
optional.

• <bgcolor> is the background color of the text 
label. Specified in comma separated RGB 
format using 2 byte hex values (e.g. 
RR,GG,BB). This field is optional.

• <textcolor> is the text color of the text label.                
Specified in comma separated RGB format 
using 2 byte hex values (e.g. RR,GG,BB). This 
field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; 
BGCLR:0x00,0x00,0x00; 
TXTCLR:0xFF,0xFF,0xFF

Note that <bgcolor> and <textcolor> are 
specified as R,G,B triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-16)

Range start value must be less than the end 
value
Single levels and ranges can be mixed in the 
list (e.g. L:1,3,4-8,12-17)
There are no spaces between numbers or 
ranges
Invalid numbers or improperly specified 
ranges will be ignored 
An argument is separated from its value using 
a single colon (:)
Command arguments are separated single 
spaces
The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,3,5 and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16

Table 59  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5727

UDP Port 4490

Table 58  RossTalk Protocol Commands (Continued)

Message
Notes

Command Description
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Protocol Implementation

The router implements the protocol with the following structure:

 DisplayID|Control|DisplayData

Table 60 lists the supported TSL UMD Protocol v3.1 commands.

Refer to Table 61 when using TSL UMD v3.1 and configuring PiP Tallies in an UltriScape Head.

TSL UMD Protocol v4.0 Commands
 Table 62 outlines the default values for the router when using TSL UMD v4.0.

Table 60  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description UltriScape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a.Green/Red may be swapped by configuring the Global Tally Settings in the UltriScape Head interface.

Bit 1 Tally 2 status Tally 2 (Green)a

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD display text

Table 61  UltriScape Tally Display — TSL UMD v3.1

Red Tally Green Tally Display
ON ON RED IS ON

ON OFF RED IS ON

OFF ON GREEN IS ON

OFF OFF OFF (no tallies are lit)

Table 62  Default Connection Types — TSL UMD v4.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5728

UDP Port 4491



Ultrix and Ultricore Database Guide (v1-rev6) Enabling a Service • 79

Protocol Implementation

The router implements the protocol with the following structure: 

Header | Control | DisplayData | VBC | XData

Table 63 lists the supported TSL UMD Protocol v4.0 commands.

Table 63  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea

a.Where 0=off, 1=Red, 2=Green, 3=Amber

Not implemented

Bits 2-3 Text display valuea Sets text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text background; 
can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented
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TSL UMD Protocol v5.0 Commands
Table 64 outlines the default values for the router when using the TSL UMD v5.0 protocol.

Table 65 summarizes the settings in the Server Options dialog for the TSL UMD v5.0 protocol.

  

Protocol Implementation

Ultrix and Ultricore implements the protocol with the following structure: 

PBC | Ver | Flags | Screen | DMSG (Index, Control, Length, Text)

Table 66 lists the supported TSL UMD Protocol v5.0 commands.

Table 64  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5729

UDP Port 4492

Table 65  Server Options — TSL UMD v5.0 Protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). This 
is the default.

PBC in Count Value Yes Include the Packet Byte Count field when 
calculating the byte count value

No Do not include the Packet Byte Count field 
in the byte count value. This is the default.

Table 66  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description UltriScape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG
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Index 16bit Display Address DisplayID associated with source or 
destination

Control

Bits 0-1 Right hand tally valuea Sets right-hand tally indicator color

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text

a.Where 0=Off, 1=Red, 2=Green, 3=Amber

Table 66  TSL UMD Protocol v5.0 Commands (Continued)

Protocol 
Breakdown Description UltriScape System Use
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Creating a New Database
This chapter provides an overview of the Database Manager, and describes how to create a new 
database.

Defining a Database for a Routing System
Each database consists of a collection of configuration files necessary for routing operation. The 
database resides within the primary device storage system. Multiple databases may be saved and 
accessed at any time, but only one database can be active at a time. 

The following information is captured in a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels
• Current crosspoint status

 The following information is not captured in a database: hardware specifics, and license settings.

Once a new database is created, you then define the devices included in the new database. Next 
you define the levels, destinations, and sources for the new database. Templates are provided to 
help map the port assignments. This makes it easy to build basic configurations as well as get a 
system up and running quickly. 

Database Manager Overview
The Database Manager interface enables you to create system input and output lists, assign those 
signals to system sources and destinations, and define multiple levels and matrices.

Use the Database Manager interface to:

• Create a New Database — You can create a number of database configurations depending on 
your routing system and its devices. The Database Builder enables you to quickly create a 
database based on the routers assigned to it. Refer to “Creating a New Database”

• Delete a Database — You can choose to permanently delete any configured database. Refer to 
“Deleting a Database”.

• Activate/Inactive a Database — Select a database from a list of imported files to activate and 
apply its settings to your routing system. Note that only one database can be active at a time. 
Refer to “Activating a Database”.

• Create a Template — Use the Duplicate feature to create a copy of a current database to use as a 
template for new databases. Refer to “Copying a Database”.

• Import a Database — Enables you to import a saved database file and make it available in the 
Database Manager interface. Refer to “Importing a Database”. 

• Import a Legacy Database — You can import a database file that was last saved in a prior version 
of the software. The Database Manager will import the file, convert it to the current format, and 
save it to your Downloads folder on your DashBoard client computer. Once a file is imported, it is 
available for editing. Refer to “Importing a Legacy Database”.

• Export a Database — Enables you to capture the active database configuration as a file that is 
saved to the Downloads folder on your DashBoard client computer. Refer to “Exporting a 
Database”. 
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• Restore a Database — Enables you to quickly restore the active database to an earlier version. 
Refer to “Restoring a Database”.

Accessing the Database Manager
The Database Manager interface enables you to quickly define a database by auto-populating the 
applicable fields in the other database interfaces. Use the Database Builder tab to further define 
the database parameters. Refer to “Using the Database Builder” for details.

To access the Database Manager

1. Display the Databases nodes as outlined in “To access the Database interfaces”.

2. Double-click the Database Manager sub-node.

The Database Manager interface opens.

Creating a New Database
This section outlines how to create a new (blank or empty) database for a routing system. The steps 
for creating a new database is the same whether it is for a router or controller.

When using an ULTRIX-FR12, new databases must be created using the Ultricore BCS that is 
controlling the router.

When setting up a redundancy system with two Ultricore BCS, the active database on the units 
must match.

To create a new database

1. From the Database Manager interface, click  Add.

The Add dialog opens.

2. Use the Name field to type a unique identifier for the database.



Ultrix and Ultricore Database Guide (v1-rev6) Creating a New Database • 85

3. Click Add database.

The Add dialog closes and a new row displays in the Database Manager table with the name 
entered in step 2. Note that the status of the new database is Inactive.

4. Select the Database Configuration tab.

5. Use the Operation Mode options to determine if the database is editable and how changes are 
applied. Choose from the following:

• Auto save — Changes made to any database interface are automatically saved and applied. 
This is the default setting when a database is toggled to Active.

• Protect — All fields, except Aliases and labels, of the database are read-only and cannot be 
edited. A blue border displays around each interface. A blue Protected icon displays in the 
bottom left corner of every interface to remind the user that the database settings are now 
read-only.

• Manual save — The database is editable. An orange border displays around each interface. 
The Cancel and Save buttons display in the bottom right corner of each interface. After 
editing any interface, the user must then click Save to apply any changes. Clicking Save on 
one interface applies changes made to any interface in the database. This mode is 
recommended if you are editing numerous database settings and want to ensure the 
changes are applied after each edit.

 Note that setting the Operation Mode from Manual save to Auto save will automatically apply any 
unsaved changes.

6. Select the Enable tally box to enable tally ID configuration in the database when it is active.

The Source and Destinations interfaces will display the required Tally columns.

 Refer to “Tallies” for details on defining the Status Level for tally operation.

7. Use the Snapshots options to specify how often the database is auto saved or to create a 
snapshot version immediately (by selecting the Create option). The default is 15 minutes.

Using the Database Builder
The Database Manager provides the option of using the Database Builder feature to easily define a 
working database. The Database Builder is organized into a series of questions and menus that you 
select from. Once you define the basic parameters of the new database using the settings in the 
Database Builder interface, you can then define the levels, destinations, and sources for the new 
database. This makes it very easy to build basic configurations as well as get a system up and 
running quickly. 
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 Before proceeding, ensure that the required license keys are installed for your router(s). Refer to 
the user guide for your router for a list of available licenses and how to enable them.

 You can still create and edit layouts in a database with settings that differ from those set in the 
Database Builder interface.

To define a database using the Database Builder

1. From the Database Manager table, select the row for the database you wish to define.

2. Ensure the selected database is active. Refer to “Activating a Database”.

3. From the right pane of the Database Manager window, select the Database Builder tab.

The Database Builder interface opens in the DashBoard window. 

4. Select a device to configure from the Devices menu. 

This menu is located in the top right corner of the interface and auto-populates with a list of 
routers included in the selected database.

 If you wish to configure only a selection of settings, leave the remaining settings at their default 
values and click Build.

5. Use the vertical scrollbar to display more of the options in the Database Builder interface.

6. If any AUX Ports are populated with SFP modules, use the Include AUX ports menu to specify 
how to label the I/O in the database.

 The default is Insert at slot, which labels the I/O in each slot starting with 1 up to a maximum of 
18 with the AUX Ports as 17 and 18.

7. Use the Support Video Signal and Number of Audio Channels menus to define the Levels in 
the database.

8. Use the Breakaway Source Support menus to implement audio shuffling. The options for SDI 
and MADI channels are as follows: 

• None — no audio-only breakaway sources are created.
• Mono — sources are created to enable individual mono audio channel routing.
• Stereo — sources are created for stereo pair audio routing (1-2, 3-4, 5-6 etc.).
• Quad — sources are created for four channel groups or quad-audio routing (1-4, 5-8, 9-12 

etc.).
• Oct — sources are created for eight group audio routing (1-8, 9-16, 17-24 etc.).
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 You must have SFP modules installed that support MADI to implement the MADI routing with 
breakaway support.

9. Use the Disconnect Source menu to create a disconnect source that enables the routing 
silence to audio channels (muting).

10. Use the Passthrough Source menu to create a pass-through source definition. This enables 
setting an audio source to follow video bypassing the audio processing and other routing.

11. If you have an UltriScape license installed, use the menus to define the heads, including the 
number of Picture in Picture (PIPs) that new layouts can include. 

12. Use the remaining menus to configure the destinations and sources for the database.

13. Click Build.

The settings are updated and applied to the database.

Activating a Database
Each active database includes a unique setup. You must activate a database before you can 
configure the matrices, resources, and soft panels. This also enables you to quickly apply a different 
setup just by activating a different database. 

When one database is active, all other databases are automatically set to inactive.

To activate a database

1. From the Database Manager table, select the row for the database you wish to activate.

2. Click Activate from the top toolbar.

 The Operation Mode is set to Auto save when a database is activated.

3. Verify the following to ensure the database was activated:

• The Status field for the selected database reports active.
• The Status fields for all other databases report inactive.
• The Database node in the Tree View reports the active Database name. 

4. If required, use the Operation Mode options to determine if the database is editable and how 
changes are applied. Choose from the following:

• Auto save — Changes made to any database interface are automatically saved and applied. 
This is the default setting when a database is toggled to Active.

• Protect — All fields, except Aliases and labels, of the database are read-only and cannot be 
edited. A blue border displays around each interface. A blue Protected icon displays in the 
bottom left corner of every interface to remind the user that the database settings are now 
read-only.

• Manual save — The database is editable. An orange border displays around each interface. 
The Cancel and Save buttons display in the bottom right corner of each interface. After 
editing any interface, the user must then click Save to apply any changes. Clicking Save on 
one interface applies changes made to any interface in the database. This mode is 
recommended if you are editing numerous database settings and want to ensure the 
changes are applied after each edit.

 Setting the Operation Mode from Manual save to Auto save will automatically apply any unsaved 
changes.
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Managing the Databases
A database can be archived by saving it as an *.udb file to the Download folder on your computer. 
This enables you to import and export an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration
• importing a copy of a reference database that can be tailored to a specific application
• restoring a known backup copy of a database to your routing system

 A legacy database (created prior to v6.1) is saved as an *.uda file. You must import these 
databases as outlined in “Importing a Legacy Database”.

Overview
The following information is captured when you archive a database:

• Definitions of levels, destinations, and sources
• Salvos
• Category assignments
• Soft panels
• Alias sets
• Current crosspoint status

 The following information is not captured: hardware specifics, and license settings.

Copying a Database
Use the Duplicate feature to quickly create a copy of a selected database to use as a template for 
new databases.

To create a database template

1. From the Database Manager table, select the row for the database you wish to copy.

2. Click Duplicate from the top toolbar.

The Duplicate dialog opens.

3. Use the Name field to assign a unique identifier to the template.

4. Click Duplicate database.

5. Click Close.

The Duplicate dialog closes. The Database Manager table displays a new row for the template.

 The database is not automatically activated. You must follow the procedure “To activate a 
database” to activate the new database before editing it.

Exporting a Database
You create an archive of a database (as a *.udb file) using the Export option in the Database 
Manager. This enables you to create a duplicate or template of a database and edit it settings 
without impacting the original file.

 The database does not need to be active.

To export a database to the archive

1. From the Database Manager table, select the row for the database you wish to export.

2. Click Export from the top toolbar.
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The Export dialog opens.

3. Use the Save as field to specify the filename for the exported file.

4. Click Export database to specify the location to save the new *.udb file to.

5. Click Close.

The Export dialog closes.

Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of 
databases in the Database Manager.

 The database is not automatically activated. You must follow the procedure “To activate a 
database” to activate the imported database.

To import a database to the Database Manager

1. From the Database Manager toolbar, click Import.

The Import dialog opens.

2. Click Choose File.

3. Select the *.udb file you wish to import as follows.

4. Click Open.

The Select file field in the Import dialog reports the selected filename.

5. Use the Database name field to assign an identifier to the file. This name will display as a new 
row in the Database Manager.

6. Click Import database.

7. Click Close.

The Import dialog closes.

8. Verify that the imported database displays in the Database Manager.

Importing a Legacy Database
Databases created prior to the v6.1 software can be still imported and used via the Legacy DB 
feature of the Database Manager. Once a legacy database file is imported, the Database Manager 
converts it to an *.udb file type and saves it to the Downloads folder of your DashBoard client PC.

To import a database to the Database Manager

1. From the Database Manager toolbar, click Legacy DB.

The Import Legacy DB dialog opens and automatically lists each available legacy database file.
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2. Select the Import box for each database you wish to import.

3. Click Apply.

The Import Legacy DB dialog closes.

4. Verify that each imported database now displays in the Database Manager table.

Deleting a Database
 Ensure the database that you are about to delete is not currently active or is in use.

To delete a database

1. From the Database Manager table, select the row for the database you wish to delete.

2. Click Delete from the top toolbar.

The Delete database dialog opens.

3. Click Delete Database.

4. Click Close.

The Delete database dialog closes.
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Adding Connection Points
This chapter summarizes how to establish a connection point from the primary device (an Ultricore 
BCS) to a client device in your routing system. 

Overview
Once a new database is created on the Ultricore BCS, you add each client device (connection point) 
that will be included and controlled by the new database. This is required when using an Ultricore 
BCS as the primary device since it does not automatically detect the client devices in your routing 
system. 

For More Information on...
• the supported third-party protocols, refer to “Enabling a Service”.

Using an Ultricore BCS as the Primary Device
To enable an Ultricore BCS to function as the ‘primary’ of the routing system, you must establish 
communications with the ‘client’ devices it is connected to and define how they will communicate. 
Each client device in your routing system then will have a connection point to the primary that is 
defined in a database. Once this information is entered into a database, the primary device can 
communicate directly with each client device and manage its input and outputs (matrices). 

The Ultricore BCS acts as the primary device for one or more Ultrix routers as well as legacy Ross NK 
series devices. A connection is made from the primary Ultricore to each client device. The primary 
device manages the full database configuration for the entire operation of the system.

All control devices, such as a remote control panel (RCP) or third-party controller, must be 
configured for and communicate with the primary device. Any router configured as a client will only 
accept control commands via the primary device (the Ultricore BCS).

 Any routers to be controlled by the Ultricore BCS must have the Remote Controller Mode 
enabled.

 Ultricore redundancy is only available when using multiple Ultricore BCS units.

Connecting to Client Devices
A database captures each connection point made from the Ultricore BCS to each client device. 

When configuring a database on an Ultrix router, the connection points are automatically 
established.

Connecting to client devices requires you to:

1. Set up any licensing requirements within each client device. Refer to the User Guide for your 
device.

2. Set up any Ultriscape requirements within each client router. Refer to the Ultriscape User 
Guide.

3. Enable Remote Controller Mode on each client device. Refer to “Enabling Remote Controller 
Mode on a Client Device”.

4. Create a database on the primary device to accommodate the inputs/outputs (matrices) 
provided by the client devices. Refer to “Creating a New Database”.

5. Create a connection point from the primary device to any/all clients. Refer to “Adding 
Connection Points”.
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6. Edit the database to map logical source and destinations to client inputs/outputs, and any 
Ultriscape heads/PiPs. Refer to “Defining an External Matrix”, “Mapping the Destinations”, 
and “Mapping the Sources”.

Enabling Remote Controller Mode on a Client Device
Before establishing a connection point between the primary device and a client Ultrix router, each 
client must have its Remote Controller Mode enabled. This allows the client to be controlled by the 
primary device in the routing system.

To enable the Remote Controller Mode on a client Ultrix device

1. In the Tree View of the client device, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Setup tab.

3. Locate the Dashboard Interface area.

4. Select the Remote Controller Mode box.

5. Wait for the new setting to be applied.

6. Verify that the Tree View of the client device no longer displays the nodes for configuring a 
database.

Accessing the Routing Devices Interface
The options in the Routing Devices interface enable you to specify the devices in your routing 
system, and create connection points from the primary device to each client device. 

To access the Routing Devices interface on the primary device

1. Display the Configuration nodes for the primary device as outlined in “To access the Database 
interfaces”.

2. Double-click the Routing Devices sub-node.

The Routing Devices interface opens.
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Adding Connection Points
A single primary device can communicate with multiple client devices such as Ultrix routers, remote 
control panels, Ross NK devices, and automation devices running third-party protocols. This section 
outlines how to add a new connection point based on the type of client device you want to connect 
to.

Before You Begin
Keep the following in mind when establishing a connection point from a primary device to clients:

• Assign a unique name to each client device. This allows identification of each device throughout 
the setup process.

• Client device configuration (licensing, port configuration, etc.) is achieved via the client’s nodes 
within the DashBoard tree. Refer to the User Guide for your router or Ultricore BCS.

• Client Ultriscape Multiviewers are configured via the Ultriscape node within the DashBoard tree 
of the client that physically hosts that Multiviewer. Refer to the Ultriscape User Guide for details.

• Routing commands are issued to the primary device via remote control panels, external 
protocols or DashBoard soft panels.
› Only the soft panels defined within the database of the primary device may control the system.
› Any client device will ignore routing commands not originating from the primary while in this 

connected mode.
• Some communication protocols refer to source and destinations with a numerical index number. 

This number is listed in the ID column of the Source and Destination interfaces of the database.

Adding a Ross Device
This section briefly summarizes the steps required to manually add a new client device to the 
Routing Devices interface. The specific steps required, based on the communication/protocol type 
used, are provided in the subsequent sections.

Once all the client devices are added to the Routing Devices interface, you will need to configure a 
connection point to each device. The steps required to define a connection point depend on the 
type of communication (ethernet or serial), and protocol (TCP, TSL, RossTalk, etc.) that the client 
device uses. 
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To add a client device

1. From the Routing Devices interface, click  Add.

The Add Device dialog opens with the Ross tab automatically selected.

2. If your device uses a Ross protocol:

a. Use the Protocol menu to select the protocol the client device will use to communicate with 
your primary device.

b. Use the IP field to specify the IP address assigned to the client device in your network.

c. Use the Name field to type a unique identifier for the client device.

3. If your device is a Ross NK product:

 The Ross NK series devices must be connected to the Ethernet network by virtue of an Ross 
NK-IPS or NK-NET devices to enable the routing system to communicate with them.

a. Select the Ross NK tab.

b. Use the Protocol menu to specify the type of Ross NK protocol the device requires.

c. Use the IP field to specify the IP address assigned to the NK-IPS or NK-NET that is connected 
to the device you wish to add.

d. Click Get device list to update the entries in the Add Devices dialog.

e. Select the Add box for each NK device you wish to add.

4. If your device uses a third-party protocol, refer to “Defining an External Matrix”.
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5. Click Apply.

The Add Device dialog closes.

The Routing Devices table updates to include a new row for the client device.

Defining a Connection Point to a Client Device
Once a connection point is established between the primary device and its clients, the physical 
inputs and outputs the clients provide will display in the active database. These input and outputs 
ports are now ready for renaming (if required) and mapping to logical source and destinations in 
the database. 

 A connection point is created using the primary device interface. Do not attempt to create a 
connection from a client to the primary device.

 Ultriscape PiP and head destination mapping is required in the primary device database for each 
Ultriscape Head in use. The procedure is the same as the Ultriscape configuration for a 
stand-alone Ultrix router. 

To enable the connection point between the primary and a client device

1. In the Routing Devices interface of the primary device, select the row for the client device you 
wish to create a connection point to.

The interface displays the Communication, Matrix, and Info tabs for the selected client device. 

2. Select the Communication tab.

3. Set the Device Status field to disabled.

4. Use the Device name field to edit the identifier assigned to the device within the database.

5. Use the IP Address field to edit the IP address assigned to the client device.

6. Verify that the other fields are correct.

7. Set the Device Status field to enabled.

 The changes are automatically applied once the Device Status is set to enabled.

Defining a Connection Point to an IP Matrix
 Before proceeding, ensure the Ultricore BCS and any client devices are running version 6.5 or 

higher.

Defining a connection point to an IP device is much like creating a connection point to other device 
types. Each IP device is identified as a separate device in the Routing Devices interface. You can then 
create connection points to individual devices in your database to include the ports and streams as 
sources and destinations. The IP device is reported in the database using the nomenclature of 
slot.port.ip-type.channel. For example, slot1.out[2].ip-video.ch1 is an Ultrix-IPX-IO blade in 
router slot 1 and a sender video stream via the second port on that blade.

Using an Ultricore BCS
When the Ultricore-IP licensed feature is enabled, the Ultricore BCS provides the following methods 
for defining a connection point to devices in your IP matrix:

• To display all NMOS devices discovered on the same subnet, select Product Info > Ultricore-IP > 
Main. Refer to the Ultricore BCS User Guide for details.

• To manually add an NMOS device using its IS-04 URL, select Product Info > Ultricore-IP > 
Advanced Options > Static NMOS Devices. Refer to the Ultricore BCS User Guide for details. 
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• Using the Database > Routing Devices > IP Discovery option. This method displays the IP 
Discovery dialog that lists each detected IP device on the same subnet as your Ultricore BCS. 
Select a device from the dialog to enable a connection point to it. This is useful if the IP matrix was 
recently updated with new devices detected via the RDS the Ultricore BCS can access.

To manually add an IP device connection point to the Ultricore BCS

1. Ensure each required IP device is reported on the Ultricore BCS > Product Info > Ultricore-IP > 
Main tab. Refer to the Ultricore BCS User Guide for details.

2. In the Routing Devices interface of the Ultricore BCS, click .

The IP Discovery dialog opens.

3. Select the box for each device you wish to create a connection point to.

4. Click Apply.

The IP Discovery dialog closes and the Routing Devices interface updates to display a row for 
each added device. 

Using an Ultrix Router
The Ultrix routers enable you to define a static RDS and IP devices using the options in the Frame 
Configuration > Ultrix-IP tab > NMOS sub-tab. This requires at least one ULTRIX-IPX-IO blade. Refer 
to the Ultrix User Guide for your router. Once you have defined the IP matrix on your router, you 
can add the IP matrix to the database.

To add an IP matrix to the database

1. Ensure the IP matrix is defined on your router. Refer to the Ultrix User Guide for your router.

2. In the Routing Devices interface, click .

The Add Device dialog opens with the Ross tab automatically selected.

3. Use the Protocol menu to select IPMatrix - tcp.

The IP and Name fields are automatically filled in and read-only.

4. Click Apply.

The Add Device dialog closes and the Routing Devices interface updates to display a row for 
the new IP matrix.

Defining a Connection Point for a Third-Party Protocol
Ultrix and Ultricore provide support for many industry standard protocols for interfacing to 
external devices such as control systems, external routing matrices, and tally systems.

 Before proceeding, ensure that your external device is installed and configure according to its 
documentation.

Connection to external devices may be categorized into two groups: controller and controllee.   

• Controllers are devices that will connect via what may be termed an incoming connection.
• Controllees are devices to be controlled by the primary device and connect via what may be 

termed an outgoing connection.

For More Information on...
• the supported third-party protocol commands, refer to the user guide for your device.
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Connection via Ethernet
Incoming ethernet connections are defined within the control system by default and need no 
further configuration. Table 67 lists the available protocols and ports. The Ultrix or Ultricore can 
communicate with third-party external devices via a TCP connection. By default, Ultrix and Ultricore 
runs a server process for the following Ethernet protocols:

The available Protocol Server options depends on the type of protocol. Table 68 briefly summarizes 
the server configuration options for each protocol type. 

Table 67  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

TSL UMD v3.1 TCP: 5727
UPD: 4490

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492

Table 68  Protocol Server Options

Protocol Option Notes
GVG Native Series 7000

L4 Echo • No — the Ethernet Layer 4 acknowledge is disabled. This is the default.
• Yes — the Ethernet Layer 4 acknowledge is enabled.

Probel SW-P-08

Protocol Variant • Use Last Req — Ultrix or Ultricore will respond using protocol variant 
(extended/non-extended) as per the received request format. This is 
the default.

• Non-Extended — Ultrix or Ultricore will always replay using 
non-extended formatting.

• Extended — Ultrix or Ultricore will respond with extended formatting.

Matrix Mode • No — Ultrix or Ultricore will use information from the LEVEL section of 
the protocol to control Ultrix levels.

• Yes — Ultrix or Ultricore will use information from the MATRIX_ID 
section of the protocol to control Ultrix levels.

TSL UMD v5.0

Wrapping • No — the DLE/STX wrapping is not enabled. This is the default.
• Yes — enables the DLE/STX wrapping for TCP/IP transport 

PBC in Count • No — Packet Byte Count is not included in total byte count. This is the 
default.

• Yes — Packet Byte Count is included in total byte count.
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To set up an outgoing ethernet connection to a client device

1. In the Routing Devices interface of the primary device, select the row for the client device you 
wish to create a connection point to.

The interface displays the Communication, Matrix, and Info tabs for the selected client device. 

2. Click  Add.

The Add device dialog opens.

3. Use the Protocol menu to select the third-party communication protocol the device uses. 

4. In the Name field, type a unique identifier for the client device. This name is used to identify the 
specific device within the database.

5. Click Apply.

The Add device dialog closes and a new row displays in the Routing Devices table.

6. In the Routing Devices table, select the row for the new device.

7. Select the Communications tab.

8. Use the Port field to specify the Port Number assigned to the client device that the primary 
device will try to connect to.

9. Set the Device Status field to enabled.

Defining a Serial Connection
This section provides information on how to set up a connection directly with third-party devices 
using a native serial protocol. Serial connections must be defined before either incoming or 
outgoing connection styles may be utilized by the routing system. Refer to Table 69 for information 
on the supported protocols.

  A USB-to-Serial converter must be used to provide a serial communication port. Only USB-serial 
devices based on these chip-sets are supported: FTDI Chip, Belkin, Prolific PL 2303, and Silicon 
Labs CP210x.

A serial connection point must be implemented via the Routing Devices interface in the database 
before communications can start. The settings may be changed from the protocol defaults to suit 
your requirements.

To set up a serial connection between a primary device and a client device

1. Double-click the Routing Devices node located under the Database node.

The Routing Devices interface opens.

2. Click  Add.

Table 69  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1
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The Add Device dialog opens.

3. Use the Protocol menu to select the protocol standard.

a. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

b. Click Apply to create the new device row(s) to Routing Devices table.

4. In the Name field, type a unique identifier for the external device. This name is used to identify 
the device within the database.

5. Click the [...] button in the new row to display the Communication dialog.

6. Use the Port field to specify the Port Number assigned to the external device that Ultrix and 
Ultricore will connect to.

7. From the Type menu, select RS232 or RS422.

The table in the Communication dialog updates to display the settings for serial 
communication.

8. Use the Type field to specify the serial transmission standard for the external device.

9. Use the Baud Rate field to specify the bit rate for the external device.

10. Use the Parity field to specify the parity.

11. Click Apply to save your settings and close the Communication dialog.

12. In the new row of the Servers table, select the Enabled box.

 The system does not poll or query the serial link to verify the validity of the setup.

Removing a Connection Point
If requirements change, a connection point from a primary device to a client device may be disabled 
or deleted from the database.

• Disabling a connection point retains the device information in your database but the connection 
is no longer active. 

• Deleting a connection point removes the information from your database. The communication 
with the device stops.

 You will need to re-configure the primary and client devices as per the new requirements (e.g. if 
the deleted client device was an Ultrix router, you can disable its Remote Controller Mode).

To disable a connection point between the primary and a client device

1. Expand the Database node for the primary device.

2. Double-click the Routing Devices node located under the Database node.

3. Select the row for the connection point to be disabled.

4. Select the Communications tab.

5. Set the Device Status field to disabled.

To delete a connection point between the primary and a client device

1. Expand the Database node for the primary device.

2. Double-click the Routing Devices node located under the Database node.

3. Select the row for the connection point to be deleted.

4. Click Delete.
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5. Click Apply.

6. Power cycle the client device to re-establish its internal database.

7. If the client device is an Ultrix router, disable the Remote Control mode on it as follows:

a. In the Tree View of the client device, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

b. Select the Setup tab.

c. Locate the Dashboard Interface area.

d. Clear the Remote Controller Mode box.

e. Verify that the full Tree View now displays in the DashBoard window for the client device.
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Defining an External Matrix
The database system does not automatically know the details of any connected third-party matrix 
(e.g. number of inputs, outputs, levels, etc.). This means that you must manually define the size and 
operating level for each device within the active database. This chapter outlines how to add the 
details of the external matrix provided by your client device(s) to the database.

For More Information on...
• enabling SNMP support on your router, refer to its Ultrix User Guide.
• communicating with a third-party control system via a media distribution protocol, refer to 

“Enabling a Service”.

Third-Party Matrix Control with the Ultricore BCS
The Ultricore BCS control system is able to control client devices via supported third-party 
protocols. The following sub-sections outline each step required to configure third-party matrix 
control.

To configure third-party matrix control

1. Create an outgoing connection point from the Ultricore BCS to the client device.

2. Create a logical matrix for the client device.

3. Map the client device inputs and outputs.

4. Define the Ultricore BCS operating level.

5. Assign the matrix to the database source and destination levels.

6. (optional) Apply an alias set to update the database labels. Refer to “To define the alias set for 
an external device matrix”.

Creating a Logical Matrix for a Client Device
Once you establish a valid connection point between the Ultricore BCS and the client device, you 
can create logical matrices in the active database using the device inputs and outputs. Creating a 
logical matrix from the client device enables the Ultricore BCS to include client inputs and outputs 
for selection in the database.

 The input/output range and level you specify in the database must match the settings within the 
client device matrix. 

To create a logical matrix from a client device

1. Navigate to the Routing Devices node as outlined in “Accessing the Routing Devices 
Interface”. 

2. In the Routing Devices table, select the row for the client device you added.

3. Select the Matrix tab.

4. From the Device ID drop-down menu, select the client device you want to define the logical 
matrix for. This is the name given to the device when you established a connection point with it.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
primary device.
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5. Define the matrix size as follows:

a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the active database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the active database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the client device during setup.

6. Use the Level field to specify the number of levels for the device within the database.

7. Use the Type field to specify the signal type for the logical matrix. 

8. In the Communications tab, set the Device Status to enabled.

Mapping the Matrix to Database Inputs and Outputs
Once the connection point and logical matrix are defined in the database, you can map the matrix 
inputs and outputs in the same manner as we do with Ross device matrices. However, you will 
instead select an external matrix output from the Outputs list (or an external matrix input from the 
Inputs list) in the database interfaces. The available inputs and outputs will display in the format of 
DeviceID.slot#.in[x].Type.ch# or DeviceID.slot#.out[x].Type.ch# where DeviceID 
represents the Name assigned to the client device on the Routing Devices interface.

 It may be necessary to create a new level in the database for the assignment of inputs and 
outputs to logical labels. Refer to “Defining the Levels” for details.

For More Information on...
• assigning destinations, refer to “Mapping the Destinations”.
• assigning sources, refer to “Mapping the Sources”.

Using Index Numbers
Some protocols refer to source and destinations with a numerical index number. This number is 
listed in the ID columns of the database interfaces (far left column in each interface). 
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Defining the Levels
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Ultrix and Ultricore use level definitions for easy identification and control of various routing 
matrices or parts of the system. 

 Procedures in this chapter assume that DashBoard is launched, the primary device displayed in 
the Tree View, and the required database is activated with its Operating Mode set to Auto save.

Before You Begin
Determining the number of levels needed requires a little planning:

• Each router can operate with as little as one level to define control of the SDI switching matrix. 
• Ultrix contains the UltriMix audio sub-system which allows independent routing of SDI 

embedded audio channels as well as MADI channels. Using a single level control, the router can 
limit the independent selection of embedded audio and/or MADI streams. 

• Any Ross NK series routers or third-party devices connected to the routing system will require 
their own control levels.

 The quantity of levels determines how many independent IN/OUT ports (including embedded / 
MADI channels) may be grouped together as one source or destination selection.

Example 1

A single control level can be used when there is no requirement for independent embedded 
audio/MADI channel switching. For example: 

 If AFV (audio-follow-video) is desired on a single level database, the Audio Bypass must be 
enabled for each IN and OUT port. Alternatively, the UltriMix audio routing sub-system may be 
disabled on a per slot basis. Refer to the user guide for your router.

Example 2

A single level setup with NK-A64 analog audio router attached would require the following levels: 

Example 3

A setup using SDI with 4 embedded audio levels. This can allow independent switching of 4 of the 
embedded SDI channels and grouping of 4 MADI channels.The following levels would be required:

ID Name
1 SDI

ID Name
1 SDI

2 AnAud L

3 An Aud R

ID Name
1 SDI

2 A1

3 A2

4 A3

5 A4



104 • Defining the Levels Ultrix and Ultricore Database Guide (v1-rev6)

Defining a Level
The levels defined in the Levels interface have a direct relationship with the Level entries in other 
database configuration interfaces.

For More Information on...
• setting the tally level, refer to “Defining the Status Level for Tally Operation”.

To define a level in the database

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Levels node located under the Database node.

The Levels interface opens with the pre-defined levels specified using the Database Builder.

3. Verify the ID field to specify the priority of each level.

 The ID field is a row number automatically defined by the routing system. This ID value 
corresponds to level numbers when used in remote control panel (RCP) configurations and 
third-party communications.

4. To re-name a level:

• In the Name column, type a unique identifier for the level. 
• It is recommended to use words that describe the level such as VIDEO, AUDIO, etc.

5. To select a unique color that will represent the level in the soft panels:

a. In the Color column, double-click the cell for the level you want to configure.

b. Select the hue from the provided vertical color grid in the Color Select dialog.
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c. Confirm that the field beneath the color grid displays the correct color for the level.

d. Double-click the cell again to close the Color Select dialog.

6. Use the Description column to enter a brief summary of the level or provide additional 
information about the level use or purpose.

 The Description column is for identification purposes only and not required for operation.

To create additional levels

1. Select a row in the Levels interface.

 It is recommended to insert below the last row in the table.

2. Click  Add.

The Add Levels dialog opens.

3. Use the Levels options to specify the type of level to add.

4. Use the Level count to specify the number of new levels to add.

5. In the Name (prefix) field, type the label for the level(s). 

For example, type AUDIO into this field to create levels named AUDIO 1, AUDIO 2, etc.

6. In the Start count field, type the first number to be used in the series.

7. Use the Color option to assign a specific display color for the levels.

8. If required, use the Description field to enter text that helps to identify the levels.

9. Verify the Levels to add field reports the correct number of levels you wish to add.

10. Click Apply.

The Add Levels dialog closes.

The Levels table updates to display the new levels.

To delete an entry from the Levels table

1. Select the row for each level to delete.

2. Click Delete.

To reassign the IDs of the Levels table
• Click Reset IDs.

The ID assigned to all the Levels are updated where the first row (Level) is assigned ID 0, with 
consecutive rows assigned 1, 2, 3, etc.
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Mapping the Destinations
This chapter outlines how to map the destinations in your database. Procedures in this chapter 
assume that you have DashBoard launched and the required database is active.

Before You Begin
Table 70 outlines the available outputs for mapping to the destinations in your database. 

For More Information on...
• defining a database, refer to “Creating a New Database”. 
• the ULTRIX-MODX-IO blade and its modules, refer to the ULTRIX-MODX-IO User Guide.

Adding Destinations to the Database
Using the Database Builder feature enables you to quickly define the destinations for a database. 
But you can still add destinations to an active database using the Add function in the Database > 
Destinations interface.

The Destinations interface is organized into a table with each row representing a Destination and 
each column representing a Level. The table cells are the output ports assigned to the Destination 
for that level. Initially, the destination label “Dest #” is assigned to the physical output sockets. The 
labels can be edited as described in “Updating the Destination Labels”.

 A database supports a maximum of 4096 destinations.

To add new destinations to the active database

1. Double-click the Destinations node located under the Database node.

The Destinations interface opens with the table auto-populated as defined by the Database 
Builder settings.

Table 70  Mapping Outputs to Database Destinations

Default Slot Label

Physical 
or 

Virtual 
Port?

Description

Slotx.out[y].sdi.ch1 P Digital video output slot x port y

flex.out[y].sdi.ch1 P Digital video output Flex slot port y of an ULTRIX-FR5

Slotx.MODX-out[y].sdi.ch1 P Digital video output slot x port y of an Ultrix-MODX-IO blade

Slotx.out[y].audio.chn P Digital audio channel n of output slot x port y

flex.out[y].audio.chn P Digital audio channel n of Ultrix-MODX-IO slot x output port y

Slotx.MODX-out[y].audio.chn P Digital audio channel n of Ultrix-MODX-IO slot x output port y

Slotx.head[y].sdi.ch1 V Ultriscape video output slot x head y 

Slotx.heady-pip[z].sdi.ch1 V Video destination for PiP z of slot x Ultriscape Head y

Slotx.heady-pip[z].meter.chn V Audio destination for meter n PiP z of slot x Ultriscape Head y

Slot0.mixer-in[y].audio.ch1 V Audio destination mixer input port y

Slot0.virt-out[y].sdi.ch1 V Acuity AUX BUS output port y
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2. Click  Add.

The Add Destinations dialog opens.

3. Use the Name (prefix) field to specify the label for the new destination entries.

4. Use the Start count field to specify the first destination in the new series.

5. Use the Count field to specify the last destination in the new series.

6. Verify the value reported in the Destinations to add field is correct.

7. Click Apply.

The new destination(s) are automatically added as rows to the bottom of the Destinations table.

Mapping the Destinations
Once you have created new entries in the Destinations table, you can map each entry to an output 
for each level.

  If you are defining the destinations in a database for use with UltriScape, it is recommended to 
first define the destinations, then re-name the UltriScape Heads as required. Otherwise there 
may be duplicate channel assignments in the database.

For More Information on...
• assigning Tally IDs to destinations, refer to the Ultricore BCS User Guide. 
• using a template to map the destinations, refer to “Using the Templates”.

To map a single destination

1. Locate the destination to map in the Destinations table.

2. If desired, type a new name for the destination in the Name cell as outlined in “To edit a single 
destination label”.

3. Select the row for the destination to map.

 Use the auto-fill feature to quickly edit a destination, by locating the cell in the Destinations 
table, type the text and click the cell to display a pull-down menu of matching destinations to 
choose from.

4. Click Edit.

The Edit dialog opens.

The following example shows that the user is editing the destination labeled OUT_1.
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5. From the Slots area, select the blade to map.

The Ports area auto-populates with the outputs available in the active database.

6. From the Ports area, select the output to assign to the destination.

The Channels area auto-populates with the video and audio channels available in the active 
database.

7. From the Channels area, select a row for each level to map.

In the following example, the user will map sdi.ch1 and audio.ch1 to OUT_1.

8. Click Fill destinations.

The Destinations table updates with the selected destination mapped.

9. Click Edit to close the dialog.
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To map a selection of destinations

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available outputs. The 
assignment operation will take the top-most of the available outputs selection and assign it to the 
left-most of the horizontal selection etc. through the range.

1. Select the first cell in the table column.

2. Press and hold Shift.

3. Select the last cell in the table column. 

4. Click Edit.

The Edit dialog opens.

The following example shows that the user is mapping three destinations.

5. From the Slots area, select the blade to map.

The Ports area auto-populates with the outputs available in the active database.

6. From the Ports area, select the output to assign to the destinations.

The Channels area auto-populates with the video and audio channels available in the active 
database.
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7. From the Channels area, select the channel(s) to map to the selected destinations.

In the example below, the user is mapping one video channel (sd.ch1), and two audio 
channels (audio.ch2, and audio.ch4) to each selected destination.

8. Click Fill destinations.

The Destinations table updates with the selected destination mapped.

9. Click Edit to close the dialog.

To map a series of outputs to multiple destinations on the same level

1. In the table of the Destinations interface, select the first row in the series you want to define 
for the level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column. 

4. Click Edit.

5. Repeat steps 5 to 8 in the above procedure.

6. Click Edit to close the dialog.
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To delete a destination from the database

1. In the Destinations table, select the destination(s) to delete. 

2. Click Delete.

 You can delete the mapping assignment(s) but keep the destination entry in the database by 
selecting the destination row and clicking Clear.

Using the Fill I/O Tool
The Fill I/O tool enables you to manage the mapping templates, and edit the port assignments for 
any number of destinations. 

When the Fill I/O button is selected from the toolbar, the Fill I/O dialog opens in a drawer in the left 
pane of the Destinations interface. This enables you to access the Fill I/O options and still view the 
destinations available in the active database. Clicking the Fill I/O button again closes the dialog.

To map destinations using the Fill I/O tool

1. Click Fill I/O.

The Fill I/O button is now lit blue and the Fill I/O dialog opens.

2. If the database includes more than one device, use the Devices options to select which device 
to edit the destination labels.

3. Use the Slots options to select the router slot that will provide the outputs.

 Virtual ports (refer to Table 70) are available via slot0.

4. Use the Ports options to select the output port(s).

 If required, use the Filter field to display only the entries that match the specified text. For 
example, enter out[5 to display only the OUT 5 ports of the selected slot(s).

5. Click Fill Destinations.

The Fill I/O dialog closes.
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Using the Templates
Templates can be used to quickly map the destinations in the active database. Each template 
provides a unique configuration. Access the Template options by clicking Fill I/Os > Templates. 
(Figure 30) Selecting a template automatically maps the destinations in the active database.

Figure 30  Example of the Destinations > Templates Dialog

A read-only field, located beside the Templates button at the top of the dialog, reports the template 
currently in use. For example, Figure 30 shows that the SDI template is currently applied to the 
database.

Overview
There are two types of templates: system and user created.

System

There are three system templates that provide settings that are for a specific function (such as 
audio mapping) that display when you select the template. These templates are listed at the top of 
the Templates dialog and cannot be deleted or copied. The following system templates are 
provided:

• Audio mixer
• MADI
• Single level
• Acuity

There are also system templates that can be copied, edited, or deleted. These templates 
automatically map the levels and destinations in a specific pattern. These templates are listed at the 
bottom of the Templates dialog and provide options for editing, copying, and deleting. Copying a 
template enables you to duplicate the template as a new version that can be edited and saved as 
required. The following templates can be customized:

• SDI
• MV PIP
• MV Head
• IP
• IP SDI
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User Created

Templates can also be created by the user by clicking New template, or by duplicating an existing 
template, or saving the current mapping as a new template. Copying an existing template enables 
you to edit the map without impacting the current configuration. 

Applying a System Template
The SDI template is applied by default.

To apply a system template to map the destinations

1. Click Fill I/Os > Templates.

The Templates dialog opens with a list of available templates.

2. To apply a template, select it from the list.

3. If you selected the Single level template:

a. Use the Level menu to specify the specific database level to map.

b. Use the Channel type menu to specify the signal or data type for the destinations in this 
level. 

c. Click Apply.

4. If you selected the MADI template:

a. Use the Start at level menu to specify the first database level for the destination mapping.

b. Use the Channels per destination menu to select the number of audio channels to map. If 
you selected Custom, enter the number of channels in the provided field.

c. Click Apply.

5. If you selected the Acuity template:

a. Use the Acuity number field to assign an ID number to this router to identify it to the 
downstream Acuity switcher. The default is 1.

b. Click Apply.

6. Verify that the Templates read-only field now reports the name of the selected template.
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Applying a Template
This procedure can be used to map your database destinations using any template.

To map the destinations using a template

1. Click Fill I/Os > Templates.

The Templates dialog opens.

2. Select a template from the provided list.

Creating a New Template
You can choose to create a new blank template or copy an existing a template and saving it with a 
new name.

To create a new template to map the destinations

1. Click Fill I/Os > Templates.

The Templates dialog opens.

2. Select New template.

The Channels map template dialog opens.

The dialog is organized into a table with the database levels for the columns and each row 
representing a specific destination.

3. Use the Template name field to assign a unique identifier for the template.

4. Select the box for each destination/level the template will map.

5. Click Save. This button is located in the bottom right corner of the Channel map template 
dialog.

To copy an existing template

1. Click Fill I/Os > Templates.

The Templates dialog opens.

2. Locate the template you wish to copy.

3. Select  beside the template name.
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The Channel map template dialog opens. Notice that the Template name field reports the name 
of the selected template with (Duplicate) added.

4. Use the Template name field to assign a unique identifier for the template.

5. Select the box for each destination/level the template will map.

6. Click Save. This button is located in the bottom right corner of the Channel map template 
dialog.

Exporting and Importing the Destination Mapping
The Destinations interface provides the option to create a backup copy of the current destinations 
map (as an *.xlsx file), edit its contents if required, and then import the updated map into the 
database. Or, if you wish to change the destinations map to another desired scheme, import the 
required *.xlsx file to the active database.

This section outlines how to export and import spreadsheets that determine the destination 
mapping for the active database.

Exporting a Destination Map
The Destinations interface provides the option to export the current destination mapping as an 
*.xlsx file that is stored on your DashBoard client computer. This enables you to create a backup 
copy of the map, edit its contents if required, and then import the updated map into the database. 

To export the current destination map to a spreadsheet

1. Display the Destinations interface.

2. Verify the current map is the one you wish to capture.

3. Click Export.

The Export Destination Spreadsheet dialog opens.
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4. Use the Save as field to assign a unique filename to the destination map.

5. Click Apply.

The Downloads dialog opens in the DashBoard window and reports when the file is saved as an 
*.xlsx file in the Downloads folder of your DashBoard client computer.

Importing a Destination Map
A destination map can be defined in a spreadsheet (*.xlsx) that is organized like the table on the 
Destinations interface. You can create a new spreadsheet or edit a spreadsheet that captured an 
existing destination map. Much like the Destinations interface, each row in the spreadsheet 
represents a specific port in the routing system.

In Figure 31, the user created a spreadsheet for 19 destinations (DST 1-19), and three levels (VID, 
AUD 1, AUD 2).

Figure 31  Example of a Destinations Map Spreadsheet

 Unicode characters are not supported.

To define a new destination map using a spreadsheet

1. Create a new spreadsheet in Microsoft® Excel® or other application that supports *.xlsx files.

2. Label the sheet as destinations.

3. Label the first column as UIID.

4. Label the second column as Name.

5. Label the next column as Description.

6. If tallies are enabled for the database:

a. Label a column Tally.

b. Label the next column as TallyMode.

7. Label each subsequent column as a Level in your database.

8. In the UIID column, enter the ID number for the destination starting with zero (0).

9. In the Name column, enter the database label (text) for the destination. 

For example, enter DST 1 for the first entry.

10. If tallies are enabled for the database:

a. Use the Tally column to specify the Tally ID for the destination.

b. Specify the Tally Mode by entering 0 (Normal), 1 (Redirect), or 2 (Routed).

11. In the Level column, enter the destination as: Frame.slot.port.type.channel.
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12. Repeat steps 8 and 11 for each destination (row).

 Any blank cells in the spreadsheet will be mapped as blank entries in the Destinations interface.

13. Save the spreadsheet to the Downloads folder on your DashBoard client computer.

To import a destination map

When you import a destination map, it is automatically applied to the database. 

1. Display the Destinations interface.

2. Click Import.

The Import Destination Spreadsheet opens.

3. Click Choose File.

4. Navigate to the file you wish to import.

5. Click Apply.

The Import Destination Spreadsheet dialog closes and the Destinations interface updates to 
report the new mapping.

Updating the Destination Labels
The Destinations interface allows the definition of names (or labels) for your routing system 
outputs. When a database is initialized using the Database Builder, the default label of Dest# is 
automatically filled into the quantity specified by the database. These destination labels may be 
edited to suit your naming conventions.

 Take care to limit the amount of characters as these labels are also used on soft panels and 
Remote Control Panels (RCPs) which have a small display area.

For More Information on...
• assigning multiple destination labels, refer to “To map destinations using the Fill I/O tool”.

To edit a single destination label

1. From the Destinations interface, select the row for the destination to update.

2. Click Rename.

The Rename dialog opens.

3. Use the Name (prefix) field to specify the virtual label.

 Unicode characters are not supported.

4. Verify the text in the New names preview field.

5. Click Rename destination(s).

6. Click Close.

The Rename dialog closes.

Applying an Alias Set
An alias set enables you to customize virtual labels and apply to the sources and/or destinations if 
required. This re-naming is not necessary for router operation, but it may make your assignment of 
source and destination labels easier to identify when using your internal cable naming conventions. 
Refer to “Using an Alias Set” to learn more about creating virtual labels.
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To apply an alias set to the destination labels

1. In the Destinations interface, locate the @ menu.

In the following example, the menu is set to None.

2. From the @ menu, select the virtual labels to apply.

The destinations are automatically updated to the new labels.

Configuring the Destination Follow Feature
The Destination Follow feature enables you to route a specific destination’s source signal to another 
destination. For example, set Dest1 to follow Dest6 so when Dest6 is switched to a different 
source, Dest1 is also switched to that same source. You can set multiple destinations to follow 
another single destination, or each following their own unique destination.

Controlling a destination that has a follow directly will overwrite the current status. Any subsequent 
changes to the followed destination will again update that destination. For example, if Dest1 
follows Dest6 and a a controller requests a new source to Dest1, that source is routed to Dest1. 
If a controller then requests a new source to Dest6, Dest1 will then also change status to the new 
source.

 Destinations defined as UltriScape Heads or PiPs are configured via the UltriScape interface. 
Refer to the UltriScape User Guide for details.

To configure the Destination Follow feature

1. Double-click the Destination Follow node located under the Database node.

The Destination Follow interface opens.

2. In the Destinations table, locate the row for the destination to configure.

3. In the Following table to specify the output that the selected Destination will follow.

 To delete a DestFollow, use the Following menu to select the required DestFollow and click 
Clear.
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Mapping the Sources
This chapter outlines how to use a database to assign inputs, as well as define levels and matrices. 
Procedures in this chapter assume that you have DashBoard launched and the primary Ultrix or 
Ultricore displays in the Tree View.

Before You Begin
Table 71 outlines the available inputs for mapping to the sources in your database. 

For More Information on...
• defining a database, refer to “Creating a New Database”. 
• the ULTRIX-MODX-IO blade and its modules, refer to the ULTRIX-MODX-IO User Guide.

Adding Sources to the Database
Using the Database Builder feature enables you to quickly define the sources for a database. But 
you can still add sources to an active database as required using the Add function in the Database > 
Sources interface.

The Sources interface is organized into a table with each row representing a Source and each 
column representing a Level. The table cells are the output ports assigned to the Sources for that 
level. Initially, the source label “Src #” is assigned to the physical output sockets. The labels can be 
edited as described in “Updating the Source Labels”.

 A database supports a maximum of 4096 sources.

Table 71  Mapping Inputs to Database Sources

Default Slot Label

Physical 
or 

Virtual 
Port?

Description

Slotx.in[y].sdi.ch1 P Digital video input slot x port y 

flex.in[y].sdi.ch1 P Digital video input Flex slot port y in an ULTRIX-FR5

Slotx.MODX-in[y].sdi.ch1 P Digital video input slot x port y of an Ultrix-MODX-IO blade

Slotx.in[y].audio.chn P Digital audio channel n of input slot x port y 

flex.in[y].audio.chn P Digital audio channel n of Flex slot input port y in an ULTRIX-FR5

Slotx.MODX-in[y].audio.chn P Digital audio channel n of Ultrix-MODX-IO slot x input port y

Slot0.disconnect[1].sdi.ch1 V A ‘no signal/disconnected’ video source 

Slot0.disconnect[1].audio.ch1 V A ‘no signal/disconnected’ audio source 

Slot0.passthrough[1].audio.ch1 V Audio on this channel will follow video regardless of audio matrix 

Slot0.layout:name[n].mv.ch1 V Ultriscape Head layout file name id n – route a layout to a head 
to change Ultriscape layouts 

Slot0.mixer-out[y].audio.ch1 V Audio source for mixer output port y

Slot0.mixerd-out[y].audio.ch1 V Audio source for mixer channel strip direct output port y

Slot0.virt-in[y].sdi.ch1 V Acuity AUX BUS Input port y
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To add sources to the active database

1. Double-click the Sources node located under the Database node.

The Sources interface opens with the table auto-populated as defined by the active database.

2. Select a row in the Sources table. 

This specifies where in the Sources hierarchy to add the new entries.

3. Click  Add.

The Add Sources dialog opens.

4. Use the Name (prefix) field to specify the label for the new source(s).

5. Use the Start count field to specify the first source in the new series.

6. Use the Count field to specify the last source in the new series.

7. Verify the value reported in the Sources to add field is correct.

8. Click Apply.

Mapping an Input to a Source
The Sources interface allows the mapping of physical and virtual input ports to your routing system 
inputs. This interface is organized into a table with each row representing a Source and each 
column representing a Level. At the top of the column is the name of the Level. The table cells are 
the input ports assigned to the source for that level.
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To map an input to a source

1. Locate the source to map in the Sources table.

2. If desired, type a new name for the source in the Name cell as outlined in “To specify a label 
for a source”.

3. Select the row for the source to map.

 Use the auto-fill feature to quickly edit a source, by locating the cell in the Sources table, type the 
text and click the cell to display a pull-down menu of matching sources to choose from.

4. Click Edit.

The Edit dialog opens.

In the following example, the user is editing the source labeled IN_73.

5. From the Slots area, select the blade to map.

The Ports area auto-populates with the inputs available in the active database.

6. From the Ports area, select the input to assign to the source.

The Channels area auto-populates with the video and audio channels available in the active 
database.

7. From the Channels area, select a row for each level to map.

In the following example, the user will map audio.ch1 to IN_73.
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8. Click Fill sources.

The Sources table updates with the selected source mapped.

9. Click Edit to close the dialog.

To map a selection of sources

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available inputs. The assignment 
operation will take the top most of the available inputs selection and assign it to the left most of 
the horizontal selection and so on through the selection range.

1. In the Sources table, select the first row in the series you want to define for the level.

2. Press and hold Shift.

3. Click Edit.

The Edit dialog opens. 

In the following example, the user is mapping three sources (IN_73, IN_72, and IN_73) in the 
VID level.

4. From the Slots area, select the blade to map.
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The Ports area auto-populates with the inputs available in the active database.

5. From the Ports area, select the input to assign to the sources.

The Channels area auto-populates with the video and audio channels available in the active 
database. 

6. From the Channels area, select the channel(s) to map to the selected sources.

In the following example, the user is mapping one video channel (sd.ch1), and two audio 
channels (audio.ch1, and audio.ch2) to each selected source.

7. Click Fill Sources.

The Sources table updates with the selected sources mapped.

8. Click Edit to close the dialog.

To map a series of inputs to multiple sources on the same level

1. In the table of the Sources interface, select the first row in the series you want to define for the 
level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Click Edit.

5. Repeat steps 4 to 7 in the above procedure.

6. Click Edit to close the dialog.

To delete a source from the database

1. In the Sources table, select the source(s) to delete.

2. Click Delete.

 You can delete the mapping assignment(s) but keep the source entry in the database by selecting 
the source row and clicking Clear.

Using the Fill I/O Tool
The Fill I/O tool enables you to manage the mapping templates, and edit the port assignments for 
any number of sources. 
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When the Fill I/O button is selected from the toolbar, the Fill I/O dialog opens in a drawer in the left 
pane of the Sources interface. This enables you to access the Fill I/O options and still view the 
sources available in the active database. Clicking the Fill I/O button again closes the dialog.

To map sources using the Fill I/O tool

1. Click Fill I/Os.

The Fill I/O button is now lit blue and the Fill I/O dialog opens.

2. If the database includes more than one device, use the Devices options to select which device 
to use for the input signals.

3. Use the Slots options to select the router slot that will provide the inputs.

 Virtual ports (refer to Table 71) are available via slot0.

4. Use the Ports options to select the input port(s).

 If required, use the Filter field to display only the entries that match the specified text. For 
example, entering in[2 will only display the IN 2 port of the selected slot(s).

5. Click Fill sources.

The Fill I/O dialog closes.

Using the Templates
Templates can be used to quickly map the sources in the active database. Each template provides a 
unique configuration. Access the Template options by clicking Fill I/Os > Templates. Selecting a 
template automatically maps the sources in the active database.
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Figure 32  Example of the Sources > Templates Dialog

Applying a System Template
The Database Manager provides a selection of default (system) templates to choose from. Each 
template maps the sources in a pre-defined pattern. The available templates are displayed as a list 
in the Fill I/O > Templates dialog.

The Fill I/O > Templates dialog also reports the name of the template currently applied to your 
sources. Note that the SDI template is applied by default, but you can choose a different template 
or none based on your requirements.

To apply a default template to map the sources

1. Click Fill I/Os > Templates.

The Templates dialog opens with a list of available templates.

In the example below, the SDI template is applied as reported in the read-only field beside the 
Templates button.

2. To apply a template, select it from the list.

3. If you selected the Audio mixer template:

a. Use the Output type menu to specify the audio outputs to map: audio outputs from the 
ULTRIMIX-MXR or the physical OUT ports. Refer to the Ultrix User Guide for details on the 
ULTRIMIX-MXR licensed feature.

b. Use the Start at level menu to specify the first database level for the source mapping.

c. Use the Channels per source menu to specify the number of audio channels to map. If you 
selected Custom, enter the number of channels in the provided field.

d. Select the Repeat mapping box to copy these settings to all the audio levels/sources.

e. Click Apply.

4. If you selected the SDI+MADI template:

a. Use the Start at level menu to specify the first database level for the source mapping.

b. Use the Channels per source menu to specify the signal or data type for the sources in this 
level.

c. Select the Repeat mapping box to apply these settings to subsequent sources.

d. Select the Include SDI box to map the SDI video signals to the specified levels and sources.
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e. Click Apply.

5. If you selected the Single level template:

a. Use the Level menu to specify the database level to map.

b. Use the Channel Type menu to specify the signal or data type for the sources in this level.

c. Click Apply.

6. If you selected the Acuity template:

a. Use the Acuity number field to assign an ID number to this router to identify it to the 
upstream Acuity switcher. The default is 1.

b. Click Apply.

7. Verify that the Templates read-only field now reports the name of the selected template.

Creating a New Template
You can choose to create a new blank template or copy an existing a template and saving it with a 
new name.

To create a new template to map the sources

1. Click Fill I/Os > Templates.

The Templates dialog opens.

2. Select New template.

The Channels Map Template dialog opens.

The dialog is organized into a table with the database levels for the columns and each row 
representing a specific source.

3. Use the Template Name field to assign a unique identifier for the template.

4. Select the box for each source/level the template will map.

5. Click Save. This button is located in the bottom right corner of the Channel map template 
dialog.
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To copy an existing template

1. Click Fill I/Os > Templates.

The Templates dialog opens.

2. Locate the template you wish to copy.

3. Select  beside the template name.

The Channel map template dialog opens. Notice that the Template name field reports the name 
of the selected template with (Duplicate) added.

4. Use the Template Name field to assign a unique identifier for the template.

5. Select the box for each destination/level the template will map.

6. Click Save. This button is located in the bottom right corner of the Channel map template 
dialog.

Exporting and Importing the Source Mapping
The Sources interface provides the option to create a backup copy of the current sources map (as 
an *.xlsx file), edit its contents if required, and then import the updated map into the database. Or, 
if you wish to change the source map to another desired scheme, import the required spreadsheet 
file (*.xlsx) to the active database.

This section outlines how to export and import spreadsheets that determine the source mapping 
for the active database.

Exporting a Source Map
The Sources interface provides the option to export the current source mapping as an *.xlsx file 
that is stored on your DashBoard client computer. This enables you to create a backup copy of the 
map, edit its contents if required, and then import the updated map into the database. 

To export the current source map to a spreadsheet

1. Double-click the Sources node located under the Database node.

The Sources interface opens.

2. Verify the current map is the one you wish to capture.
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3. Click Export.

The Export Source Spreadsheet dialog opens.

4. Use the Save as field to assign a unique filename to the source map.

5. Click Apply.

The Downloads dialog opens in the DashBoard window and reports when the file is saved as an 
*.xlsx file in the Downloads folder of your DashBoard client computer.

Importing a Source Map
A source map can be defined in a spreadsheet (*.xlsx) that is organized like the table on the 
Destinations interface. You can create a new spreadsheet or edit a spreadsheet that captured an 
existing destination map. Much like the Sources interface, each row in the spreadsheet represents a 
specific port in the routing system.

In Figure 33, the user created a spreadsheet for 20 sources (SRC 1-20), and four levels (VID, AUD 1, 
AUD 2, AUD 3).

Figure 33  Example of a Source Map Spreadsheet

 Unicode characters are not supported.

To define a new source map using a spreadsheet

1. Create a new spreadsheet in Microsoft® Excel® or other application that supports *.xlsx files.

2. Label the sheet as sources.

3. Label the first column as UIID.

4. Label the second column as Name.

5. Label the next column as Description.

6. If tallies are enabled for the database, label the next column as Tally.

7. Label each subsequent column as a Level in your database.

8. In the UIID column, enter the ID number for the source starting with zero (0).

9. In the Name column, enter the database label (text) for the source. 

For example, enter SRC 1 for the first entry.

10. If tallies are enabled for the database, use the Tally column to specify the Tally ID for the 
source.

11. In the Level column, enter the source as: Frame.slot.port.type.channel.



Ultrix and Ultricore Database Guide (v1-rev6) Mapping the Sources • 131

12. Repeat steps 8 and 11 for each source (row).

 Any blank cells in the spreadsheet will be mapped as blank entries in the Sources interface.

13. Save the spreadsheet to the Downloads folder on your DashBoard client computer.

To import a source map

When you import a source map, it is automatically applied to the database. 

1. Double-click the Sources node located under the Database node.

The Sources interface opens.

2. Click Import.

The Import Source Spreadsheet opens.

3. Click Choose File.

4. Navigate to the file you wish to import.

5. Click Apply.

The Import Source Spreadsheet dialog closes and the Sources interface updates to report the 
new mapping.

Updating the Source Labels
The Sources interface allows the definition of labels for your routing system inputs. When a 
database is initialized, default labels of Src # are automatically filled in to the quantity specified by 
the database. These source labels may be changed to suit your naming conventions.

For More Information on...
• assigning Tally IDs to sources, refer to the Ultrix User Guide for your router.
• assigning multiple source labels, refer to “To map sources using the Fill I/O tool”.

To specify a label for a source

1. Double-click the Sources node located under the Database node.

The Sources interface opens.

2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each source you want to specify a virtual label for.
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Mapping the I/O for ULTRIMIX-MXR
The ULTRIMIX-MXR licensed feature is a virtual audio mixer that can be configured up to 128×64. 
This chapter outlines how to map the destinations and sources for ULTRIMIX-MXR. 

For More Information on...
• the ULTRIMIX-MXR licensed feature, refer to the Ultrix User Guide for your router.

Before You Begin
Before you can map the destinations and sources, you must first:

• Install an ULTRIMIX-MXR license(s) for each audio mixer partition you require. You can install up 
to 4 licenses in a single router. Refer to the Ultrix User Guide for your router.

• Specify the audio mixer I/O partitions. Refer to the Ultrix User Guide for your router.

Overview
When enabled, the ULTRIMIX-MXR feature can access every input in the system, and its outputs can 
be routed to any output in the router, providing tremendous flexibility for audio work-flows. Each 
input has a 4-band parametric equalizer, noise gate and compressor/limiter. In addition, 
ULTRIMIX-MXR has 128 direct outputs for simple audio processing as part of its standard feature 
set. It is controllable via a DashBoard user interface as well as application-specific panels for both 
the Ultritouch-2 and Ultritouch-4 control panels.

Figure 34  Block Diagram of Mapping Audio Mixer I/O to Router Destinations and Sources

An Audio Mixer template is provided in the Destination and Source interfaces to help quickly map 
the audio mixer I/O. The Audio Mixer template enables you to specify:

• one or more partitions to create destinations/sources based on the I/O available in those 
selected partition(s).

• the starting audio level for the I/O mapping for each destinations/sources.
• how many audio levels for each destinations/sources.
• a prefix for each destinations/sources and a starting number (if there are more than one 

destination).
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When mapping your audio mixer I/O:

• Mixer Inputs (channel strips) are mapped to Router Destinations 
• Mixer Outputs (output strips) are mapped to Router Sources 

Mapping the Router Destinations to the Audio Mixer Inputs
The Audio Mixer template prevents a user from mapping I/Os from two different mixers into one 
logical matrix since each source/destination can have I/O mappings from only one mixer partition.

By default, the Audio Mixer template assigns consecutive mixer inputs across the table starting at 
the defined Starting Level and continuing each level column for the channels per Destination 
quantity. Note the chosen Channels per destination setting will impact the total number of logical 
labels created. For example, when creating mixer input logical label for a 64×32 mixer, a setting of 
Quad will result in 32 logical destinations (mixer inputs) created or 32 destinations × 4 levels (Quad) 
with 128 mixer inputs (64 stereos channel strips).

When mapping stereo pairs, each channel strip in the soft panel Home View represents a stereo 
pair with the first strip automatically assigned to the first pair of the selected partition. For 
example, slot0.mixer-in[1] and slot.mixer-in[2] is mapped to Channel strip 1, and slot0.mixer-in[3] 
and slot.mixer-in[4] is mapped to channel strip 2 etc. This is also true for the mixer outputs. 

To map the destinations to the audio mixer

1. Double-click the Destinations node located under the Database node.

The Destinations interface opens with the table auto-populated as defined by the Database 
Builder settings.

2. Select an entry point in the Destinations tab from where the new audio mixer assignments will 
begin. 

3. Click Fill I/Os > Templates.

The Templates dialog opens with a list of available templates.

4. Select Audio mixer.

5. Use the Input type menu to specify to what audio inputs to map: audio inputs from the 
ULTRIMIX-MXR or the physical IN ports. Refer to the Ultrix User Guide for details on the 
ULTRIMIX-MXR licensed feature.

6. Use the Start at level menu to specify the first database level for the destination mapping.

7. Use the Channels per destination menu to specify the number of audio channels to map. If 
you selected Custom, enter the number of channels in the provided field.

8. Select the Repeat mapping box to copy these settings to all the audio levels/destinations.

9. Click Apply.

Mapping the Router Sources to the Audio Mixer Outputs
When mapping sources, ensure to use the same mixer partition(s) that was selected in “To map 

the destinations to the audio mixer”.

To map the inputs for an audio matrix

1. Double-click the Sources node located under the Database node.

The Sources interface opens with the table auto-populated as defined by the Database Builder 
settings.
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2. Select an entry point in the Sources tab from where the new audio mixer assignments will 
begin. 

3. Click Fill I/Os > Templates.

The Templates dialog opens with a list of available templates.

4. Select Audio mixer.

5. Use the Output type menu to specify the audio outputs to map: audio outputs from the 
ULTRIMIX-MXR or the physical OUT ports. Refer to the Ultrix User Guide for details on the 
ULTRIMIX-MXR licensed feature.

6. Use the Start at level menu to specify the first database level for the source mapping.

7. Use the Channels per source menu to specify the number of audio channels to map. If you 
selected Custom, enter the number of channels in the provided field.

8. Select the Repeat mapping box to copy these settings to all the audio levels/sources.

9. Click Apply.
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Tallies
This chapter provides instructions on how to enable TSL UMD messages in the active database, 
assign Tally IDs to your sources and destinations, and how to manage tally objects in your 
Ultriscape heads.

For More Information on...
• the supported TSL UMD protocols, refer to “Server Options and Supported Commands”.
• Ultriscape PiP Tally setup and operation, refer to the Ultriscape User Guide.
• Ultricore-Tally, refer to the Ultricore BCS User Guide.

Overview
The Ultrix router accepts TSL UMD tally messages, and passes tally status notifications to 
configured Ultriscape Heads. Tally messages associated with a router source may also be passed to 
the routed destination tally status. Tally information may be associated with either routing system 
sources or destinations.

Tally IDs
A Tally ID may be associated with routing system destinations using the options in the Database > 
Destinations interface. Three modes of operation are available:

• Normal — The database name of the connected source is placed in the Display Data field of the 
destination Tally ID message (an outgoing connection is required; TSL v3.1 only). When the Tally 
ID is associated with an Ultriscape PiP (slotn.headx-pip[y] or slot0.pip[y]), any assertion on this 
Tally ID will directly control the PiP tally visual elements and override any Tally associated with the 
PiP video source.

• Redirect — The destination Tally ID follows the connected source Tally ID. For example, when a 
source is switched to a destination on the selected Tally Level, the Ultrix forwards the tally status 
of the source that is active on the destination, but the outbound TSL message has its display ID 
re-mapped to the display ID that is associated with the destination. An outgoing connection is 
required.

• Routed — The connected source Tally ID follows the destination Tally ID. Any configured 
Ultriscape PiPs showing this source will use destination Tally ID status to assert Tally Indicators or 
Tally Borders.

 Ensure the destination Tally IDs do not conflict with Tally IDs asserted by other devices.

Tally ID Format
Table 72 summarizes the format that the TSL protocol defines Display IDs that are associated with 
the tally displays. 

Table 72  TSL Protocol — Tally ID Format

TSL Protocol 
Version Tally ID Format Range

3.1 <displayID> 0 - 127

4.0 <displayID> 0 - 127

5.0 <screenID>:<displayID> 0 - 65535 : 0 - 65535
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Keep the following in mind when using tally display IDs:

• TSL UMD protocols v3.1 and v4.0 messages will always map to screen 0.
• When using TSL UMD v5.0, the screen ID is assumed to be 0 if no screen ID is entered.
• If the controller is configured for either v3.1 or v4.0 protocol, it is not necessary to enter a screen 

ID.
• If the controller is configured for v5.0, it is only necessary to specify the screen ID if the tally 

controller is configured to send messages to tally displays on ‘screens’ other than the one with 
the screen ID of 0.

Router Tally Output Operation
Ultrix and Ultricore will track current Tally Status messages sent by a controller via Tally Display IDs 
associated with router sources. When a source (with a Tally ID) is routed to a destination (with a 
Tally ID), the router will emit Tally Status messages that reflect the current tally status of the Tally ID 
associated with the source, but that target the Display ID associated with the destination.

 An outgoing connection point must be defined for Ultrix and Ultricore to send the new status out.

Example

Consider the following source and destination configurations:

For the above configuration settings, the following states are possible:

Router Status over TSL UMD v3.1 Operation
Ultrix and Ultricore can use the TSL UMD protocol version 3.1 to send the connected source 
database name as tally text. This requires you to:

1. Set up an outgoing TSL v3.1 connection.

2. Assign Tally ID numbers to the destinations you wish to track.

3. Ensure the Tally mode is set to None.

When a configured destination changes, the name of the new source will be sent as tally text. Ultrix 
will resend all the configured destinations every 1 minute, and immediately for any source change 
on a configured destination.

Table 73  Example of Sources and Destinations Assigned to Tally IDs

Name Tally ID Tally Status
Sources

Src 1 5 T1:on

Src 2 10 T1:off

Destinations

Dest 1 33 T1:xxx

Table 74  Example of Sources and Destinations Assigned to Tally IDs

Router Status Tally Status
Src 1 > Dest 1 TallyID 33 T1 = TallyID 5 T1 (on)

TallyID 33 Display Data = Src 1

Src 2 > Dest 1 TallyID 33 T1 = TallyID 10 T1 (off)
TallyID 33 Display Data = Src 2
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Getting Started
Before configuring tallies, you must first perform the following in the active database:

1. If RS-232 or RS-422 communication is required, add a serial connection point for TSL protocol 
support.

2. If Router Tally Output operation is required, add either a serial or ethernet outgoing connection. 

3. Enable Tally ID support.

4. Assign the Tally IDs to the sources.

5. Assign the Tally IDs to the destinations.

6. Set the Tally mode to None.

Communication Setup
This section summarizes how to add a connection point for TSL protocols.

Adding a Serial Connection Point
Connections may be created via the Edit > Add menu on the Connections tab and selecting the TSL 
protocol from the Protocol menu in the Add Connection dialog.

For More Information on...
• a serial connection point to third-party devices, refer to “Defining a Serial Connection”.

Adding an Ethernet Connection Point
An Ethernet connection point must be added for outgoing TSL protocol support only. Incoming 
Ethernet services are natively available.

For More Information on...
• ethernet connection point to third-party devices, refer to “Connection via Ethernet”.

Enabling Tally ID Support in the Active Database
To enable tally ID configuration in an active database, you must select the Enable Tally box on the 
Database Manager interface, and then define the Status Level for tally operation.

Once support is enabled, the Destinations and Sources interfaces display a Tally column. Use this 
column to assign Tally IDs to destinations and/or sources in the active database.

To enable tally ID support in the active database

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Database Manager sub-node.

The Database Manager interface opens.

3. Verify that the active database is the one you wish to enable Tally ID support for.

4. Select the Enable tally box located on the Database Configuration tab.

• The Levels tab displays the Tally level menu.
• The Source and Destinations tabs automatically update to display the Tally column. 
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Defining the Status Level for Tally Operation
The Tally Status Level specifies which level in the routing system is used to determine the current 
source switched to a given logical destination. Generally this should be the main SDI Video level; 
which in most systems is the level to which the Ultriscape Head PiP and/or Router Video 
destinations are mapped in the system database.

To define the status level for tally operation

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Use the Tally level menu (located at the top of the Levels interface) to specify the Level in the 
active database that will determine the tally status. 

Assigning the Tally IDs to the Destinations
Assigning a Tally ID to a standard database destination (e.g. not a PiP, audio mixer destination, etc.), 
enables currently routed source tally data to be output on a defined destination Tally ID, essentially 
routing the tally information along with the video. Refer to Figure 35 for examples.

 An outgoing connection point (either ethernet server or RS232/422 port) is required for the 
router to emit tally information.

For More Information on...
• PiP tally operation, refer to the Ultriscape User Guide.
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 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Destinations tab. Refer to 
Table 72 for details.

To assign a Tally ID to a destination in the database

1. Double-click the Destinations node located under the Database node.

The Destinations interface opens.

2. Verify that the Tally column displays in the Destinations interface. 

 If the Tally column does not display, refer to “Enabling Tally ID Support in the Active 
Database”.

3. Select the cell in the Tally column of the Destinations interface to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that destination.

5. Press Enter to apply the change.

6. Select the cell in the Tally Mode column. Choose from the following:

• Normal — the database name of the connected source is placed in the Display Data field of 
the destination Tally ID message (an outgoing connection is required; TSL v3.1 only).

• Redirect — the connected source Tally ID is directed to this destination Tally ID.
• Routed — the connected source Tally ID follows this destination Tally ID.

7. Repeat steps 3 to 6 for each destination you wish to assign a Tally ID.

Tally ID 51 follows the connected 
source associated tally. This requires an 
established outgoing connection point. 
(TSL UMD v3.1 and v4.0 TallyID format). 

Tally Screen 4, ID 11 follows the 
connected source associate tally. This 
requires an established outgoing 
connection point. (TSL UMD v5.0 TallyID 
format). 

The label of the source currently 
connected to DST 1 will be sent as TSL 
text on Tally ID 5. (TSL UMD v3.1 only). 

When Tally ID 8 is asserted, any PiPs 
showing the same source as routed to 
DST 1 also have their tally asserted (if 
defined on the PiP). For example, if DST 
1 has source CAM 1 routed to it, and 
one or more Ultriscape PiPs also had 
source CAM 1 displayed, the PiP would 
display tally data from Tally ID 8. 

Figure 35  Example of Destinations with Assigned Tally IDs
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Assigning the Tally IDs to the Sources
Tally IDs associated with routing system sources may serve two purposes:

• Trigger any Ultriscape Multiviewer to display tally status (this requires that the router has at least 
one Ultriscape Head enabled and configured). Refer to the Ultriscape User Guide for details.

• Enable the tally status to be mapped to other Tally IDs based on router crosspoint status (the 
destination must have a Tally ID associated and Tally Re-direct enabled).

Assigning a Tally ID to a database source enables configured Ultriscape displays to show tally 
information.

For example, if an Ultriscape Head contains a PiP configured to display tally information, and a 
source with an assigned Tally ID is routed to that PiP, that PiP will reflect the incoming messages 
received by the router via the TSL protocol.

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Sources tab. Refer to Table 72 for 
details.

To assign a Tally ID to a logical source in the database

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Verify that the Tally column displays in the Sources tab. 

 If the Tally column is not displayed, refer to “Enabling Tally ID Support in the Active 
Database”.

3. Select the cell in the Tally column of the Sources tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that source.

5. Press Enter to apply the change.

6. Repeat steps 3 to 5 for each source you wish to assign a Tally ID.

Example of Tally Routed Mode
Consider an Ultrix router feeding signals to a Ross Carbonite switcher; the switcher can assert tally 
messages based on which signals are contributing to those outputs, but the switcher has no 
knowledge of how Ultrix and Ultricore has routed its inputs to the outputs. 

TallyID 41 is associated with Src 1 in 
the Ultrix and Ultricore database. (TSL 
UMD v3.1 and v4.0)

Tally Screen 5, ID 41 is associated with 
Src 1 in the Ultrix and Ultricore 
database. (TSL UMD v5.0)

Figure 36  Example of a Sources with Assigned Tally IDs
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The Tally Routed mode associates a tally with a specific Ultrix and Ultricore destination. Ultrix and 
Ultricore knows which input is routed to that output, and so can assert tally indicators wherever the 
input signal is displayed in an Ultriscape PiP.

In Figure 37, Tally ID 3 is associated with Ultrix and Ultricore destination 11. When the switcher 
asserts Tally ID 3 (based on its own configuration rules), Ultrix and Ultricore looks up the input 
connected to destination 11 (source 19 - Cam 1). Ultriscape will then assert the same tally data as 
received wherever source 19 - Cam 1 is displayed. Cam 2 has a different tally asserted because Cam 
2 (source 20) is routed to destination 12 which is associated with Tally ID 4. 

Figure 37  Example of Tally Routed Mode

Application
Use a routed tally to associate the tally state for a particular router source to ultimately reach the 
on-air path of the Carbonite switcher. For example:

1. The Carbonite generates a tally (e.g. program or preview) with an assigned Carbonite Tally ID. 

2. The Ultrix and Ultricore looks up which router source is currently connected to the router 
destination associated with that Carbonite Tally ID. 

3. The Ultrix and Ultricore then determines if that source is currently displayed on any Ultriscape 
PiPs, and if so, asserts the appropriate Ultriscape PiP tally.

In this example, the Tally Routed mode would enable the PIP tally to accurately reflect the tally state 
when a different source is routed to a Carbonite switcher input.

Carbonite Requirements
You will need to configure the Carbonite to communicate with the Ultrix and Ultricore router UMD 
service using specific TSL UMD ethernet protocol settings. 
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To set up tally communications between Carbonite and the Ultrix and Ultricore UMD

1. On the Carbonite panel menu system, press MENU > SYSTEM > NEXT > NEXT > Device Config.

2. Press Add.

3. Use the Slot knob to select an ethernet connection (Slot #).

4. Use the Type knob to select SerialTally.

5. Press NEXT.

6. Use the SubType knob to select TSLUMD_1.0.

7. Press NEXT.

8. Enter the IP address of your Ultrix and Ultricore:

a. Use the Field knob to select the segment of the IP address you want to edit.

b. Use the Value knob to enter the IP address of your Ultrix.

9. Press NEXT.

10. Use the Option and Value knobs to complete the setup as outlined in the following table. 

11. Press the Option knob and Confirm to add the Ultrix and Ultricore as a new device.

Ultrix and Ultricore Requirements
For each Ultrix and Ultricore destination that is connected to a Carbonite switcher input:

• Set the switcher's primary input number in the Tally column of the Destinations table in the 
router database.

• Set the Tally mode to Routed.
• Set an ID number in the Tally column and set the Tally mode to Normal for any Ultriscape PIP 

destination that is expected to show UMD tally for sources that are also routed to a switcher 
source. 
This can be any ID as long as it is not used by your destinations that feed your Carbonite inputs. 
To make it simple, on our example below we start at 201, this would be a recommended value 
that should not conflict with anything else.

Option Value
Port Set to 5727 if you are using the default value that Ultrix and Ultricore requires for 

TSL V3.1 over TCP/IP communication.
Set to 4490 for UDP communication.

Transport Select TCP if the Port is set to 5727.
Select UDP if the Port is set to 4490.
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Using an Alias Set
This chapter outlines how to create an alias set of virtual labels and how to apply an alias set to your 
sources and destination matrices.

For More Information on...
• alias sets and soft panels, refer to “Applying an Alias Set to a Soft Panel”.

Overview
 By default, a matrix (or router) port is identified via the Frame.Slot.Port.Type.Channel 
nomenclature. An alias set enables you to customize virtual labels and apply to the ports if 
required. For example, you may wish to create an alias set that reflects the actual name/label text 
that the physical cable would be assigned. 

 This re-naming is not necessary for router operation, but it may make your assignment of source 
and destination labels easier to identify when using your internal cable naming conventions. 

Creating an Alias Set for Sources or Destinations
An alias set can include labels for sources, and/or destinations. You can choose to rename all labels, 
specific labels, a mix of labels, or whatever suits your requirements. By default, there are no 
pre-defined alias sets in an active database.

For More Information on...
• creating alias sets for audio channels, refer to “Creating a Channel Alias Set”.

Creating a New Alias Set
Take care when determining label text. While a long name may be descriptive for the Source and 
Destination interfaces, many control devices have limited screen space and labels may be 
truncated.

 Unicode characters are not supported.

To create a new alias set

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Aliases node located under the Database node.

The Alias interface opens.

 The Alias interface is blank when no alias sets are defined yet.
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3. Click  Add.

The Add dialog opens.

4. Use the Name field to assign a unique identifier to the alias set.

This name is displayed in the Alias set menu of other interfaces.

5. If required, enter additional information in the Description field.

6. Click Apply.

The Add dialog closes and the Alias page updates to include the new entry.

The Sources, and Destinations tabs now display a list of available matrices in the active 
database. Each tab indicates the port that is included in the active database using the default 
nomenclature Frame.Slot.Port.Type.Channel.

To define the source aliases

1. Select the alias set you wish to define.

2. Select the Sources tab.

3. To define a single source label, select the row for the specific port label to edit.

4. To define multiple source labels:

a. Select the first row.

b. Press and hold Shift 

c. Select the last row.

5. To define all source labels, click Select All.

6. Click Rename.

The Rename dialog opens.

7. Use the Name (prefix) field to type a label prefix. 

 Enter a trailing space to ensure a space between the prefix and the numerical counter.

8. Use the Start count field to select 

9. Use the New Names Preview field to verify the new label text.

In the following example, the user is renaming sources SRC 1 to SRC 6 using the text CAMERA.
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10. Click Apply.

The Rename dialog closes and the Alias column updates to display the new virtual labels for this 
alias set.

To define the destination aliases

1. Select the Destinations tab.

2. To define a single destination label, select the row for the port label to edit.

3. To define multiple destination labels:
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a. Select the first row.

b. Press and hold Shift 

c. Select the last row.

4. To define all destination labels, click Select All.

5. Click Rename.

The Rename dialog opens.

6. Use the Name (prefix) field to type a label prefix. 

 Enter a trailing space to ensure a space between the prefix and the numerical counter.

7. Use the Start count field to 

8. Use the New names preview field to verify the new label text.

9. Click Apply.

The Rename dialog closes and the Alias column updates to display the new virtual labels for this 
alias set.

To define the alias set for an external device matrix

1. Configure the device as outlined in “Enabling a Communication Service” and “Configuring 
the Service Settings”.

2. From the Alias table, select the row for the alias set you wish to apply to the external device 
matrix.

3. Select the Services tab.

4. Click Apply selected.

The Service alias set field updates to report the selected alias set, the number of services the 
set was applied to. The Clear button is now enabled in the toolbar.

Creating an Alias Set Template
Once an alias set is created, you can choose to use it as a template. This template can be edited as 
required without impacting the original version (set). 
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To create an alias set template

1. From the Alias table, select the row for the alias set you wish to copy.

2. Click Duplicate.

A new entry displays in the Alias Set table with the original alias set name and “(copy)” in the 
Name column.

3. Double-click the cell in the Name column.

4. Type a unique identifier for the template.

5. Press Enter.

The template entry now displays the new name.

6. Edit the virtual labels in the Sources, and Destination tabs as required.

Creating a Channel Alias Set
An alias set defines the virtual labels for audio channels. You can choose to rename all labels, 
specific labels, a mix of labels, or whatever suits your requirements. By default, there are no 
channel alias sets in an active database.

 Take care when determining label text. While a long name may be descriptive, many control 
devices have limited screen space and labels may be truncated.

To define a new channel alias

1. Display the Databases > Configuration node as outlined in “Accessing the Database 
Interfaces”.

2. Double-click the Channel Aliases node.

The Channel Alias interface opens.

3. To define a single channel label, select the row for the channel.

4. To define a series of channel labels:

a. Select the first row.

b. Press and hold Shift 

c. Select the last row.
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5. To define all channel labels, click Select All.

6. Click Rename.

The Rename dialog opens.

7. Use the Name (prefix) field to type a label prefix. 

 Enter a trailing space to ensure a space between the prefix and the numerical counter.

8. Use the Start count field to select the first channel of the selected port.

9. Use the New names review field to verify the new label text.

10. Click Apply.

The Rename dialog closes and the Alias column of the Channels tab updates to display the new 
virtual labels for this alias set.

Applying an Alias Set
Once an alias set is defined, it becomes available for use in the active database. 

To apply an alias set

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Perform one of the following:

• Double-click the Destinations node located under the Database node; or
• Double-click the Sources node located under the Database node.

3. Locate the Alias set menu in the top toolbar of the interface.

4. Select the alias set to apply.

5. Verify the new labels displayed in the Name column of the tab.

Exporting an Alias Set
You can create a copy of the Source or Destination aliases using the Export function in each tab. The 
aliases are saved to a Microsoft Excel spreadsheet (*.XLSX file) on your DashBoard client computer. 
This enables you to create a backup of your aliases or a template which can be edited as required 
and then imported back into the Alias interface. 

 This section is applicable to sources, destinations, and channel aliases.

To export an alias set to a spreadsheet

1. If you wish to export the sources or destinations aliases:

a. Display the Aliases interface.

b. Select the alias set you wish to export.

c. Select the Sources or Destinations tab.

2. If you wish to export an audio channel alias, display the Channel Alias interface.

3. Click Export.

The Export Alias Spreadsheet dialog opens.
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4. Use the Spreadsheet name field to assign a unique filename to the alias set.

5. Click Apply.

The alias set is saved to a spreadsheet in the Downloads folder of your DashBoard client 
computer.

Importing an Alias Set
Define an alias set by creating a Microsoft Excel spreadsheet or editing a spreadsheet that captured 
an existing alias set. When you import an alias set, it is added to the database and is selectable via 
the Alias set menus. 

 This section is applicable to sources, destinations, and channel aliases.

To define a new alias set using a spreadsheet

1. Create a new and blank spreadsheet in Microsoft Excel.

2. Label the sheet as Alias Data.

3. Label the first column as Name.

4. Label the second column as Alias.

5. In the Name column, enter the database labels (text) that will be replaced with the Alias label.

6. In the Alias column, enter the new virtual label.

7. Repeat steps 5 and 6 for each label.

8. Save the spreadsheet to the Downloads folder on your DashBoard client computer.

To edit an alias set

1. Export the alias set you wish to edit. Refer to “To export an alias set to a spreadsheet”.

2. Open the spreadsheet file you exported in step 1.

3. Edit the cell contents for the alias labels as required.
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4. Save your changes to the spreadsheet.

To import an alias set

1. If you wish to import a sources or destinations alias set:

a. Display the Aliases interface.

b. Select the Sources or Destinations tab.

2. If you wish to import an audio channel alias set, display the Channel Alias interface.

3. Click Import.

The Import Alias Spreadsheet opens.

4. Click Choose File.

5. Navigate to the file you wish to import.

6. Click Apply.

The Import Alias Spreadsheet dialog closes and the new alias set displays.
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Tielines
This chapter outlines how to define a distributed routing system using the Tieline Builder feature of 
the Ultricore BCS. 

 Ensure the ULTRICORE-TLX license is enabled on the Ultricore BCS.

What are Tielines?
A tieline is a method of connecting two routers together so that they may share sources and 
destinations. How many inputs and outputs that can be shared depends on how many tielines have 
been provisioned, if the tielines are in use, or if a user has permissions to use them. 

 Tielines do not have to be bi-directional as represented in Figure 38 and Figure 39.

Figure 38 represents a two-way tieline connection between routers where one (or more) outputs of 
Ultrix 1 are connected to the inputs of Ultrix 2, and one (or more) outputs of Ultrix 2 are connected 
to the inputs of Ultrix 1. 

Figure 38  Example of a Distributed Routing System Work Flow with Tielines

Figure 39 illustrates a work flow where Ultrix 2 needs a source that is only present on Ultrix 1. The 
Ultricore BCS routes the requested source to a destination that is configured as a tieline, and on 
Ultrix 2, it will route the tieline source to the user selected Destination. 

Figure 39  Example of Tielines in a Work Flow
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In Figure 39 the following occurred:

1. An RCP-QE36 panel, with access rights, made a request for a source on Ultrix 1 to be connected 
to a destination on Ultrix 2.

2. The Ultricore BCS determined the ‘path’ knowing it has to use a tieline.

3. The Ultricore BCS had a free tieline and enabled:

a. The Ultrix 1 requested source to switch to the tieline.

b. The Ultrix 2 tieline input to switch to the requested destination.

Setup Work Flow
Figure 40 summarizes the steps required to set up and configure tielines for the Ultricore BCS.

Figure 40  Required Steps for Tieline Setup
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2. If bi-directional tieline management is required, connect the signal cable(s) from the output(s) of 
Ultrix 2 to the input(s) of Ultrix 1.

3. Take note of the physical address of the connectors used for the tieline signal cables as this 
information will be required when configuring the tielines in DashBoard.

Add the Routers to Ultricore BCS Control
This section assumes that each router is configured in DashBoard.

 Two or more physical routers are required for tieline setup. Tielines within the same router are 
not supported.

1. Display the Product Info interface in DashBoard for the router as follows:

a. Locate the Ultrix node in the Tree View.

b. Expand the Ultrix node to display a list of sub-nodes.

c. Expand the Ultrix sub-node.

d. Double-click the Product Info sub-node.

2. Select the Setup tab.

3. Ensure each router has a unique Device Name assigned to it. This makes it easy to identify the 
router in the database. 

To assign a name to a router:
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a. Locate the Device Identification area. 

b. Use the Device Name field to assign a unique identifier to the router.

4. Set the Ultrix router to Remote Controller mode as follows:

a. Locate the DashBoard Interface area.

b. Select the Remote Controller Mode box.

5. Repeat steps 1 to 4 for each router.

6. Reboot each router by clicking the Reboot button on its Product Info interface.

7. Create a connection point between the Ultricore BCS and each router as outlined in 
“Connecting to an Ultrix Router”.

To add a router to the database

1. Display the Database nodes on the Ultricore BCS as outlined in “To access the Database 
interfaces”.

2. Double-click the Routing Devices sub-node.

3. Select the row for the router.

4. Select the Communications tab in the Routing Devices page.

5. Specify the type of connection as follows:

a. Set the Protocol to Ultrix.

b. Set Type to tcp.

c. Set Count to 1 (for one Ultrix connection).

6. If required, enter a unique identifier for the new connection in the Device Name field.

7. In the Address field, type the IP Address for the Ultrix you want to connect to.

8. Set the Port to 15000.

9. In the Control area, set the Device Status to enabled.

10. Repeat this procedure for every router you wish to include in the database.

Create a Database for the Ultricore BCS
Tieline definition starts with the database. Tielines may only be configured to work with outputs of a 
router that are not defined as regular destinations. To enable a physical output to be used as a 
tieline, any reference to that physical port must be removed from the Destination table of the 
database. This deletion of an output from the list of logical destinations serves to prevent a 
mis-configured system from directly controlling a tieline by directly routing to it.

 An output port must be either a regular destination or a tieline. It cannot be both. 

To create a database to utilize the resources presented by the connected routers

1. Create a database for the Ultricore BCS as outlined in “Creating a New Database”.

2. Edit the database to identify tieline sources, destinations, and free sources as outlined below.

To delete a logical destination definition

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

3. Locate the Destination row that includes the physical port name of the output port to be used 
as a tieline. 
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 By default, Ultrix uses the nomenclature of framename.slotnumber.out[socket].type to 
reference a physical output socket. 

4. Select any cell within the row.

5. Click Delete.

6. Repeat this for each output that is to be used for a tieline.

 Any audio channels associated with the main SDI output socket reference must be removed from 
the destination table also.

Define a Free Source for each Router
Tieline control requires the definition of a router input as a “parked” or “free source” on each router 
within the tieline enabled system. This free source supplies a dedicated source for destinations that 
were previously fed via a tieline, but the tieline has now been freed or was re-assigned. This section 
outlines how to define a local parked source on a router.

 Each router within the tieline system requires a Free Source definition. If a Free Source is not 
defined, a destination will remain connected to the tieline, even after being released. 

To define a free source on a router

1. Make note of a physical IN port on the Ultrix router that provides a known and valid signal.

This would typically be a test signal, station logo or similar. Ultrix routers also have the ability to 
define a 'disconnected' source. This signal is used when the tieline is “parked” or not in use.

2. Navigate the database source definition page and edit (or create if not already defined) the 
source name as required.

3. Assign a name to this new source following the convention of FreeSource-<RouterName> 
where <RouterName> is the name of the Ultrix router. For example, if the router name is 
Ultrix23, then the Free Source label will be FreeSource-Ultrix23.

4. Ensure to assign and add the physical router port from step 1 to this new source in the Ultrix 
database.

Using the Ultricore BCS Tieline Builder
Once you have defined the connection points and database for your routing system, you can define 
the routers and available I/O ports for use in tielines. For each tieline you must define where the 
tieline starts (by selecting an output from a device) and where it will end (by selecting an input from 
another device).

The Ultricore BCS provides two interfaces for creating and managing tielines:

• Tieline Builder — creates tielines based on the routers and ports available to the Ultricore BCS 
within the current database and routing system.

• Tieline Runtime — reports the sources and destinations for each defined tieline, enables the 
user to manage and monitor the switch requests using the defined tielines.

To define a tieline on the Ultricore BCS

1. Display the Database nodes on the Ultricore BCS as outlined in “Accessing the Database 
Interfaces”.

2. Double-click the Tieline Builder sub-node.

The Tieline Builder interface opens in the DashBoard window.

3. Click  Add.

The Add dialog opens.
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4. To define the start point for a tieline:

a. Locate the From Device table in the interface.

b. Use the From Device menu to specify the router that will provide the start point for the 
Ultricore BCS tieline. In Figure 39, this would be Ultrix 1.

The Output Ports area updates to display a list of available output ports on the selected 
router.

 The From Device Output ports that display Used for <dst name> cannot be used for tieline 
start points.

5. From the Output Ports area, select the port that will be the Ultricore BCS tieline start point. 

 The port was noted during the “Physical Setup”.

6. To define the end point for a tieline:

a. Locate the To Device table in the interface.

b. Use the To Device menu to specify the router that will be the end point for the Ultricore BCS 
tieline. In Figure 39, this would be Ultrix 2.

The Input Ports area updates to display a list of available input ports on the selected router.

7. From the Input Ports area, select the port that will be the endpoint for the Ultricore BCS tieline. 
This is the physical input where the tieline cable was connected during “Physical Setup”.

8. Click Add Tieline.

The Existing Tielines table updates to include the new tieline.

A created tieline automatically takes the default name Tie x where x is a numerical identifier. 

 A tieline can be renamed. Highlight the tie line row to be renamed, and click Rename.

9. Repeat steps 4 to 8 for each tieline that the Ultricore BCS will manage in your routing system.
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Using the Tieline Runtime
Once your tielines are defined, you will need to verify the routing system sources and destinations 
that the Ultricore BCS will use to determine the best path for the tieline between its start and end 
points. 

Viewing the Tieline Details
The Tieline Runtime interface enables you to view the sources and destinations available for each 
existing tieline, 

To view the tieline details

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Tieline Runtime sub-node.

The Tieline Runtime interface opens in the DashBoard window.

3. In the Existing Tielines table, select the row for the tieline you wish to verify.

4. Click View Tieline Details.
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Parking a Tieline using a Free Source
When a tieline resource is no longer required, it should be parked or released. This ensures 
subsequent uses of the tieline do not inadvertently route a new signal to the previous tie-line 
destination selection. 

An entire tieline route may be released (Release Tieline function) or specific destinations using that 
tieline may be released (Release Destination function).

To park an entire tieline

 This will park all destinations currently using the selected tieline.

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Tieline Runtime sub-node.

The Tieline Runtime interface opens in the DashBoard window.

3. Select the tieline to park from the Existing Tielines table.

4. Click Release Tielines.

To park a specific destination

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Double-click the Tieline Runtime sub-node.

The Tieline Runtime interface opens in the DashBoard window.

3. Select the destination path from destinations using Tielines table.

4. Click Release Destinations.
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Using Cat/Index Mode
Category Index mode (or Cat/Index mode) enables you to organize the resources (sources, 
destinations, and/or levels) in a routing database to defined categories. This allows you to piece 
together or build up the final resource name from category names and index identifiers. Once you 
have defined your categories, you can create a custom soft panel using the category settings to 
arrange the sources, destinations, and levels.

This chapter outlines how to organize your resources using the Cat/Index Mode feature.

 The procedures in this chapter assume that the Cat/Index Categories interface displays in the 
DashBoard window. Refer to “Accessing the Database Interfaces” for details.

For More Information on...
• the Group Categories feature, refer to “Using Group Categories”.
• creating a custom soft panel using the category settings, refer to “Soft Panels in DashBoard”.

Cat/Index Categories Overview
Cat/Index mode allows alpha-numeric extensions to labels to “build up” the final label selection. For 
example, CAM 1 - 6 may be expressed as a CAM label with numerical extensions 1 through 6. 
Similarly, alpha extensions may be used, for example, CAM A - E for Cameras A through E.

Destination and source names are split into substrings - the first substring is referred to as the 
category, and subsequent substrings as the indexes (e.g. Category CAM index 1 through 6). As 
source/destination names become more complex, an index may not be the final part of the 
selection name. For example, consider the source names CG TX 1 and CG TX 2; Cat/Index category 
mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be 
extrapolated to cover a large range of sources and destinations.

Example of a Cat/Index Category Setup
The following resources are available: 

The possible categories and indexes would be: 

Sources / Destination Names

Categories Indexes

CAM_a

a. The “_” characters represents a blank space. This indicates the category will filter resources 
with a space in the name (e.g. the CAM_ category will allow resources named CAM 1, CAM 2 but 
not CAM3).

1 5 D

SAT_ 2 A E

CG_ 3 B RX_

EDIT_ 4 C TX_

VTR
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Once the Cat/Index categories are defined, the user can perform switches, on a hard or soft panel, 
based on the categories. 

In Figure 41, a RCP-QE18 is used to select the source labeled as CAM 3. Note only the sources are 
available for the second button selection. In this example, the user would need to select TAKE to 
make the switch.

Figure 41  RCP-QE18 — Selecting HD 3 via Category Mode

In Figure 42, a soft panel is used to select the destination labeled as SAT B2.

Figure 42  Ultrix — Selecting SAT B2 via a Soft Panel

Configuring a Cat/Index Category Setup
Configuring Cat/Index categories requires:

1. Creating the categories.

2. Creating the index filters.

3. Assigning the resources.

Creating the Categories
You can assign each resource to a specific category or multiple categories in a database. Using 
multiple categories enable you to filter the resources, and organize them into logical groups. By 
default, categories are organized in alphabetical order. There are two methods for creating 
categories: auto-generate and manual.
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Using the Auto-Generate Tool
 All previous categories will be deleted from the Category table and new ones are created based 

on the resource labels in your database.

To auto generate categories based on a database

1. Click Generate on the Cat/Index Categories interface.

The Auto-Generate dialog opens.

2. Click Apply.

The Auto-Generate dialog closes. The Category and Index tables are now populated based on 
the database labels.

Manually Create a New Category
You can choose to create a new category that is not based on the resource labels in your database. 
This is helpful when you want to customize the labels for the control panel with specific resources.

To manually create a new category

1. Select a row in the Category table.

2. Click  Add on the Cat/Index Categories interface.

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

The entry must match a resource name prefix. For example:

• “CAM_” creates a category to categorize resources named CAM_xx where xx is any index.
• “CAM” creates a category to categorize resources named CAMxx where xx is any index.
• “cam” will not categorize any resources as the category names are case sensitive.

4. Click Apply.

The Add Category dialog closes and the new category displays at the bottom of the Category 
table.

In the following example, the user created a new category “CAM_”.
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Deleting a Category
You can choose to delete a category by selecting it from the list and clicking Delete. This will remove 
the row from the Category table and clear the resources. The resources will now display in their 
respective tabs, making them available to assign to the remaining categories.

To delete a category from the database

1. Select a row in the Category table.

2. Click Delete on the Cat/Index Categories interface.

The Delete Category dialog opens.

3. Click Apply.

The Delete Category dialog closes and the selected category and assigned resources no longer 
display in the Category table. 

Creating the Index Filters
An index for a category enables you to filter the resources. As category names and indexes are 
entered, the bottom half of the Category table updates to indicate which resources of a given 
category is accessible on a control panel.

 Unicode characters are not supported.

Auto-Generated Index Filters
There are two methods of auto-generating index filters:

• Using the Auto Generate tool — this feature creates categories and index filters based on the 
resource labels of the database. Refer to “Using the Auto-Generate Tool” for details.

• Using the Default Index tool — click this button to replace the only the entries in the Index table 
with filters based on the resource labels of the database.

Manually Assign an Index Filter
You can create an index filter that is not based on the resource labels of the database. This allows 
you to customize the filters used when creating a soft panel, or when using a control panel. 

To assign an index filter

1. Select a row in the Index table. 

2. Click  Add on the Cat/Index Categories interface.

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 
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The entry must match a partial resource name. For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This 
will filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose 
one or the other.

4. Click Apply.

The Add Index dialog closes and the new index filter is listed in the Index table.

In the following example, the user created index “CH9”.

Managing the Resources
The Cat/Index Categories interface organizes the lists of resources based on what is currently 
assigned to a category/index, and what resources are still available (unassigned). This information is 
also reported in the bottom toolbar of the Cat/Index Categories interface.

Assigned Resources
The lower half of the Cat/Index Categories interface displays the Levels, Sources, and Destinations 
currently assigned to a selected category. 

Select a row in the Category table to display the assigned resources for that specific category. In 
Figure 43, the user is reviewing the resources for the CG_ category.

Figure 43  Example of Assigned Resources for a Category
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Click a Show button to display the resources in the table and highlights each category and index the 
resources are assigned to. In Figure 44, the user selected Show Sources.

Figure 44  Example of Sources in Categories

Available Resources
The right panel of the Cat/Index Categories interface displays a tab for each available resource type 
in the database. Select a tab to view a list of those resources that are not assigned. If a tab is blank, 
all the resources of that type are currently assigned to a category.

In Figure 45, the user is reviewing the list of available Destinations.

Figure 45  Example of Available Resources

To create a new category based on the resources

1. From the right panel, select the tab for the resource type you wish to assign.

 If the tab is blank, all the resources of that type are assigned.

2. To manually add a new category:

a. Select a resource.

b. Click  Add.

The Add Category/Index dialog displays with the Category auto-populated based on the 
selected resource.
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c. Edit the fields as required.

d. Click Apply.

3. To auto-generate a new category, click Generate from the resource tab toolbar.

• The Category table displays the a new row for the generated category.
• The selected resource tab is now blank.
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Using Group Categories
Group Categories allow the user to organize database resources (sources, destinations, and levels) 
into folders and sub-folders with arbitrary group names. The group name is not required to match 
the resource names (it is similar to setting up file folders). This group categorization is useful when 
you need to group resources based on their operational regions, events, personnel credentials etc. 
Once you have defined your categories and tags for each level of a database, you can create a 
custom soft panel using the category settings to arrange the sources, destinations, and levels.

This chapter outlines how to organize the database resources into folders and sub-folders using the 
Group Categories feature. This is done in preparation for creating your custom soft panels using the 
category settings.

 The procedures in this chapter assume that the Global Categories interface displays in the 
DashBoard window. Refer to “Accessing the Database Interfaces” for details.

For More Information on...
• Cat/Index categories, refer to “Using Cat/Index Mode”.
• creating a custom soft panel using the category settings, refer to “Soft Panels in DashBoard”.

Example of a Group Category Setup
A user wants to arrange sources and destinations based on the types of sports the network 
broadcasts: baseball and football. The resources available are: 

The resources need to be arranged into the following groups based on the sport type: 

Sources Destinations

Baseball Football
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Figure 46 shows these resources as organized in the Group Category interface.

Figure 46  Example of Group Categories Arrangement Based on Sport Type

Once the group categories are defined, you can perform switches, on a hard or soft panel, based on 
the group categories. 

In Figure 47, an RCP-QE18 is used to select the source labeled as HD 3.

Figure 47  RCP-QE18 — Selecting HD 3 via Category Mode
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In Figure 48, an Ultrix soft panel is used to select the source labeled as HD 2.

Figure 48  Ultrix — Selecting HD 2 via a Soft Panel

Configuring Group Categories
Group categories are arranged in a hierarchy and displayed in a tree view. Each group is 
represented as a folder or node, and the resources included in that group are sub-nodes. Figure 49 
shows two main groups (Baseball and Football) where the Football group also has three sub-groups 
(Local, National, and State).

Figure 49  Example of GroupCategories Tree View

Configuring group categories requires:

1. Creating groups

2. Assigning the resources (destinations, sources, and/or levels) to groups

Auto Generating the Groups
You can choose to create the groups based on the levels, sources, and destinations in your 
database or a combination. This requires the virtual labels for each resource to be consistent. For 
example, if all destinations are labeled as DST #, a group will be created called DST with each 
destination (resource) listed as a separate node.

 Auto generating a group will delete the groups currently listed in the GroupCategories tree.
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To auto generate a group

1. Click Generate on the Group Categories interface.

The Generate Groups dialog opens.

2. Select the box to include the resources in the group.

3. Click Apply.

The Generate Groups dialog closes and the GroupCategories interface displays the new 
groups. In the following example, two groups were auto-generated: DST and SRC.

Manually Adding a New Group
You can add a new group or sub-group using the methods described below. 

To manually add a new category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories interface opens.

2. Select the GroupCategories node.

3. Click  Add.

The Add Group Category dialog opens.
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4. In the Name field, type a unique identifier for the new group.

 Unicode characters are not supported.

5. Click Apply.

The Add Group dialog closes and the new group Hockey displays in the GroupCategories tree.

To create a category sub-group

1. Expand the GroupCategories node.

2. Select the node to add the new sub-group to.

3. Click  Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new sub-group.

 Unicode characters are not supported.

5. Click Apply.

The Add Group dialog closes and the new sub-group is added to the GroupCategories tree 
view.

In the example below, a new sub-group Studio 1 was created in the Baseball group.

Assigning Resources to a Group
You can assign resources (destinations, sources, levels) once a group is created. Resources may be 
assigned to multiple groups if required.

 Auto generating the groups will also assign all available resources for that group. For example, if 
you selected to generate a group of Sources, the sources in the active database are automatically 
assigned to that group.
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To assign a resource to a group

1. In the GroupCategories tree, select the group you want to add a resource to.

2. In the right pane, select the tab for the type of resource you wish to assign to the group.

3. To assign a single resource, select the resource from the tab.

4. To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click  Add.

The GroupCategories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.

To move a resource to another group

1. In the GroupCategories tree, select the resource you want to move.

2. Click Move.

The Move Group Category dialog opens.

3. Select the new location for the resource.

In the example below, DST 3 will move from the Baseball group to the Hockey group.
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4. Click Apply.

The Move Group Category dialog closes.

The GroupCategories tree updates to display the resource in the new location. Notice that the 
resource is now removed from the original group.

To delete a resource from a group

1. In the GroupCategories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.

3. Click Apply.

The Delete dialog closes.

The GroupCategories tree updates to no longer display the resource in the group. 

To delete a series of resources from a group

1. In the GroupCategories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.
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2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.

4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Apply.

The Delete dialog closes.

The GroupCategories tree updates to no longer display the resources in the group. 

To move a group within the tree view

1. In the GroupCategories tree, select the group you want to move.

2. Click Move. 

The Move Group Category dialog opens.

3. Use the tree view in the dialog to select where to move the group to.

4. Click Apply.

The Move Group Category dialog closes.

The GroupCategories tree updates to display the group in the new location.

Renaming a Group
 You cannot rename resources using the options in the Group Categories interface.

To rename a group

1. In the GroupCategories tree, select the specific group you want to rename.

2. Click Rename.

The Rename Group Category dialog opens.

3. Use the Name field to enter a unique identifier for the selected group.

 Unicode characters are not supported.

4. Click Apply.

The Rename Group Category dialog closes.

The GroupCategories tree updates to display the new name for the group. 

Deleting a Group
Deleting a group does not delete the resources from the database.

To delete a group

1. In the GroupCategories tree, select the group you want to delete.

2. Click Delete.

The Delete Group Category dialog opens.

3. Click Apply.

The Delete Group Category dialog closes.

The GroupCategories tree updates to no longer display the group. 
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Using Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for crosspoint transitions. Procedures in this chapter assume that you have DashBoard 
launched and the primary device displayed in the Tree View.

Creating Salvos
The Salvos interface enables you to create, delete, re-name, and manage your salvos in an interface 
that is off-line. The Salvo interface layout arranges the crosspoints in a grid layout with sources in 
columns and the destinations in rows. The available levels are displayed in a toolbar to the right of 
the grid.

To create a salvo

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Create a new salvo in the database as follows:
a. Click  Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Add salvo.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected. Notice 
that the salvo is flagged as empty.

3. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

4. To create a single crosspoint switch, use the cross-hairs to select the source/destination 
combination on the grid.

 A yellow warning icon displays when a salvo is empty (does not include any crosspoint switches).
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5. To assign multiple destinations to the same source.

a. Click the button(s) in the Destination toolbar for each destination to include in the switch; or 
click Select all dest to include all the available Destinations.

b. Click the button in the Source toolbar for the source to use for the switch.

The grid updates to indicate the new selections. Notice that each level is represented by a 
corresponding slice of the crosspoint indicator. In the following example, there are five 
crosspoint switches selected that will affect four levels.

6. Click Follow to enable the levels to automatically follow the switches.

 Click Deselect all dest to cancel the destination selections or click Clear presets to clear the 
workspace.

Saving the Current Crosspoint Status as a New Salvo
The Capture status option enables you to copy the current state of the crosspoint selections and 
save them as a new salvo.

 It is recommended to first verify the current destination crosspoint states using one of the soft 
panels in your database. Refer to “Soft Panels in DashBoard”.
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To create a salvo based on the current status of all destinations

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Select Capture status > Capture system status.

The Capture System dialog opens.

3. Type a unique identifier in the New name field for the new salvo.

4. Click Apply.

• The Capture System dialog closes.
• The Salvos list updates with the new salvo selected.
• The matrix in the Salvos interface updates to reflect the current crosspoint state.

To create a salvo based on destination status

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Select Capture status > Capture destination status.

The Capture Destination dialog opens.

3. Use the New name field to type a unique identifier for this salvo.

4. Click Apply.

The matrix in the Salvos interface updates to reflect the current destination states.
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5. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

6. Select the source(s) to use in the crosspoint switch.

To create a salvo based on the current port status

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Select Capture status > Capture port status.

The Capture Port Status dialog opens.

3. Use the New name field to type a unique identifier for this salvo.

4. Use the Port type menu to specify the outputs to capture for the salvo. Choose from the 
following:

• Output — captures the status of all physical OUT ports in the database.
• MV Head PiP — captures the status of each Multiviewer Head PiP.
• MV System PiP — captures the status of the Multiviewer Head PiPs.
• MY Head — captures the status of each output port assigned to a Multiviewer Head.

5. Click Apply.

The matrix in the Salvos interface updates to reflect the current port states.

Viewing a Salvo
The default view of the Salvo interface shows a workspace in a grid pattern with sources at the top 
and the destinations along the left side. (Figure 50)
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Figure 50  Example of the Salvo_2 Workspace

You can also choose to view a selected salvo in a table format by clicking the View button on the top 
toolbar. (Figure 51) From this interface, you can still use the Find and Filter tools to navigate to 
specific sources/destinations. But editing is not available in this table view.

Figure 51  Example of the Salvo_2 View Interface (View button is selected)

Copying a Salvo
You can create a copy of a saved salvo and edit its settings or add crosspoint selections separately 
from the original salvo. This also enables you to create a template.

To copy a salvo

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Select the salvo to copy from the Salvos list.

3. Click Duplicate.

4. Use the New name field to type a unique identifier for the new salvo.

5. Click Apply.
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A new salvo displays at the bottom of the Salvos list. 

6. Edit the settings of the new salvo as outlined in the procedure “To edit a salvo”.

Using the Find & Filter Tool
The Salvos interface provides the Find & Filter tool to help you to quickly search and filter the 
sources and destinations on the workspace. This is useful when working in a large database with 
hundreds of sources and destinations. The Find & Filter tool provides two functions:

• Find — locates sources and/or destinations containing specific text.
• Filter — shows only the sources and/or destinations that you want on the workspace.

To find specific sources

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. From the Salvos interface, click Find & Filter.

The Find & Filter dialog opens.

3. In the Sources > Find String field, enter the text you wish to search.

For example, CAM.

4. Select the Exact Match box to search only for the text as entered in step 3. 

For example, a search for CAM would result in finding sources labeled as CAM and not CAMERA.

5. Select the Match Case box to search only for the text as entered in step 3.

For example, a search for CAM would result in finding sources labeled as CAM and not cam.

6. Use the <Find prev and Find next> options to scroll through the Sources row in the workspace 
to next label that matches your search criteria.

To find specific destinations

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. From the Salvos interface, click Find & Filter.
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The Find & Filter dialog opens.

3. Scroll to the Destinations options in the Find area.

4. In the Destinations > Find String field, enter the text you wish to search.

For example, OUT 2.

5. Select the Exact Match box to search only for the text as entered in step 4. 

For example, a search for OUT 2 would result in finding destinations labeled as OUT 2 and not 
OUTPUT 2, or OUT 22.

6. Select the Match Case box to search only for the text as entered in step 4.

For example, a search for OUT 2 would result in finding destinations labeled as OUT 2 and not 
out 2.

7. Use the <Find prev and Find next> options to scroll through the Destinations column in the 
workspace to next label that matches your search criteria.

To filter the workspace

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. From the Salvos interface, click Find & Filter.

The Find & Filter dialog opens.

3. Locate the Filter area.

4. To filter the source entries on the workspace:

a. In the Sources field, enter the filter criteria. For example, typing IN 2 filters the Sources row 
to display only IN 2, IN 20, IN 21, IN 22, IN 23, etc. 

b. Press Enter.

5. To filter the destination entries on the workspace:

a. In the Destinations field, enter the filter criteria. For example, typing STUDIO filters the 
Destinations column to display only STUDIO, STUDIO1, STUDIO2, STUDIO 1, STUDIO 2 etc.

b. Press Enter.
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Editing a Salvo
Once a salvo is created in the database, you can edit its crosspoint selections as required.

To edit a salvo

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections currently saved for the salvo.

3. Perform steps 3 to 5 as outlined in the procedure “To create a salvo”.

Deleting a Salvo
Deleting a salvo removes it from the database. The corresponding button on any soft panels for the 
deleted salvo are also no longer displayed.

To delete a salvo from the database

1. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

2. From the Salvos list, select the salvo to delete.

3. Click Delete.

The Delete salvos dialog opens.

4. Click Apply.

• The salvo no longer displays in the Salvos list to the left of the workspace. 
• If the salvo was assigned to a button on a soft panel, the button is automatically deleted from 

the panel.

Recalling a Salvo
Once you have created a salvo, you can recall it for use on a soft panel in DashBoard.

 You cannot recall salvos from a Category soft panel.

 If the soft panel has its Take operation set to Direct, the Take button does not display and the 
switch occurs automatically.

For More Information on...
• adding salvos to soft panels, refer to “Creating a Soft Panel”.

To recall a salvo from a Matrix panel

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Expand the Soft Panels node.

3. Double-click the node for a Matrix Panel.

The Matrix Panel interface opens.

4. Click Salvo > Recall. 

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is 
currently in use (ON) or not (OFF).
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5. Select the salvo to recall.

6. Click Take to recall the salvo.

The Execute Salvo dialog closes and the crosspoint switch is made.

To recall a salvo from a MultiBus panel

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Expand the Soft Panels node.

3. Double-click a MultiBus Panel node.

The MultiBus Panel interface opens. 

The salvo buttons are located at the bottom of the soft panel interface. If a salvo button is lit 
green, the current router status matches the salvo presets. 

4. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

5. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.
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To recall a salvo from a Cat/Index Category panel

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Expand the Soft Panels node.

3. Double-click a Cat/Index Category Panel node.

The Cat/Index Category Panel interface opens. 

4. Click Salvo. 

The Execute Salvo dialog opens. The Active column reports whether the salvo is currently in 
use (ON) or not (OFF).

5. Select the salvo to recall.

6. Click Take to recall the salvo.

The Execute Salvo dialog closes and the crosspoint switch is made.

To recall a salvo from a Group Category panel

1. Display the Database nodes as outlined in “Accessing the Database Interfaces”.

2. Expand the Soft Panels node.

3. Double-click a Group Category Panel node.

The Group Category Panel interface opens. 

4. Click Salvo. 

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is 
currently in use (ON) or not (OFF).
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5. Select the salvo you wish to recall.

6. Click Take to apply the salvo.

The Execute Salvo dialog closes. The crosspoint switch is made. 
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Soft Panels in DashBoard
A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel 
configurations are part of a database so any instance of DashBoard connecting to the primary 
device has the defined soft panels available. You can customize a soft panel by defining the sources, 
destinations, levels, and/or salvos that will be available on the panel interface. 

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database resources (sources, destinations, levels, salvos, 
aliases, and port assignment) to be complete.

• If the database changes, you will need to verify each soft panel configuration to ensure the 
correct resources are still visible.

• Ultrix and Ultricore do not support Unicode characters.
• Procedures in this chapter assume that you have DashBoard launched and the primary device 

displayed in the Tree View.

Soft Panels Overview
A soft panel is created using the options in the Panels interface for the database. Once created, the 
soft panel is listed as a sub-node in the Database > Control > Panels tree. The hierarchy of the 
nodes in the tree is determined by their Panel ID which is assigned when the soft panel is created in 
the database. Double-click a sub-node to display the corresponding soft panel in the DashBoard 
window. In Figure 52 there are six soft panels in the tree view.

Figure 52  Example of Soft Panel Nodes

A soft panel can be as simple or complex in its layout as you require. You select a panel type, assign 
a unique name, and configure the settings of the soft panel (such as adding a Lock and/or Protect 
button, the maximum number of resources to display, etc.). Then you specify which destinations, 
sources, levels, and salvos to display on your panel. 

Enabling Machine Control for Legacy Devices
Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there 
is both a transmit (input to output) and reciprocal receive connection that is made for each port. For 
example, a switch from port 1 to port 2 involves a forward path (from port 1 input to port 2 output) 
and the reciprocal connection from (port 2 input to port 1 output).

In some cases however, there is a need to connect on the port’s input to several ports’ output (e.g. 
one device commanding many target devices) without making the reciprocal connection. This 
allows the commanding device to just broadcast commands and not receive from the many devices 
it communicates with. 
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When configuring a soft panel, you have the option to add a Machine Control button to the panel. 
When selected on the panel, this Machine Control button sends a Take request directed to an NK-M 
series data router to automatically make the reciprocal port switch. On a video router, the 
connection is all one way from an input port to an output port (e.g. such as from IN 1 to OUT 2). 

Creating a Soft Panel
When you create a new soft panel, you select from the existing soft panel types which determines 
the options to add to the panel. You then assign a Panel Name and ID to display in the tree view 
using the nomenclature “Name [#]” where [#]is the Panel ID.

To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

 The interface is blank when there are no configured soft panels.

2. Click  Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. 

This will be used to identify the panel in the Control > Panels tree.

4. If required, use the Description field to provide a textual summary of the panel.

5. Use the ID field to determine the position of the panel in the Control > Panels tree where a 
value of 1 is the highest priority and listed as the first node. Refer to Figure 52.

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

6. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — organizes the destinations and sources in a grid layout. 
• MultiBus — organizes the destinations and sources into separate rows (buses) of buttons.
• Group Category — the hierarchy of the destinations and sources are determined by the 

values in the Group Categories interface. Refer to “Using Group Categories” for details.
• Push Button — organizes the destinations and sources in a distinct vertical layout. Provides 

a similar layout and features of the Ultritouch PB panel but sized for use on a computer 
monitor.

• Cat/Index Category — the hierarchy of the destinations and sources are determined by the 
values in the Cat/Index interface. Refer to “Using Cat/Index Mode” for details.

• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for 
an Ultritouch hard panel. Refer to the Ultritouch User Guide for details.

• Ultritouch MV — enables you to control Multiviewer layouts, switch PiPs, and modify 
follow/non-follow modes directly from an Ultritouch hard panel. This feature is not supported 
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when the router is in a system that is controlled by an Ultricore. Refer to the Ultritouch User 
Guide for details.

• Audio Mixer — provides a familiar interface similar to other audio consoles and allows for 
real-time adjustment of audio levels and audio processing. This soft panel type can only be 
configured on the Ultrix router. Refer to “Using an Audio Mixer Panel”.

• Ultritouch #RU Audio Mixer — an audio mixer panel that is pre-sized for an Ultritouch hard 
panel. This soft panel type can only be configured on the Ultrix router. Refer to “Using an 
Audio Mixer Panel”.

• Ultritouch 4RU Split — a customized layout that is pre-sized for an Ultritouch-4RU. Refer to 
the Ultritouch User Guide.

• Group PB — the destinations and sources are determined by the Group Categories interface 
but organized into a vertical layout that is similar to the Ultritouch PB panel. Refer to “To 
configure a Group PB panel”.

7. Click Apply.

The Add Panel dialog closes.

The new panel name is added to the Saved Panels list of the Panels tab and automatically 
selected in the tab for editing. In the example below, the user created a new Audio Mixer panel 
named “Studio 5” with a Panel ID of 5.

8. Select the Settings tab.

9. Use the Protection operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. Refer to “Using 
Matrix Panels” or “Using MultiBus Panels” for a description of these buttons. 

• Disable — The Lock, Protect, and Free buttons do not display on the soft panel. These 
protection options will not display on the soft panel.

• Enable w/ Override — Use this soft panel to override any locked/protected destination on 
another panel. Refer to “Using an Override” for details.

10. Use the Take operation menu to configure the TAKE button for the soft panel. Choose from 
the following:

• Confirm — Displays a TAKE button on the soft panel. You must select TAKE to perform a 
crosspoint switch.

• Direct — The soft panel does not display a TAKE button. A crosspoint switch occurs 
automatically after each destination/source selection is made by the user via the soft panel.
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11. If this is a MultiBus panel, use the Selection operation menu to enable multiple 
crosspoint/level selections and display the Multi Select button. Choose from the following:

• Single — Disables this feature. The Multi Select button does not display on the soft panel.
• Multi — The Multi Select button displays on the soft panel.

12. Use the Machine control menu to control whether a TAKE request directed to an Ross NK-M 
series data router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select Machine 
Control to enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button.

13. Use the Viewable Data options to specify the maximum number of resources to display on the 
soft panel.

Customizing the Layout
Some soft panel types also provide options for defining the Home and Drawer windows that display 
on the final panel. You can chose to use the default settings, or customize the width and number of 
rows/columns in each window independently.

 This section provides a summary of the layout options and settings. Some options may not be 
available for all panel types.

To customize the layout of a soft panel

1. Select the Settings tab.

2. To re-size the scroll bars on your soft panel:

a. Use the Vertical Scrollbar Width field to determine the size of the bar that enables the user 
to scroll along the vertical axis of the soft panel.

b. Use the Horizontal Scrollbar Height field to determine the size of the bar that enables the 
user to scroll along the horizontal axis of the soft panel. 

3. Use the Icons display menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

4. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — a horizontal layout; the panel is taller than it is wide. (Figure 61)
• Landscape — a vertical layout; the soft panel is wider than it is tall. (Figure 62)

5. Use the Drawer Width menu to specify the width of the drawer handle size.

6. Use the Take button size menu to determine the size of the TAKE button on your soft panel.

7. If you set the Style to Push Button or Group PB, proceed to “Configuring a Push Button Soft 
Panel”.

8. If this is an Audio Mixer or Ultritouch #RU Audio Mixer soft panel, use the Channel Strip Title 
menu to assign a label to the columns of audio channels.

9. If you set the Style to Group Category, use the Nongroup Resources options to determine if 
resources that are not assigned to a specific group are displayed. Choose from the following:

• Hide — The unassigned resources are not displayed on the soft panel.
• Show — All resources are displayed on the soft panel.
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Customizing the Home Window
The order of the rows in the Layout > Home Windows table determine the order of the windows 
that display on the soft panel. For example, if the first row is assigned to Destinations, the first 
window next to the main toolbar of the soft panel will display the Destinations buttons.

To customize the Home Window of a soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab. 

2. Select the Layout tab.

In the following example, the user is configuring an Ultritouch Push Button soft panel.

3. Locate the Home Windows area of the tab.

4. To add a data type to the Home window of the soft panel:

a. Select a row in the Home Windows table.

b. Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the 
table) to move a highlighted row to the desired position.

c. Click  Add.

The Add Window dialog opens.

d. Use the Window menu to specify the first window to include in the soft panel.

 You cannot have multiples of the same window in either Home windows or Drawer windows.

e. Click Apply.

The Add Window dialog closes and the Home Windows table updates to display the 
selection.

5. Repeat step 4 for each data type you want to include on the Home window.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display
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Defining the Drawers on a Soft Panel
Soft panels can also include fly-out menus (drawers) that operate like horizontal drop-down menus. 
You can specify what menus, functions, and settings each drawer includes. The order of the rows in 
the Drawer Windows table determine the order of the windows that display on the soft panel. For 
example, if the first row is assigned to Sources, the first window next to the main toolbar of the soft 
panel will display the Sources buttons.

To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Layout tab.

3. Locate the Drawer Windows area of the tab.

4. Select a row in the Drawer Windows table.

5. Click .

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the window it will be 
assigned to.

For example, if you select Type > Left and Window > Sources, the drawer will display on the 
left side of the Sources window.

7. Use the Window menu to specify the window to assign to the drawer to.

8. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the 
selection.

9. Repeat steps 5 to 8 for each drawer you want to include in the soft panel.

10. To customize a drawer size:

a. Use the Width field to specify the percentage of the allocated drawer space.

b. Use the Rows field to specify the number of rows in the drawer will display.

c. Use the Columns field to specify the total number of columns in the drawer will display.

 You can also use the Drawer Width menu, located near the top of the Home View tab, to specify 
the width of the drawer handle size.

11. Repeat step 10 for each drawer of the soft panel you wish to re-size.

Continue to the next sections to add the required levels, destinations, sources, and salvos to your 
soft panel.
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Levels for the Soft Panel
You can specify the levels and their hierarchy on the soft panel. For example, if you configure the 
Settings > Viewable Data > Levels to 6 but have assigned 8 levels to the panel, the first six levels are 
automatically in the Assigned list. You would then use the options on the Data > Levels tab to select 
the levels and determine their hierarchy on the soft panel.

To specify the levels for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Levels tab.

4. To add a level to the soft panel:

a. From the Available list, select the level you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level.

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.

7. Use the  buttons beside the Assigned list to determine the 
hierarchy in which the levels are displayed on the soft panel.

Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the crosspoint row of the panel. For example, the router may have 64 sources 
but you only want to make 12 selectable on the crosspoint row of your soft panel. You can also 
specify the order in which the sources are displayed on the soft panel.
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To specify the sources for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Sources tab.

4. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the  buttons to determine the order in which the sources are 
displayed on the soft panel.

Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the crosspoint row of the panel. For example, the database may have 32 
destinations but you only want to make the first 4 outputs selectable on the crosspoint row of your 
soft panel. You would then set the Settings > Viewable Data > Destinations field to 4. You can also 
specify the order in which the destinations are displayed on the soft panel.

To specify the destinations for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Destinations tab.
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4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

7. Use the  buttons to determine the hierarchy in which the 
destinations are displayed on the soft panel.

Adding Salvos to a Soft Panel
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for crosspoint transitions. Before you can add salvos to a soft panel, you must configure 
them as outlined in “Creating Salvos”. 

To specify the salvos available on a soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Salvos tab.
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4. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the  buttons to determine the order in which the salvos are 
displayed on the soft panel.

Applying an Alias Set to a Soft Panel
By default, a matrix (or router) port is identified via the Frame.Slot.Port.Type.Channel 
nomenclature. An alias set enables you to customize virtual labels and apply to the ports if 
required. This re-naming is not necessary for router operation, but it may make your assignment of 
source and destination labels easier to identify.

For More Information on...
• configuring an alias set, refer to “Creating an Alias Set for Sources or Destinations”.

To apply an alias set to a soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Alias Sets tab.
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4. To apply a alias set to the soft panel:

a. From the Available list, select the alias set you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected set.

5. To apply all the available sets in the database to the soft panel, click .

6. To apply multiple aliases to the soft panel:

a. From the Available list, select the first set you wish to apply to the soft panel.

b. Press Shift.

c. From the Available list, select the other set(s) you wish to apply to the soft panel.

d. Click .

The Assigned list updates to include the selected sets.

7. Use the  buttons to determine the order in which the sets are 
applied on the soft panel.

Copying a Soft Panel
Once a soft panel is configured, you can copy it and use it as a template for creating additional soft 
panels.

 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Select the soft panel name from the Panels table.

2. Click Duplicate.

The Duplicate dialog opens.

3. Click Duplicate panel.

The Duplicate dialog closes and the Panels interface updates to display the copied panel. 

A copy of a soft panel is automatically named “x(copy)” where x is the name of the original 
panel. In the following example, the user created a new soft panel “Studio 6(copy)”.



200 • Soft Panels in DashBoard Ultrix and Ultricore Database Guide (v1-rev6)

4. Type a unique identifier in the Panel Name field. 

This name is used to identify the panel in the Control > Panels tree (see Figure 52).

Editing a Soft Panel
You can edit any soft panel that is not currently in use.

 You cannot edit the Panel Style of a soft panel.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels interface updates to display the settings for the selected soft panel. The Settings 
tab, in the right pane, is automatically selected.

3. If required, use the  buttons to determine the position of the 
panel in the Panels list. This also determines the priority of the panels in the Control > Panels 
tree (see Figure 52).
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4. Edit a setting for the panel using one of the following procedures:

• “To specify the levels for the soft panel”
• “To specify the destinations for the soft panel”
• “To specify the sources for the soft panel”
• “To specify the salvos available on a soft panel”

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

2. Select the soft panel row from the Panels list.

3. Click Delete.

The Delete dialog opens.

4. Click Apply.

The Delete dialog closes.

The selected panel is removed from the Panels list and the Control > Panels tree.

Displaying a Soft Panel in DashBoard
Once a soft panel is configured in the database, it is listed in the Control > Panels tree and is 
available for use. The procedure to display a soft panel is the same for every panel type.

To display a soft panel in the DashBoard window

1. Expand the main Database node.

2. Expand the Control sub-node.

3. Expand the Panels sub-node.

The Panels tree displays with each sub-node representing an available soft panel.

4. Double-click the node for the soft panel.

The select soft panel interface opens in the DashBoard window.

Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features is determined by the Settings > 
Protection Operation option. To display these buttons, ensure the Protection Operation is set to 
Enable.
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 A MultiBus panel can only display the Lock button. 

Using a Lock
The Lock button provides the option to protect source/level and destination/level pairs. When 
another control panel or DashBoard client attempts to switch that combination, the request will be 
denied.

To lock a source/level pair

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Select the source/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Select the destination/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again. A 
protect alarm message is displayed in the System Status tab when an output is protected.

This feature protects the currently selected destination/level pair from use by other sources, as well 
as from other linked panels. The Protect button is especially useful in instances where a 
destination must be held after a switch has been made.

To apply a protect

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Click Protect.

The button is lit. Selecting crosspoints will not take effect and the panel does not update when 
buttons are pressed.

To clear a protect

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Click Protect.

The button is no longer lit and crosspoint switches can be initiated.



Ultrix and Ultricore Database Guide (v1-rev6) Soft Panels in DashBoard • 203

Using an Override
You can choose to create a soft panel with the ability to free/override a destination previously 
locked/protected by another soft panel. This enables a user to override a locked destination on 
other panels via a single panel (without accessing additional panels), and make it available for 
selection.

Adding the Override Feature to a Soft Panel
A soft panel with the Override feature enabled will display the Override button on its interface. You 
can enable this feature on any soft panel type.

To add an override feature to a soft panel

1. Create the soft panel as outlined in “To create a soft panel”.

2. Select the Settings tab.

3. Set the Protect Operation to Enable w/ Override.

Applying the Override Feature
The Override button displays near the Lock and Protect buttons on a soft panel. When lit red, the 
Override is available for use.

 The RCP-QE18 and RCP-QE36 do not support the Override feature.

To apply an override

1. Display the soft panel you created in the previous section. Refer to “To display a soft panel in 
the DashBoard window”.

2. Select the locked destination(s) you wish to override using this soft panel.

3. Click Override.

The Override button label changes to Lock and the selected destination button(s) no longer 
display the lock icon. 

Using Matrix Panels
Matrix panels enable you to perform direct take transitions, and local salvo definitions using a grid 
of sources and destinations.

Panel Interface Overview
Each level is represented as a button in the color defined in the current database. Notice that the 
crosspoints are represented in the same color as the applicable level. 
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Figure 53  Example of a Matrix Panel

1. Crosspoints

The number of Destinations and Sources and their labels in the matrix are specified using the 
Destinations and Sources interfaces. Click within the matrix or click the Destination and Source 
buttons to select the crosspoints for switching the selected levels. In Figure 53, crosspoints were 
selected using the Advanced > Diagonal Presets option. 

2. Levels Button

Click a level button to include that level in the next crosspoint switch. A lit button indicates that 
the corresponding level will be included in the next transition. The color and name of the button 
are specified using the Levels interface. Figure 53 illustrates a Matrix panel with nine levels 
selected.

3. Follow Button

Click this button to select all levels in the matrix. Clicking TAKE after pressing Follow will then 
switch all crosspoints at the same time on all available levels.

4. TAKE Button

Click this button to execute the switch between crosspoints. If you are using a soft panel with its 
Take operation set to Direct, a TAKE button is not displayed because the transitions will occur 
automatically after a crosspoint switch is selected.

5. Lock Button

Click this button to prevent switching of the selected crosspoints. When creating the soft panel, if 
the Protection operation was set to Disable, the Lock and Protect buttons are not displayed.

6. Protect Button

Click this button to prevent switching of the selected crosspoints except in the DashBoard client 
session the Protect was initiated in.

7. Free Button

Click this button to end a lock or protect on the selected crosspoints.

1) Crosspoints 4) TAKE Button 7) Free Button 10) Find Button

2) Levels Button 5) Lock Button 8) Salvo Button 11) Filter Button

3) Follow Button 6) Protect Button 9) Advanced Button 12) Show Take Errors Button



Ultrix and Ultricore Database Guide (v1-rev6) Soft Panels in DashBoard • 205

8. Salvo Button

Click this button to display the Salvo menu. Refer to “Salvo Menus” for menu options.

9. Advanced Button

Click this button to display the Advanced menu. Refer to “Advanced Menus” for menu options.

Machine Control Button (not shown)

If you are using a soft panel with the Machine control set to Enabled, the MACHINE CONTROL 
button is displayed. 

10.Find Button

Click this button to quickly navigate to known source or destination names.

11.Filter Button

Click this button to reduce the number of source and/or destinations visible in a matrix panel. 
This enable a user to filter a matrix panel view to only source/destinations that match entered 
text.

12.Show Take Errors Button

Click this button to display a summary of the number of failed TAKE transitions.

Status Quick Navigation
In multi-level systems, the status of any given crosspoint can often be such that a matrix style soft 
panel cannot show all levels. 

Figure 54  Example of Crosspoint Status in a Matrix Panel

In Figure 54, destination DST1 only shows status for the green level. It cannot show the red/blue 
levels status' as the relevant sources are outside the current view.

Right clicking the destination button/label will re-center the source buttons to the next level status. 
Subsequent right-clicking the destination button will cycle to the next level status indicator. (Figure 
55)

Figure 55  Example of a Cycled Status Indicator

Find Dialog
The Find dialog helps you to quickly navigate to known source or destination names. (Figure 56)
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Figure 56  Example of the Find Dialog

To access the Find dialog

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. From the matrix panel control area (located in the bottom right corner), click Find.

The Find dialog opens.

3. From the Find in List menu, choose either Source or Destination as required.

4. Type the text to search for in the Find what field.

5. If an exact string match is required, select the Exact Match box.

6. If text case matching is required, select the Match Case box.

7. Click Next to begin the search.

The Matrix panel updates to the first match.

8. Click Next again to navigate to subsequent matches.

9. Click  to navigate to previous matches.

10. Click Close to close the dialog. 

The Matrix panel view will remain with the last match in the middle of the matrix panel view.

Filter Dialog
Use the Filter dialog to reduce the number of source and/or destinations visible in a matrix panel. 
(Figure 57) This enable a user to filter a matrix panel view to only source/destinations that match 
entered text.

 The filter matches any consecutive characters and ignores the case. For example, typing at will 
match to SAT, data, Matte etc.
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Figure 57  Example of the Filter Dialog

To use the Filter dialog

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. To filter the destinations:

a. Enter the filtering text in the Destination field as required.

b. Click  to enable destination filtering.

The Matrix panel view updates to display only those destinations matching the entered text.

3. To filter the sources:

a. Enter the filtering text in the Source field as required.

b. Click  to enable source label filtering.

The Matrix panel view updates showing only those destinations matching the entered text.

4. Click  to clear the associated filter text field.

5. Click Clear All to clear both filter text fields.

6. Click Close to close the Filter dialog.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and 
Source buttons on the panel. This section provides instructions using the cross-hairs for crosspoint 
selections.

To make a crosspoint switch using a single level

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select a level from the toolbar.

The button is now lit.

3. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. In the example 
below, Level 2, Src_28-4, and DST_28-2 are selected. The TAKE button is now lit.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.
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4. Click TAKE.

The icon on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch between multiple sources and destinations on a single level

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select a level from the toolbar.

3. Select the first source and destinations inside the matrix.

4. Select the additional crosspoints to switch.

In the example below, Level 2 is selected but seven crosspoint switches are also selected (each 
is represented with a green icon on the matrix).

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.
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To make a crosspoint switch using multiple levels

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or click Follow to include all levels.

3. Select the first source and destination inside the matrix.

4. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections 
with each section representing a level. In the example below, Levels 4, 6, and 8 are selected; 
each with multiple crosspoint selections on the matrix.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

3. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected.The Select All button is 
labeled Clear All.

4. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to 
the same source and the TAKE button is now lit. In the example below, Levels 4, 5, and 6 are 
selected; all destinations will switch to Src_28-6.
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 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

Using a Default Preset
The Advanced menu provides two pre-configured presets: Diagonal and R-Diagonal.

Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top left corner of the 
matrix (e.g. Src 1 and Dest 1), continues in single step intervals (e.g. Src 2 and Dest 2, Src 3 and 
Dest 3 etc.) and ends with the bottom right corner of the matrix (e.g. Src 16 and Dest 16). 

To use the Diagonal Preset

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

3. Click Advanced > Diagonal Presets.
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 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

4. Click TAKE.

R-Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top right corner of the 
matrix (e.g. Src 16 and Dest 1), continues in single step intervals (e.g. Src 15 and Dest 2, Src 14 and 
Dest 3 etc.) and ends with the bottom left corner of the matrix (e.g. Src 1 and Dest 16). 

To use the R-Diagonal Preset

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

3. Click Advanced > R-Diagonal Presets.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

4. Click TAKE.
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Creating an Automatic Switching Loop
The Automation feature enables you to set up a crosspoint and create a continuous switch loop 
using the specified crosspoints.

To set up an automated crosspoint selection loop

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Click Advanced > Setup Automation.

The Automation Setup dialog opens.

3. Use the Repeat Interval field to specify how long the crosspoint switch will continuously loop 
for.

4. Use the Levels menu to specify the levels the crosspoint will include.

5. Use the Destinations menu to select the outputs on the router.

6. Use the Sources menu to select the input signals to route to the output for the switch.

7. Click Start.

The menu closes and the crosspoint switch begins. The loop continues for the length of time 
specified in step 3.

 To instantly stop the loop, click Advanced > Stop Automation.

Clearing the Matrix Selections
You can choose to clear all the crosspoint selections, or only the selected Destinations.

To clear all crosspoint selections on the matrix

• Click Advanced > Clear All Presets.

To clear only the Destination selections on the matrix

• Click Advanced > Clear Dest Presets.
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Using MultiBus Panels
Use the MultiBus Panel to send a source to multiple destinations.

Panel Interface Overview
The MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. 

Figure 58  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. 
Selecting a button includes the destination in the next crosspoint switch. The number of 
destinations and label for each button is defined by its entry in the Destinations interface. A 
destination selected to be included in the next crosspoint switch will have a lit button. For 
example, DST_28-5 is selected in Figure 58.

2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft 
panel with the Take operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.

4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, 
once destination, and one level are selected on the interface (the Dest and Src buttons are lit 
blue to indicate their inclusion in the next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on 
the soft panel.

1) Destination Bus 4) Preset Button 7) Level Button(s)

2) Lock Button 5) Clear Button 8) Follow Button

3) Take Button 6) Multi Select Button 9) Source Bus
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If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will 
take effect the next time the TAKE button is selected. If you are using a soft panel with the Take 
Operation set to Direct, a TAKE button is not displayed because the transitions occurred 
automatically (hot-punch operation).

5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel 
interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you 
are using a soft panel with the Selection Operation set to Single, a Multi Select button is not 
displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit 
button indicates that the corresponding level will be included in the next transition. The color and 
name of the button are specified using the Levels interface. Figure 58 illustrates a MultiBus 
panel with four levels selected.

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take 
operation set to Confirm, pressing TAKE after pressing Follow will then switch all crosspoints at 
the same time on all available levels.

9. Source Bus

Each button in this crosspoint row represents an input in the routing system. Selecting a button 
includes the source in the next crosspoint switch. The label for the button is defined by its entry 
in the Sources interface of the Database. A source selected to be included in the next crosspoint 
switch will have a lit button. For example, in Figure 58 the Src_28-1 is selected for the next 
transition while the Src_28-4 is the current source in use. 

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control for Legacy Devices” for details.

Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are 
arranged into a row of buttons near the top of the panel and the sources are arranged on a row 
near the bottom. 

To make a crosspoint switch on a single level using a MultiBus panel

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. From the left toolbar, select the button for the level you want to perform the crosspoint switch.

3. Select a button from the Source bus (located at the bottom of the interface).

The button is now lit.

4. Select a button from the Destination bus (located at the top of the interface).

The Dest, and Preset buttons are now lit.

In the example below, the first level is selected (VID) and OUT 4 will switch with CAM 1.
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 If the soft panel has its Take operation set to Direct, the Take button does not display and the 
switch occurs automatically.

5. Click Take.

To make a crosspoint switch using multiple levels

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a 
horizontal bar to represent the level.

3. On the Destination bus, select the button for the outputs to include in the crosspoint switch.

4. On the Source bus, select the button for the input.

The Destination, Source, Preset, and Take buttons are now lit. 

In the following example, STUDIO 1 will switch with CAM 3 on Levels VID and AUD 3.

 If the soft panel has its Take operation set to Direct, the Take button does not display and the 
switch occurs automatically.

5. Click Take.
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Using the Multi Select Function
Use the Multi Select button when you want to group multiple destinations to use a single source 
during the next crosspoint switch. 

To use the Multi Select function

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select the level(s) from the left toolbar.

3. Click Multi Select.

The Multi Select button is now lit.

4. Select the buttons from the Destination bus located near the top of the interface.

The Destination buttons are now lit.

5. Select a button from the Source bus located near the bottom of the interface.

The Source, Preset, and Take buttons are now lit.

In the example below, Levels 2 and 4 are selected, and DST_28-1, DST_28-3, and DST_28-6 will 
switch with Src_28-6.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

6. Click TAKE.

Using Category Panels
Category panels organize sources, destinations and levels based on the settings in the Group 
Category and Cat/Index interfaces.

For More Information on...
• legacy categories, refer to the RCP-QE User Guide.
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Panel Interface Overview
The soft panel interface for each category type is similar in layout and available buttons. 

Figure 59  Example of a Group Category Soft Panel

Figure 60  Example of a Cat/Index Soft Panel

1. Group Window

This area of the soft panel interface may include the following buttons:

› DESTINATIONS, SOURCES, LEVELS — Clicking one of these buttons updates the crosspoint 
area to display the selected resource (destinations, sources or levels) available as per the 
selected category. The button labels update to display the assigned labels.

› TOP — Click this button to return the crosspoint area to display the selected resources. This 
button is only available on the Group Category soft panels.

› BACK — Click this button to return the navigation to the previous category selection (back one 
level).

› RESET — Click this button to clear all selections on the interface. This button is only available 
on the Cat/Index soft panels.

1) Group Window 2) Status Window 3) Control Area
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› SELECT — This button is only available on the Cat/Index soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to 
Hide, only the resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of 
available levels, a corresponding status indicator display will indicate the current source for the 
currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Level buttons — Click a level button to include the level in a crosspoint that you are configuring 
in the matrix. A lit button indicates that the corresponding level will be included in the next 
transition. The color and name of the button are specified using the Levels interface.

› CURRENT — This button updates the level display area to show the current status for all 
displayed levels.

› PENDING — This button updates the level display area to show status for the currently 
pending operation (if selected source has not been switched yet. e.g. before TAKE is pressed).

› USER — This button shows current lock/protect status of each levels (and the soft panel name 
that is currently owned it). Since the soft panel does not recognize the names of remote control 
panels (RCP) to retrieve their name, a “owner #” name is used. 

› FOLLOW — Click this button to select all levels in the matrix. Clicking TAKE after clicking 
FOLLOW will then switch all crosspoints at the same time on all available levels.

› CLEAR — Click this button to clear all selections on the interface.
› CLEAR SEL SRC — Click this button to clear individual source selections by selecting the levels 

to be cleared.

3. Control Area

The bottom toolbar of the soft panel interface can include the following buttons:

› Protect — Click this button to prevent switching of the selected destination except by the 
panel that initiated the protect. If you are using a soft panel with the Protection Operation set 
to Disable, the Protect button is not displayed.

› Lock — Click this button to prevent switching of the selected destination by an control device. 
If you are using a soft panel with the Protection Operation set to Disable, the Lock button is 
not displayed.

› View — Click this button to display the VIEW dialog. This dialog lists the current TAKE 
commands in the queue. Individual items may be removed from the queue via the options in 
the View dialog.

› Clear — Click this button to clear the current TAKE queue.
› Preset — Use this button to queue up multiple TAKE commands. Select a destination/source 

combination, then click Preset. Select another destination/source combination then click 
Preset. A following TAKE command will execute all the Preset switches. To view the switch 
commands queued by the Preset, click View.

› Show TAKE Errors — Click this button to display a summary of the error conditions that were 
detected each time a switch command was executed. Click Close to the exit the dialog.

› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you 
are using a soft panel with the Take Operation set to Direct, a TAKE button is not displayed 
because the transitions will occur automatically after a crosspoint switch is selected.

Crosspoint Switches via a Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the 
current database, and how the soft panel was defined in the Panels interface. Instead of displaying 
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all sources, destinations, and levels at one time, a Category soft panel provides access based on the 
categories and the indexes you created.

To make a crosspoint switch using a Group Category Panel

1. Display the Group Category soft panel in the DashBoard window as outlined in “To display a 
soft panel in the DashBoard window”.

2. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

3. To select a destination:

a. Click DEST from the category navigation tools.

b. Navigate to the desired group using the displayed groups in the main group window. 

Only groups containing destination assignments will be displayed unless the Non-group 
Resources option for this soft panel is set to Show.

c. Select a button from the available category destinations located in the main group window.

In the following example, the user has selected levels VID, AUD 1, and AUD 3; destination 
STUDIO 2.

4. To select a source:

a. Click SRC from the category navigation tools.

b. Select a button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button 
is lit. Otherwise the crosspoint switch automatically occurs.
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5. Click TAKE.

Using Push Button Panels
 This soft panel type is suitable for use on an Ultritouch hard panel. To control the Ultrix and 

Ultricore via an Ultritouch, you must create and load an Ultritouch PB soft panel as outlined in the 
Ultritouch User Guide.

Panel Interface Overview
The Push Button soft panel is organized into three distinct windows. The order and width of each 
window can be customized using the options in the Panels > Settings interface.

Figure 61 is an example of a Push Button soft panel set to portrait.

Figure 61  Example of the Default Push Button Soft Panel — Portrait
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Figure 62 is an example of a Push Button soft panel set to landscape.

Figure 62  Example of the Default Push Button Soft Panel — Landscape

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a button to 
arm that destination for subsequent panel operations. Beneath each destination button is 
displayed the current source for that destination.

This area also includes the Filter field. A filter is available to match destination names against the 
entered text:   

• Enter text in the Filter field.

• Click  (or press Enter). The destinations area updates to display only those destinations 
starting with the filter text.

• To clear the active filter, click .

2. Sources Area

The Sources area displays the available sources for router control. Select a button to control the 
crosspoint for the currently selected destination.

This area also includes a Filter field. A filter is available to match source names against the 
entered text:

• Enter text in the field provided.

• Click  (or press Enter). The sources area updates to display only those sources starting 
with the filter text.

• To clear the active filter, click .

3. Current Destination

The currently selected destination label is displayed here. All subsequent panel operations 
operate on this destination until a new destination is selected.

›  — the current status is not the same for all levels (ie a breakaway switch has occurred).

1) Destinations Area 3) Current Destination 5) Operation Area

2) Sources Area 4) Levels Area
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›  — the current destination is locked. No switches can be made on this destination.

›  — the current destination is protected. Only the panel that initiated the protect may 
switch this destination.

4. Levels Area

The Levels area displays the available router levels as individual buttons. The current source for a 
given router level is displayed each level button. Select a button to include this level in the next 
source selection operation. Select the button again to toggle the level selection setting.

This area also includes the following buttons:

› FOLLOW — toggles the selection for all displayed levels.
› CLEAR — toggles the currently active level buttons.

5. Operation Area

This area includes the following buttons (left to right) for soft panel and router control:

› SALVO — displays a list of predefined salvos. A salvo may be executed from the dialog. The 
salvo button is visible only when the panel configuration has one or more salvos assigned.

› PROTECT — protects the current destination. Only the panel that initiated the protect may 
change the protect status. When selected, the following occurs:

a. The destination button displays a blue border.

b. The Current Destination area displays . When a destination is protected, only the panel 
that initiated the protect can change the destination status.

c. The PROTECT button is now labeled as UNPROTECT. 

d. Toggle the button to disable the protect.

› LOCK — locks the current destination. Only the panel that initiated the lock may change the 
lock status. When selected, the following occurs:

a. The destination button displays a red border.

b. The current destination display area displays . A panel cannot change the destination 
status of a locked destination.

c. The LOCK button is now labeled as UNLOCK.

› VIEW — displays the current crosspoint switch requests currently in the preset list. Individual 
crosspoints may be removed via the list view.

› CLEAR — clear the preset list of all crosspoint selections.
› PRESET — adds the current destination/source/level selection to a preset list. A crosspoint is 

added to the list for every level selected. This enables the user to add more switches and 
execute them all with a single take operation. The preset function is only available when the 
Take Mode is set to Confirm.

› TAKE — is lit when the current destination/source selection is ready to be requested of the 
router. This button only displays when the soft panel Take Mode is set to Confirm.

Configuring a Push Button Soft Panel
The Push Button soft panel provides additional configuration options in addition to those outlined 
in “Creating a Soft Panel”. 
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To configure a Push Button soft panel

1. Create a new soft panel as outlined in the procedure “To create a soft panel” and “To 
customize the layout of a soft panel”.

The Settings tab is automatically selected.

2. Use the Icons Display menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

3. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — a horizontal layout; the panel is taller than it is wide. (Figure 61)
• Landscape — a vertical layout; the soft panel is wider than it is tall. (Figure 62)

4. Select the Layout tab.

5. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Status.

a. In the Home Windows table, select the row for the window you want to move to on the soft 
panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display.

7. Select the Title bar box to display a header above a window.

To configure a Group PB panel

1. Create a new Group PB soft panel as outlined in the procedures “To create a soft panel” and 
“To customize the layout of a soft panel”.

The Settings tab is automatically selected.

2. Use the Icons Display menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).
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3. Select the Layout tab.

4. In the Home Windows table, specify the order that the windows will display in the completed 
soft panel layout as described in “To customize the Home Window of a soft panel”.

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Operation.

5. In the Drawer Windows table, specify the order of the windows that display on the soft panel. 
Refer to “To define the drawer elements of the soft panel” for details.

 To configure an Output Monitor window for a Group PB soft panel, refer to the Ultritouch User 
Guide.

Crosspoint Switches via a Push Button Panel
The buttons and options in a Push Button soft panel are dependent on the current database, and 
how the soft panel was defined in the Panels interface. You can also use the Filter fields in the 
Destinations and Sources area of the panel to provide access based on the search criteria entered 
into each Filter field.

To make a crosspoint switch on a single level using a Push Button Panel

1. Display the Push Button soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select the Level you want to perform the crosspoint switch.

3. Select a button from the Destinations window.

The Status field reports the selected button. 

4. Select a button from the Sources window.

In the following example, the user selected EDIT 3, CAM 4, and a level (VID).

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

5. Click TAKE.

To make a crosspoint switch on multiple levels using a Push Button Panel

1. Display the Push Button soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select each level from the Levels window or click FOLLOW to include all levels.
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The Level buttons are lit in the right most toolbar.

3. Select a button from the Destinations window.

The Status area updates to display report the selected destination. 

4. Select a button from the Sources window.

The Status area updates to display only the selected source. 

In the following example, the user selected OUT 3, SAT 5, and two levels (VID and AUD7).

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

5. Click TAKE.

Using an Ultritouch PB Panel
An Ultritouch PB soft panel is organized into a pre-sized layout that can be loaded for use on an 
Ultritouch hard panel. Customize each soft panel by specifying the size of each window, the location 
of each window on the layout, and what operational buttons to include on the panel.

 The Ultritouch PB soft panel type can only be loaded and used on an Ultritouch hard panel. 

Figure 63  Example of an Ultritouch PB Soft Panel

For More Information on...
• configuring and using an Ultritouch PB soft panel, refer to the Ultritouch User Guide.

To load a soft panel to an Ultritouch

1. On the Ultritouch hard panel display, tap .

The All Connections interface displays.

2. Tap the router you want to control via the Ultritouch.
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3. Tap the second button.

The panel updates to display the router hierarchy much like the tree view in the router menu 
system.

4. Tap Soft Panels.

A list of available soft panels displays.

5. Tap the required soft panel.

6. Tap Open.

The Ultritouch interface updates to display the selected soft panel.

Using an Audio Mixer Panel
An audio mixer panel can be customized to display a collection of data as defined during the soft 
panel configuration using the options in the Panels > Layout tab.

 The audio mixer panels can only be configured, accessed, and operated on an Ultrix router.

Customizing the Audio Mixer Panel Features
Table 75 summarizes the options for the types of data you can assign to the Home window of an 
audio mixer panel.

By default, the Drawer window is populated with a right-side Mixer Output window, a left-side 
Mixer Selection window, and a right-side Mixer Filters window. When multiple windows are 
assigned to either left or right drawers, the user must first select the drawer handle, then the 
window that is required. 

Table 76 summarizes the options for the types of data you can assign to the drawers of an audio 
mixer panel.

Table 75  Home Window — Types of Data

Type Description
Channel Strip Displays the controls for the inputs of the selected audio mixer

Output Strip Displays the controls for the outputs of the selected audio mixer

Mixer Destination Displays the audio mixer destination selection buttons

Monitor Displays read-only status information of the selected audio mixer

Sources Displays the router source selection buttons 

Table 76  Drawers — Types of Data

Type Description
Mixer Outputs Displays the available audio mixer outputs. Select to switch the mixer 

panel current output bus.

Mixer Partition Displays the audio matrix (partition) selection buttons.

Audio Filters Displays the audio filter page for the currently selected channel strip.

Channel Balance Displays the audio channel balance slider.
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Table 77 summarizes the default sizes for the types of drawers for each type of audio mixer panel.

By default, the channel strips are placed from left to right, and the output strips are placed at the far 
right.

Audio Mixer Soft Panel Overview
The panel UI design are similar to Ultritouch approach where UI sections are categorized into UI 
windows. These UI windows can be placed in main display and/or drawers. 

Home View Window
By default, the channel strips are placed from left to right, and the output strips are placed at the far 
right. (Figure 64)

Mixer 
Destinations

Displays the router destination selection buttons in the specified 
drawer. Select to route the current mixer output to one or more Ultrix 
destinations.

Sources Displays the router source selection buttons in the specified drawer. 
Select to route an Ultrix source to the current mixer channel.

Table 77  Drawer Windows — Default Settings

Window Type Default Percent
Audio Mixer Desktop

Mixer Output 30

Mixer Selection 30

Mixer Filters 50

Audio Mixer 4RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100

Audio Mixer 2RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100

Table 76  Drawers — Types of Data (Continued)

Type Description



228 • Soft Panels in DashBoard Ultrix and Ultricore Database Guide (v1-rev6)

Figure 64  Example of an Audio Mixer Soft Panel

1. Channel Strips

Each strip controls the input from that audio channel and are color coded for where the audio 
comes from. Each strip includes the name of the audio channel and the router source assigned to 
it. Clicking the router source name opens the router source selection drawer window if defined.

 If a source is grayed out, the crosspoint is currently set to Lock or Protect by another panel.

2. Noise Gate

Opens the Noise Gate page in the Audio Filters window. Refer to “Noise Gate” for details.

3. Compressor/Limiter

Opens the Compressor/Limiter page in the Audio Filters window. Refer to “Compressor/Limiter” 
for details.

4. Equalizer

Opens the Equalizer page in the Audio Filters window. Refer to “Equalizer” for details.

5. Mute

Turn off the audio from this source. This does not change the level.

6. Audio Fader and Meter

Adjust the level of the audio from the source. 

7. Solo, Solo Clear

The solo action is dependent on the current mixer output.

› Master output — Selecting solo will route that channel to the defined Monitoring output. It 
does not affect the master output. Only those channels with solo activated will be connected to 
the Monitoring output. If no channels have solo activated, the monitoring output follows the 
Master output.

1) Channel Strips 5) Mute 9) Drawers

2) Noise Gate 6) Audio Fader and Meter 10) Monitor Strip

3) Compressor/Limiter 7) Solo, Solo Clear

4) Equalizer 8) Output Strips
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› Aux outputs — Selecting solo MUTES all other inputs to the selected output bus.

Any channels with solo active will illuminate the Solo Clear button - even channels not currently 
visible. Clicking Solo Clear disables any solo action for the selected output bus.

8. Output Strips

The output channel strip fader controls the over-all level for that mixer output. Use the scroll bar 
at the bottom or the mixer output drawer window to select a mixer output bus. 

9. Drawers

A navigation drawer is available on the left and right sides of the interface. Tap the drawer icon 
once to open a pane that provides access to additional menus and functions of your soft panel. 
Tap the drawer icon again to close the pane. The contents of a drawer is determined when the 
soft panel was configured.

By default, the audio filters are located in the right drawer of a soft panel. The following audio 
filters are available for each channel strip: audio equalizer, noise gate, and compressor/limiter. 
Refer to the following sections for details on configuring each filter type.

 At the top of each audio filter setting is a Clipping indicator to warn you if clipping is occurring in 
the Equalizer stage (EQ) or Compressor/Limiter stage (CL).

10.Monitor Strip

The Master layer also has a Monitor output and level. By default, the Monitor strip reports the 
status of the last channel pair of the partition.

Equalizer
The audio equalizer (EQ) allows you to enhance the sound quality of audio sources. An independent 
equalizer is available for every audio fader in the system and allows for adjustment in four bands 
(low-shelf, mid-range, high mid-range, and high-shelf).

 You can adjust the EQ settings using the EQ graph or the specific slider control.

To configure an equalizer

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Equalizer.

In the example below, the Audio Filters window displays in the right drawer.



230 • Soft Panels in DashBoard Ultrix and Ultricore Database Guide (v1-rev6)

3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Low Shelf slider to adjust the gain of the low frequency band.

 You can also move the L point around on the graph to adjust the low shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Max Freq — set the maximum frequency that you want the low shelf audio band limited to 

(20Hz to 1kHz).

5. Use the Midrange 1 slider to adjust the gain of a midrange frequency band.

 You can also move the M1 point around on the graph to adjust the midrange 1 values. The dot 
below the M1 allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the bandwidth of the Q ratio filter (0.51 to 9.91). Note that adjusting the bandwidth 

also changes the frequency range the filter affects.

6. Use the Midrange 2 slider to adjust the gain of a midrange frequency band.

 You can also move the M2 point around on the graph to adjust the midrange 2 values. The dot 
below the M2 allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the Q ratio.

7. Use the High Shelf slider to adjust the gain of the high frequency band.

 You can also move the H point around on the graph to adjust the high shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Min Freq — set the minimum frequency that you want the high shelf audio band limited to 

(20kHz to 1kHz).

Noise Gate
A noise gate allows a signal above a certain selected threshold to pass through. Noise gates are 
typically used to reduce unwanted external sounds, and/or reduce natural channel noise.

To configure the noise gate

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Noise Gate.

In the example below, the Noise Gate window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to specify the level at which the gate opens.

5. Use the Gain Reduction slider to specify the amount of gain are reduced.

6. Use the Attack slider to specify how quickly sounds louder than the threshold are affected.

7. Use the Release slider to specify how quickly sounds softer than the threshold are affected.

8. Select the Enable Clipping to 

 Click Reset Noise Gate to return all Noise Gate settings to the default values.

Compressor/Limiter
The audio compressor allows you to restrict audio levels from passing a threshold level. These are 
often used to prevent digital clipping of audio levels that are too high for output equipment. Once 
the threshold is reached, the compressor starts to reduce the gain at a specific ratio. The higher the 
compression ratio, the harsher the reduction in gain. The compression continues until the audio 
level falls below the threshold. You can adjust how quickly the compressor is applied once the 
threshold is surpassed as well as how long after the level drops below the threshold that the 
compressor is still applied.

 The compressor is said to be acting as a limiter when the compression ratio is set very high, or to 
infinity, and the attack time is set very low. This has the effect of causing a very abrupt flattening 
of the audio level once the threshold is reached.

To configure the Compressor/Limiter settings for the audio matrix inputs

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Compressor/Limiter.

In the example below, the Compressor/Limiter window displays in the right drawer.



232 • Soft Panels in DashBoard Ultrix and Ultricore Database Guide (v1-rev6)

3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to select the level (dB) at which the compressor is applied.

5. Use the Compression slider to select the ratio for the amount of compression you want to 
apply. The higher the ratio the more compression is applied to lower the level. At infinity the 
audio level is limited to the threshold.

6. Use the Attack slider to select the amount of time (ms) you want to pass between the level 
surpassing the threshold and the full compression ratio being applied.

7. Use the Release slider to select the amount of time (ms) you want to pass between the level 
falling below the threshold and the compression ratio returning to 1:1 (no compression 
applied).

8. Use the Makeup slider to increase the gain of the audio after compression.

Adjusting the Balance of an Audio Source
Adjusting the balance of an audio source adjusts the volume of the left and right stereo channel. For 
example, as you move the Balance slider to the right the volume of the right channel is increased 
and the volume of the left channel is decreased.

To adjust the balance of an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

In the example below, the Pre-Processors & Balance Control window displays in the right 
drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the slider in the Balance area to adjust the volume of the left and right stereo channel.

Audio Processing Options
The audio mixer panel enables you to adjust the gain and phase invert, individually, each of the 
audio sources.

To configure the audio proc-amps for an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

3. Select an audio channel to modify.

4. Use the Pre-Gain field to specify the amount of gain (dB) applied to the input channel. 

5. To invert a channel:

• Click Left Channel Phase Invert to inverts the audio signal of the left channel.
• Click Right Channel Phase Invert to inverts the audio signal of the right channel.

6. Click Input Sum to sum the left and right input channels. Both channels carry the average 
((A+B)/2) of the two input (Left and Right) channels. 

Partitions in an Audio Mixer Soft Panel
If your audio mixer soft panel includes partitions, you can switch between matrices as follows:

1. Expand the applicable drawer to display the Mixer Selection window.

 By default, the Mixer Selection window is located in the left drawer of the soft panel.

2. Click the Partition button for the required mixer (partition).

• The channel strips and output strips are auto-populated.
• The mixer inputs are automatically routed to the mixer outputs.
• The soft panel recognizes a take transition from an external panel.

If your audio mixer soft panel includes router levels, sources, and destination, you can perform 
crosspoint switches as outlined in “Crosspoint Switches via a Matrix Panel”.
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Ultricore Profiles
A DashBoard client has the ability to detect devices on a subnet and can enable complete control of 
all settings on all devices. Ultricore Profiles are designed to enable administrators to assign and 
manage user permissions and determine the level of access for those users. For example, one user 
is only responsible for monitoring the video sources is given access only to control panels, while 
another user who manages the input and outputs of the router matrix is also given access to 
manage the databases. 

This chapter provides an introduction to the Ultricore Profiles for your router matrix and includes 
general information on managing those profiles. 

Overview
The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which routing system functions and 
interfaces that an assigned user can access. 

Any number of profiles may be created and can be used in the following ways:

• Group/Role — This profile type is not specific to any user or machine. Once created, they can be 
referenced or used by any number of users or machines. For example, a Graphics Editor profile 
can be created and referenced by a team of graphics editors. When a new control panel is added 
to that profile, all graphics editors are updated with the new panel automatically.

• User — A profile that identifies a specific username and can either reference an existing role as 
above or copy an existing role then modify, add, or remove items to allow total customization as 
required. This allows a user that has a specific profile to have the same capabilities on any 
DashBoard system regardless of where they log in. 

• Location — A profile that is defined by a specific location (user station) and assigns a consistent 
function regardless of who is logged in that suits the operation in that location. In this way the 
DashBoard instance in front of, for example, the audio operator in a specific control room will 
only have the optimize functionality for that role. A location profile can also reference or copy and 
modify role profiles.

Profiles can also be created that identify a specific user at a specific workstation to further optimize 
the user interface in different locations. If no profile exists for the combination of user and location, 
the system default profile is used.

When there are multiple available profiles, the one used is chosen as follows:

1. A User profile has the highest priority. This means that an administrator can log in anywhere 
and execute Administrator level functions or an operator can login anywhere and have an 
optimized UI for their function.

2. A Location profile is used for all users at a specific location unless the user logged in has a 
profile. This allows more or different functionality for users logged into a specific location even 
if they do not have a specific profile themselves.

3. The Operator profile is used in all other scenarios.

Modes of Operation
The Ultricore Profiles feature consists of three sub-functions or modes of operation.

 The ULTRICORE-PRO license is required to upgrade from the basic, non-configurable profiles on 
the Ultrix chassis to full, customizable configurations. The ULTRICORE-PRO license is standard on 
the Ultricore BCS.
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Creation and Management of User Credentials
User profiles can reference the operating system username of the individual currently logged into 
the workstation.

Setting the Credentials Mode to Ultricore Users in the Product Info > Setup tab engages the 
Ultricore Profiles feature. This allows an independent definition of usernames and passwords 
specifically for the Ultricore Profiles feature.

Creation and Management of User Profiles via the Profiles Only 
User and Location profiles are created and function as above but only reference one of the two 
default profiles:

• Admin can access all features; or
• Operator has full database and configuration capability but not engineering configuration and 

administrative functions.

Full Creation, Customization, and Management of User Profiles
In addition to the above modes included with the ULTRICORE-PRO license is the ability to create and 
customize group and role profiles as well as create custom profiles on a user or location basis as 
appropriate. In addition, the order of items within these profiles can be set to fully optimize the 
operational environment for a specific user or group as needed.

User Profiles Interface
The options for configuring and managing the Ultricore Profiles are organized as individual tabs 
within the User Profiles interface of DashBoard. The available settings depend on whether the 
ULTRICORE-PRO license is installed. By default, all settings are displayed and accessible by any user 
or DashBoard client machine.

Accessing the User Profiles Interface
The User Profiles interface is a sub-node of the Database tree in DashBoard. 

To display the User Profiles interface

1. Display the Database > Configuration interface as outlined in “Accessing the Database 
Interfaces”.

2. Double-click the User Profiles sub-node.

The User Profiles interface opens in the DashBoard window. 



Ultrix and Ultricore Database Guide (v1-rev6) Ultricore Profiles • 237

Overview
When the ULTRICORE-PRO license is enabled, or you are using an Ultricore BCS, the Ultricore 
Profiles interface displays a toolbar with two tabs: Users and Profiles. Each tab is briefly described in 
the following sections.

Users Tab

When the system is configured to use the Ultrix user login mechanism, a list of all defined user 
accounts displays in this tab. From this tab, you can add, edit, and manage the accounts in your 
routing system.

Profiles Tab

A list of all currently configured profiles. Selecting a profile (row) in this tab automatically updates 
the settings in the Info, Configuration, and Assign users sub-tabs.

• Info — reports the name of the selected profile. 
• Configuration — displays two areas: Available and Assigned. The Assigned area provides a visual 

representation of the tree view that is defined in the Info sub-tab. Note that certain entries that 
are specific to licenses or other conditions may be visible but not in the actual tree view. Should 
conditions change that enable those entries, they will appear as shown in this display. A profile 
also maintains the position of items in groups allowing the most relevant items to be the easiest 
to reach. The tree nodes are organized in a hierarchy where the top level (blue icons) list system 
specific options, and secondary levels (yellow icons) list specific functions. This requires the 
ULTRICORE-PRO license to be enabled.

• Assign users — displays the user accounts that have not yet been assigned to the currently 
selected profile but are available. This requires the ULTRICORE-PRO license to be enabled.

Creating a Database of Users
To begin implementing the User profile feature for your system, you first create at least one new 
user account. You can create as many user accounts as required by your system. New user 
accounts will default to the Operator profile unless or until they have a profile created that allows 
them appropriate access for their role. 
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Two user accounts are available by default:

• admin — provides full admin and engineering capabilities by using the Admin profile. This 
account is read-only by default.

• operator — provides access to all non-engineering features and functions. The user can 
configure and access all operational functions and databases of the systems. 

 Ensure that the system is not in use before creating accounts and profiles. Any currently active 
DashBoard instances will require users to login and features may be blocked. 

To create a new user account

1. Display the User Profiles interface as outlined in “To display the User Profiles interface”.

The Users tab is automatically selected.

2. Click .

The Add User dialog opens.

 A user can change their password at the login screen. 

3. Use the Name field to assign a unique identifier for the user account. 

4. Use the Password field to define the password the user will need to enter when logging in with 
this account.

5. Type the same password in the Retype Password field.

6. Click Apply.

The Add User dialog closes and the new user account is listed in the table.

 By default, a new user account is assigned to the Operator profile.

7. Repeat this procedure for every new user account you wish to create. 

Creating a New Profile
 The User Profiles feature offers a significant flexibility to optimize the tools in front of individual 

operators which, if inadvertently mis-configured could lead to administrators being locked out. 
As such, it is a good idea for the administrator to ensure that no users are actively working within 
the system prior to making significant changes to user accounts and profile settings. 

Two profiles are available by default: 

• Admin — a group profile giving access to all features and functions as has been available prior to 
the Ultricore Profiles feature.

• Operator — a group profile giving access to only the soft control panels. This allows users that 
are registered but either have no defined profile on a system or only require basic operational 
access the ability to control pre-configured operational functions of the systems. 
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 All users default to the Operator profile with no System Login required. In other words, until 
specifically enabled, the Ultricore Profiles feature is not engaged, and the systems will all behave 
as in previous versions. It should be noted that while the User Profiles feature is not engaged, the 
default user profile can be modified should the tree for all users need to be modified. 

To create a new profile

1. Display the User Profiles interface as outlined in “To display the User Profiles interface”.

2. Select the Profiles tab.

3. Click .

The Add Profile dialog opens.

4. Use the Name field to assign a unique name for the profile. 

 Since the profile could be either specific to a user, a workstation or a group of users, it is 
recommended to create a name that reflects its purpose. For example, John Doe (a specific user), 
Graphics Operator (a group of users), or PCR1-TD (a workstation). 

5. Use the Type menu to define the purpose of the profile. Choose from the following:

• User — the profile is specific to a user or a workstation.
• Group — the profile is specific to a group of users, roles, or locations.

6. Click Apply to create the new profile.

The Profile table updates to display the new entry.

To define the name for a profile

1. From the Profile table, select the row for the new profile.

2. Select the Info tab in the right pane.

3. Use the Profile name field to edit the assigned name to the profile.

Defining the Permissions for a Profile
Once a profile is created, you can modify the tree structure that will be enabled for the user(s) of the 
selected profile. (Figure 65) 

 This section only applies if you are using an Ultrix router to configure your database and the 
ULTRICORE-PRO license is enabled on the router.
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Figure 65  Example of the Profiles > Configuration Sub-tab

Overview
This section provides a brief overview of the Configuration areas.

Available

The Available area (the leftmost table) displays all items that are not currently included in the 
selected profile’s tree. If an item is not in the tree currently but required, the appropriate group tab 
is selected, the item required is selected and the Assign button is clicked moving it to the bottom of 
the appropriate group of the tree. The Up and Down buttons can then be used to order the tree 
items specific to the needs of the profile. 

Assigned

The Assigned area (the rightmost table) displays all the assigned options and their desired order in 
the tree structure much like the tree view in DashBoard for an Ultrix and Ultricore router. The 
nodes in Ultricore Profiles tree view are determined by your system configuration and any licenses 
installed for your system. Buttons at the bottom of this area (Up, Down, Remove) allow entries to 
be moved up and down in the tree within the group to which the item belongs or removed if they 
are not required for the selected profile. When removed, the item is returned to the list of available 
items in the appropriate group tab. 

Configuring the Permissions for a Profile
When any change is made in the Configuration sub-tab, the changes are automatically captured in 
the system database. 

To configure the permissions for the profile

1. From the Profile table, select the row for the profile you wish to configure.

2. Select the Configuration tab in the right pane.

3. Use the Available and/or Assigned tables to determine if the parent profile tree configuration 
is used directly by the profile being created or edited or copied into this profile allowing 
customization of the tree for the specific needs of the user. 

 If another profile tree is used rather than copied, changes to the tree need to be performed on 
the parent profile tree and will affect all users that “use” that parent profile and that the same 
change would need to be executed individually on all users that copied the parent profile tree. 
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Assigning Users to a Profile
Once the user accounts and profiles are defined for your system, you can assign users to the 
profiles. 

Figure 66  Example of the Profiles > Assign users Sub-tab

To assign a user account to the profile

1. From the Profile table, select the row for the profile you wish to configure.

2. Select the Assign users tab in the right pane.

3. From the Available table, select the user account you wish to assign to the profile.

4. Click .

The selected user name displays in the Assigned table.

5. Repeat this procedure to add users to the selected profile.

Managing the User Accounts
This section outlines how to edit the credentials, re-assign accounts to different profiles, and how to 
delete an account from the database.

To edit a user account

1. Ensure the user account is not currently in use. 

2. Display the User Profiles interface as outlined in “To display the User Profiles interface”.

The Users tab is automatically selected.

3. Select the row for the user account you wish to edit.

4. Click Edit.

The Edit dialog opens.

5. Edit the user account credentials as required.

6. Click Apply.

The Edit dialog closes and the changes are applied.
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To manage the profile(s) assigned to a user account

1. Select the Users tab.

2. Select the row for the user account you wish to edit.

3. To remove a user account from all currently assigned profiles, click Clear Profile.

The Assigned Profile cell is now blank, and the Available Profiles list updates in the right pane.

4. To remove a user account from a specific profile:

a. In the Available Profiles list, select the profile you wish to remove from the account.

b. Click .

To delete a user account

1. Select the Users tab.

2. Select the row for the user account you wish to delete.

3. Click Delete.

The Delete dialog opens.

4. Click Apply.

The Delete dialog closes and the selected user account no longer displays in the Users tab.

Setting the Credentials Mode
Once Ultricore Profiles are configured for your system, you can proceed to set the Credentials Mode 
to Ultricore Users. This replaces the current user credentials and settings with the profiles and 
groups you defined in this chapter. 

 Before proceeding, ensure that you created a new Administrator profile that has full access to 
your system. This is a separate profile from the default Admin profile (which is read-only).

 This procedure requires a reboot of the Ultrix or Ultricore BCS.

To set the Credentials Mode

1. Locate the primary device in DashBoard.

2. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

3. Select the Setup tab.

4. Locate the Ultricore Profile Settings area.

You may need to scroll down the tab to view this area.

5. Select the Ultricore Users box.

A dialog opens to confirm the selection.

6. Click Reboot.

Application of the Ultricore Profiles
Once the Credentials Mode is set to Ultricore Users, all users will initially view a DashBoard tree that 
only has a System Login entry. (Figure 67) Once the user is created with either the default or a 
specific password by the Administrator, the user can login through a login page displayed in the 
DashBoard window.
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Figure 67  Example of the System Login Sub-node

To log in

1. In the Basic Tree View, locate the device you wish to access.

2. Expand the device nodes to display the System Login sub-node.

3. Double-click the System Login sub-node.

The System Login page displays in the DashBoard window.

4. Enter the credentials for the profile assigned to you.

5. Click Login.

• The login information is confirmed by the system, and the appropriate tree with all assigned 
pages and functions are immediately available for use in the DashBoard window. 

• The Login page updates to the Logout page. 

When you log out, the Basic Tree View returns to the System Login tree view. Figure 67

To change the password

• Click Change Pwd on the System Login page.

 The old password is required to change the password, and to confirm that the new password is 
entered correctly. If the old password is forgotten/lost, the admin can force an update to the user 
password through the Users > Manage Users of the Ultricore Profiles interface. 

Unlocking via the Front Panel
Under some conditions, mis-configurations of Admin profiles, lost passwords etc. it may be 
necessary to force the Ultricore Profiles feature to be disabled to recover. This can be done via the 
front panel controls of the router.

To unlock the Ultrix and Ultricore via the front panel

1. Use the LCD panel and joystick to select Config > System > UC-Profiles.

2. Select Disable.

3. Perform a reboot to apply the change to either enable or disable the use of profiles.

User Data Import/Export
Due to the need to maintain different permutations of user data to system data, the Product Info > 
Transfer function includes the ability to manage the Ultricore Profiles database. This enables the 
Ultricore Profiles to be imported and exported independently to any chosen database. For example, 
import a different show configuration while maintaining the same staff and location configuration 
or for a truck, allowing a new crew configuration to be loaded without changing system 
configurations. 

To export the Ultricore Profiles for your system

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Transfer tab.
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3. From the top toolbar, click Ultricore Profiles.

4. Locate the Export area.

5. Click Browse... to specify the name and location to save the Ultricore Profiles file to.

The Save As read-only field updates with the selected path and file name.

6. Click Apply.

The Downloading Archive dialog opens to monitor the export.

To import an Ultricore Profiles set to your system

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Transfer tab.

3. From the top toolbar, click Ultricore Profiles.

4. Locate the Import area.

5. Click Browse... 

The Open dialog opens.

6. Select the Ultricore Profiles file to import.

7. Click Open to close the dialog and load the file.

8. Click Apply.

The Uploading Archive dialog opens to monitor the transfer.


	Ultrix and Ultricore · Database Guide
	Thank You for Choosing Ross
	Guide Information
	Contents
	Introduction
	Related Publications
	Documentation Conventions
	Interface Elements
	User Entered Text
	Referenced Guides
	Menu Sequences
	Important Instructions

	Contacting Technical Support

	Getting Started
	Before You Begin
	How a Database Determines the Routing System
	Configuration Overview

	Using DashBoard
	Launching DashBoard
	Accessing the Ultrix and Ultricore Interfaces in DashBoard

	Navigating the Database Interfaces
	Database Tree View Overview
	Accessing the Database Interfaces

	Databases Menu System
	Database Manager Interface
	Database Configuration Tab
	Database Builder Tab

	Configuration Interfaces
	Routing Devices
	Levels
	Destinations
	Sources
	Aliases
	Channel Alias
	Cat/Index Categories
	Group Categories
	Salvos
	Panels
	Layout Tab
	Buttons
	Destination Follow Interface
	Ultricore Profiles Interface

	Tieline Builder Interface
	Tieline Runtime Interface

	Enabling a Service
	Enabling a Communication Service
	Configuring the Service Settings
	Server Options and Supported Commands
	GVG Series 7000 Native Protocol Commands
	NVISION Commands
	Probel SW-P-08 Protocol Commands
	RossTalk Commands
	TSL UMD Protocol v3.1 Commands
	TSL UMD Protocol v4.0 Commands
	TSL UMD Protocol v5.0 Commands


	Creating a New Database
	Defining a Database for a Routing System
	Database Manager Overview
	Accessing the Database Manager
	Creating a New Database
	Using the Database Builder
	Activating a Database
	Managing the Databases
	Overview
	Copying a Database
	Exporting a Database
	Importing a Database
	Importing a Legacy Database
	Deleting a Database


	Adding Connection Points
	Overview
	Using an Ultricore BCS as the Primary Device
	Connecting to Client Devices

	Enabling Remote Controller Mode on a Client Device
	Accessing the Routing Devices Interface
	Adding Connection Points
	Before You Begin
	Adding a Ross Device
	Defining a Connection Point to a Client Device

	Defining a Connection Point to an IP Matrix
	Using an Ultricore BCS
	Using an Ultrix Router

	Defining a Connection Point for a Third-Party Protocol
	Connection via Ethernet
	Defining a Serial Connection

	Removing a Connection Point

	Defining an External Matrix
	Third-Party Matrix Control with the Ultricore BCS
	Creating a Logical Matrix for a Client Device
	Mapping the Matrix to Database Inputs and Outputs
	Using Index Numbers

	Defining the Levels
	Before You Begin
	Defining a Level

	Mapping the Destinations
	Before You Begin
	Adding Destinations to the Database
	Mapping the Destinations
	Using the Fill I/O Tool
	Using the Templates
	Overview
	Applying a System Template
	Applying a Template
	Creating a New Template

	Exporting and Importing the Destination Mapping
	Exporting a Destination Map
	Importing a Destination Map

	Updating the Destination Labels
	Applying an Alias Set

	Configuring the Destination Follow Feature

	Mapping the Sources
	Before You Begin
	Adding Sources to the Database
	Mapping an Input to a Source
	Using the Fill I/O Tool
	Using the Templates
	Applying a System Template
	Creating a New Template

	Exporting and Importing the Source Mapping
	Exporting a Source Map
	Importing a Source Map

	Updating the Source Labels

	Mapping the I/O for ULTRIMIX-MXR
	Before You Begin
	Overview
	Mapping the Router Destinations to the Audio Mixer Inputs
	Mapping the Router Sources to the Audio Mixer Outputs

	Tallies
	Overview
	Tally IDs
	Tally ID Format

	Router Tally Output Operation
	Router Status over TSL UMD v3.1 Operation

	Getting Started
	Communication Setup
	Adding a Serial Connection Point
	Adding an Ethernet Connection Point

	Enabling Tally ID Support in the Active Database
	Defining the Status Level for Tally Operation
	Assigning the Tally IDs to the Destinations
	Assigning the Tally IDs to the Sources
	Example of Tally Routed Mode
	Application
	Carbonite Requirements
	Ultrix and Ultricore Requirements


	Using an Alias Set
	Overview
	Creating an Alias Set for Sources or Destinations
	Creating a New Alias Set
	Creating an Alias Set Template

	Creating a Channel Alias Set
	Applying an Alias Set
	Exporting an Alias Set
	Importing an Alias Set

	Tielines
	What are Tielines?
	Setup Work Flow

	Physical Setup
	Add the Routers to Ultricore BCS Control
	Create a Database for the Ultricore BCS
	Define a Free Source for each Router

	Using the Ultricore BCS Tieline Builder
	Using the Tieline Runtime
	Viewing the Tieline Details

	Parking a Tieline using a Free Source

	Using Cat/Index Mode
	Cat/Index Categories Overview
	Configuring a Cat/Index Category Setup
	Creating the Categories
	Using the Auto-Generate Tool
	Manually Create a New Category
	Deleting a Category

	Creating the Index Filters
	Auto-Generated Index Filters
	Manually Assign an Index Filter

	Managing the Resources
	Assigned Resources
	Available Resources


	Using Group Categories
	Example of a Group Category Setup
	Configuring Group Categories
	Auto Generating the Groups
	Manually Adding a New Group
	Assigning Resources to a Group
	Renaming a Group
	Deleting a Group


	Using Salvos
	Creating Salvos
	Saving the Current Crosspoint Status as a New Salvo

	Viewing a Salvo
	Copying a Salvo
	Using the Find & Filter Tool
	Editing a Salvo
	Deleting a Salvo
	Recalling a Salvo

	Soft Panels in DashBoard
	Before You Begin
	Soft Panels Overview
	Enabling Machine Control for Legacy Devices

	Creating a Soft Panel
	Customizing the Layout
	Customizing the Home Window
	Defining the Drawers on a Soft Panel

	Levels for the Soft Panel
	Sources for the Soft Panel
	Destinations for the Soft Panel
	Adding Salvos to a Soft Panel
	Applying an Alias Set to a Soft Panel
	Copying a Soft Panel
	Editing a Soft Panel
	Deleting a Soft Panel from the Database
	Displaying a Soft Panel in DashBoard
	Using the Lock and Protect Features
	Using a Lock
	Using a Protect

	Using an Override
	Adding the Override Feature to a Soft Panel
	Applying the Override Feature

	Using Matrix Panels
	Panel Interface Overview
	Status Quick Navigation
	Find Dialog
	Filter Dialog
	Crosspoint Switches via a Matrix Panel
	Using a Default Preset
	Creating an Automatic Switching Loop
	Clearing the Matrix Selections

	Using MultiBus Panels
	Panel Interface Overview
	Crosspoint Switches via a MultiBus Panel
	Using the Multi Select Function

	Using Category Panels
	Panel Interface Overview
	Crosspoint Switches via a Category Panel

	Using Push Button Panels
	Panel Interface Overview

	Configuring a Push Button Soft Panel
	Crosspoint Switches via a Push Button Panel

	Using an Ultritouch PB Panel
	Using an Audio Mixer Panel
	Customizing the Audio Mixer Panel Features

	Audio Mixer Soft Panel Overview
	Home View Window
	Equalizer
	Noise Gate
	Compressor/Limiter
	Adjusting the Balance of an Audio Source
	Audio Processing Options
	Partitions in an Audio Mixer Soft Panel


	Ultricore Profiles
	Overview
	Modes of Operation
	Creation and Management of User Credentials
	Creation and Management of User Profiles via the Profiles Only
	Full Creation, Customization, and Management of User Profiles

	User Profiles Interface
	Accessing the User Profiles Interface
	Overview

	Creating a Database of Users
	Creating a New Profile
	Defining the Permissions for a Profile
	Overview
	Configuring the Permissions for a Profile

	Assigning Users to a Profile
	Managing the User Accounts
	Setting the Credentials Mode
	Application of the Ultricore Profiles
	Unlocking via the Front Panel

	User Data Import/Export




